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1. SUMMARY 

 

This document describes the procedures and technical configurations necessary for installing, 
upgrading and uninstalling programs of the Windows Front-End. 

 

Note that Windows Front-End is also the kernel for HOPEX Web Front-End. 

It applies to HOPEX V2R1. 

 

It does not describe: 

• System requirements and possible architectures (see architecture overview documentation). 

• How to install corrective patch (see how to upgrade CP documentation). 

• How to manage installations (see administrator manuals). 

• How products are licensed (see license installation documentation). 

• How to use features (see user manuals). 

 

Before installing: 

• You must have chosen a deployment (Standard deployment or Citrix/TSE deployment) 

• You must have chosen a type of license (Must license, Elf license). 

 

The types of installations described in the document are the following 

 

Type of installation Comment 

Installation on standalone machine Standalone installation for test purpose. It this 

case, it is assumed that storage is GBMS. 

Installation on multiple machines Real deployment on several machines. It is 

assumed that a tool to deploy .MSI/.MSP files is 

available and that storage it RDBMS. 

Installation on Citrix /TSE Server Real deployment on one or several Citrix/TSE 

servers. It is assumed that storage it RDBMS. 
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2. INSTALLATION ON STAND-ALONE MACHINE 

2.1. General Steps 
Performing an installation on a stand-alone machine includes the following steps from the 
Windows Client:  

o Installing the HOPEX programs (HOPEX Kernel). 
o Installing a HOPEX Environment for test. 

o Installing the HOPEX License. 

 
In this document, it is assumed that the repository storage is GBMS. Otherwise: 

• A HOPEX Environment should be available in a database server. 
• If storage is SQL Server, SQL Server native client should be installed on the machine. 

 

Pre-requisites: 

Confirm that you have: 

• Local administrator rights for the machine (for updating the system). 

• 'Full control' of the installation folder. 

• 4 GB free space in the installation folder. 

• A system that is supported for this version of Windows Front-End 

See document 'Windows Front-End Architecture Overview HOPEX V2R1 EN'. 

• Visual C++ Redistributable for Visual Studio 2015 installed. 

See also the section 'FAQs' of this document. 

• A HOPEX local license. Consult your sales representative to obtain a license. You will get a license file 

and instructions to install it. 

 

2.2. Installing on the Windows client 

Procedure: 

• Insert the HOPEX disk in the disk drive but do not install from the page started automatically 

(autorun). 

• Select the program "\DISK1\setup.exe" and execute in 'Run as administrator' mode 

• Select the language of the user interface. 

• Accept the license agreement. 

• Choose whether the Windows Front-End is installed for all users or for the current user or for all 

system users (windows users). 

• Check the folder in which you wish to install HOPEX, for example: 

Folder 'C:\Program Files (x86)\MEGA\HOPEX' for a 64-bit system 

This installation folder must not be the root of the drive, for example, it must not be C:\ 

• In the 'Setup Type' window, select Windows Standalone Setup. 

• Run the installation and wait for confirmation of completion. 
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Result: 

• Programs are installed for the Windows Front-End. 

• The system of the machine is updated (registry, libraries). 

• Windows Service are installed  

o HopexRedisBackEnd 

• Redis client programs are installed. 

• The Program Features selected by default are installed. Note that no HOPEX environment is created 

by default. 

• The local configuration file (Megasite.ini) contains the following section. It should not be removed. 

[LAN] 

clusterrootpath= 

2.3. Post installation tests 
After installation of HOPEX: 

• Install the HOPEX license. 

See section ' Checking the HOPEX License', later in this document. 

• Install a test environment and a test data repository. 

See section 'Installing a test environment', later in this document. 

Then, perform the following tests: 

Windows client Scenario 

Workstation01 Scenario #1 

• Check license 

• Connection to Window Administration console 

Scenario #2 

• Connection to Windows Front-End 

• Check dispatch 

Scenario #3 

• Connection to Windows Front-End 

• Check creation of diagram 

 

See Post installation scenarios section p. 11. 
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3. COMMON CONFIGURATION 

This section describes configurations that will be necessary for standard deployment or Citrix/TSE 

deployment. 

3.1. Checking the HOPEX License 
Consult your sales representative to obtain a license. You will get a license file and instructions to install it. 

 

License type Requirement 

Must license (.must) • It should be installed in the UNC folder for which it has been programmed. 

Example: folder \\server001\Apps\Licenses containing the file License-

000001.must. 

• The must license folder must be accessible with full control to all Windows users 

that should share this configuration.  

• If you want to configure smarter permissions, consult the FAQs section p. 25. 

Elf license (.elf) • It should be installed in a shared folder. Example: folder 

\\server001\Apps\Licenses containing the file License-000002.elf 

• The Elf license file must be accessible with at least read access to all Windows 

users that should share this configuration.  

 

For more details about HOPEX license, see the article 'Must License Installation Guide HOPEX V2R1 EN'. 

3.2. Creating a shared configuration folder 

The configuration of the HOPEX installation can be local or shared: 
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When Windows Front-End is run by an end-user: 

1. A configuration file (Megasite.ini) is read. 

2. If it contains a redirection (clusterrootpath=YYY, ex clusterrootpath=\\mega\data), a different 

configuration files (Megasite.ini) is read in the shared folder. 

 

Procedure: 

• Create and share a folder that will contain configuration files (Example: 

\\mega\data\ClusterRoot\Cfg). 

• Manually create a text file called 'megasite.ini'. 

 

Notes: 

• The folder must be accessible with full control to all Windows users that should share this 

configuration. 

• The file megasite.ini must be copied in a subfolder (\ClusterRoot\Cfg) of the path set for 

clusterrootpath. Ex: \\mega\data\ClusterRoot\Cfg\megasite.ini 

• If you want to configure smarter permissions, consult the FAQs section p. 25. 

• The file megasite.ini should at least contain a section for the license, according to the type of license 

used. See below: 

 

License type Example 

Must license (.must) [Must license] 

Path = \\server001\Apps\Licenses 

Elf license (.elf) [MegaLicenseFile] 

FileLongName = \\server001\Apps\Licenses\License-000002.elf 

 

If you do not have the technical skills or the authorization required for this step, contact your system 

administrator. 

3.3. Copying the installation program on a network folder 
You need to copy the HOPEX installation programs (often called ‘installation master’) on a network folder. 

Example: \\Srv001\Master\HOPEX 

This folder contains a subfolder \DISK1\HOPEX V2R1.msi. 

 

Important notice: 

Choose a folder that persists in time (do not delete it after installation). Indeed this path will be saved in 

the registry of the machines where HOPEX programs are installed. When such installations are upgraded 

(CP upgrade), this path can be tested and errors can occur if the master is no longer available. 

3.4. Building an installation command line 
Installing on several machines requires batching the execution of an installation command line. 

The command line should be executed with the privilege 'Run as administrator'. 

 

Execute the command line with the privilege Run as administrator: 

With recent operating system it is required that the installation is performed not only by a user that 

belongs to the group of 'Administrators' but also that the installation program is executed with the privilege 

'Run as administrator'. 

 

It is important to verify that, in the procedure used, the .MSI/.MSP program is executed with the 

privilege 'Run as administrator'. Otherwise, the HOPEX Programs may not be fully installed or upgraded 

and various problems can occur especially with HOPEX Web Front-end. 
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Different procedures are available and only one is described below: 

• Create a text file with the .Bat extension. 

• Edit the .Bat file, add the command lines and save the file. 

• Select the .Bat file and right-click > Run as administrator. 

 

Full installation command line syntax for HOPEX V2R1.msi: 

 

<path of msiexec.exe> /package "<Folder of the HOPEX MSI file>\HOPEX V2R1.msi" /passive /levw "<path 

of installation log>" 

SELECTED_LANGUAGE="<language code>" 

ADDLOCAL="<feature list>" REMOVE="<feature list>" 

ALLUSERS="1" 

INSTALLDIR="<installation path>" 

CLUSTERDIR="<configuration folder>" 

HOPEXDIR="<installation path of IIS HOPEX application>" 

HOPEXMWAS="<installation path of IIS MWAS>" 

MSSPDIR="<installation path of IIS SSP>" 

IS_NET_API_LOGON_USERNAME_HOPEX="<HOPEX service account name>" 

IS_NET_API_LOGON_PASSWORD_HOPEX="<HOPEX service account password>"  

IS_NET_API_LOGON_USERNAME_API="<HOPEX API service account name>" 

IS_NET_API_LOGON_PASSWORD_API="<HOPEX API service account password>" 

WEBPORTAL_USERNAME="<name of administrator of the machine>" 

WEBPORTAL_PASSWORD="<password of administrator of the machine>" 

WITHSSL="<0 or 1>" 
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Element Comment 

/package "<Folder of the HOPEX MSI 

file>\HOPEX V2R1.msi" 

Required. To specify the path of the .msi file.  Ex: 

\\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi. 

/passive Optional. To trigger not interactive mode 

/levw "<path of installation log>" Optional. To generate installation log 

Ex: /levw "C:\tmp\ScriptInstall.log" 

SELECTED_LANGUAGE="<language 

code>" 

 

Optional (English by default). To control installation language. 

Languages codes: 1031 (German language), 1033 (English 

language), 1036 (French language), 1040 (Italian language) 

ADDLOCAL="<feature list>" 

REMOVE="<feature list>" 

 

Recommended. To list the features to install: feature X, feature 

Y… See table 'Complete list of installation features' later in this 

document 

INSTALLDIR="<installation path>" Optional. To control target folder of HOPEX core programs. Ex: 

C:\Apps\MEGA\HOPEX 

CLUSTERDIR="<root configuration 

folder>" 

Optional (empty by default). To set a root configuration folder 

for the installation 

Ex: "\\mega\data" 

HOPEXDIR="<installation path of IIS 

HOPEX application>" 

Optional (by default C:\inetpub\wwwroot\HOPEX). To control 

target folder of IIS HOPEX application folder when installing Web 

Front-End. 

Ex: C:\Apps\MEGA\wwwroot\HOPEX 

HOPEXMWAS ="<installation path of IIS 

MWAS>" 

Optional (by default C:\inetpub\wwwroot\HOPEXMWAS). To 

control target folder of IIS MWAS folder when installing Web 

Front-End. 

Ex: C:\Apps\MEGA\wwwroot\HOPEXMWAS 

MSSPDIR="<installation path of IIS SSP>" Optional (by default C:\inetpub\wwwroot\MegaSSP). To control 

target folder of IIS SSP folder when installing SSP. 

Ex: C:\Apps\MEGA\wwwroot\MegaSSP 

IS_NET_API_LOGON_USERNAME_HOPEX 

="<HOPEX service account name>" 

Required with HOPEX Web Front-End 

Ex: mydomain\myuserhopex 

IS_NET_API_LOGON_PASSWORD_HOPEX

="<HOPEX service account password>" 

Required with HOPEX Web Front-End 

Ex: mypasswordhopex 

IS_NET_API_LOGON_USERNAME_API="<

HOPEX API service account name>" 

Required only to deploy web services with HOPEX Web Front-

End. 

Ex: mydomain\myuserhopexapi 

IS_NET_API_LOGON_PASSWORD_API="<

HOPEX API service account password>" 

Required only to deploy web services with HOPEX Web Front-

End. 

Ex: mypasswordhopexapi  

WEBPORTAL_USERNAME="<login of 

administrator of the machine>" 

Required to control access later. Choose the name of 

administrator of the machine 

Ex: mydomain\myadminuser 

WEBPORTAL_PASSWORD="<password of 

administrator of the machine>" 

Required to control access later. Choose the password of 

administrator of the machine 

Ex: mydomain\myadminpassword 

WITHSSL="<0 or 1>" 

 

0 to disable SSL at installation 

1 to enable SSL at installation 

If no certificate is installed on the web server, disable 

installation with SSL. This can be configured after installation. 

 

You can use such a command line to install HOPEX Windows Front-End and/or HOPEX Web Front-End. The 

appendix of this document contains: 
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• Examples of command line for Web Front-End. 

• A complete description of installation features. 

 

See also Microsoft documentation, for example: 

https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx 

3.5. Installing a test environment 
A HOPEX Environment is required to run connection scenarios. To facilitate this step, it is created in the 

GBMS storage format. It can also be created in the RDBMS storage format. Of course, the HOPEX 

Environment used for production can be created in the RDBMS storage format. 

 

For more details about RDBMS storage format, see the article 'RDBMS Repository Installation guide HOPEX 

V2R1 EN'. 

 

Pre-requisites: 

• 800 MB free space on a shared folder. 

On the server disk, create a folder (example \\svrname\data) and share it with a few end-users (full 

control). 

• Local HOPEX installation. 

 

Procedure:  

From the File Server: 

• Run Administration.exe 

Example: C:\Program Files (x86)\MEGA\HOPEX V2R1\Administration.exe 

• In the tree, select the 'Environments' folder. 

• Right-click > New. 

• A window 'Environment installation (Create/Update)' is displayed. 

o Enter a value for 'Name:', (example: 'TestEnvironment'). 

o For 'Location:', select the shared folder (example \\svrname\data). 

o For 'Repository storage support', keep 'Gbms'. 

o Click 'OK' and wait until installation is complete. 

• In the tree, select the 'Environments' folder. 

• Right-click > Open. 

• In the window Identification, enter the identifier System (no password) and click 'OK'. 

• In the tree, below the environment, select the 'Repositories' folder.  

• Right-click > New. 

• A 'Create repository' window is displayed. 

o Enter a value for 'Name:', (example: 'TestRepository'). 

o For 'Repository storage support', keep 'Gbms'. 

o Click 'OK' and wait until installation is complete. 

• Exit the Administration Console with Menu File > Exit. 

  

https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx
http://megaportal/doc/dug/MEGA2012/Source%32documents/EN/Repository%32-%32RDBMS%32Installation%32Guide%32HOPEX%321.0%32EN.doc
http://megaportal/doc/dug/MEGA2012/Source%32documents/EN/Repository%32-%32RDBMS%32Installation%32Guide%32HOPEX%321.0%32EN.doc
baggage/data
baggage/data
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3.6. Post installation scenarios 
Once HOPEX Programs and HOPEX Licenses are installed, it is important to verify that connection to the 

Windows Front-End is technically possible. 

 

A HOPEX Environment and a HOPEX Repository are required. If no environment or repository is available at 

this step, see the section 'Installing a test environment' in this document. 

 

Scenario Steps 

Scenario #1 

• Check license 

• Connection to 

Administration console 

 

• Run Administration.exe. 

A window 'HOPEX - Administration' is displayed 

• Click the menu help > About HOPEX 

A window 'About HOPEX is displayed 

• Check the type (ex: Must license) and name (ex: 'License HOPEX.must') of 

the license in the bottom of the page (1). 

If you can run Administration console and display the name of the licence, test 

is a success. Otherwise, test is a failure. 

• Select the test environment 

Ex: xx\TestEnvironment. 

• R click > Open 

• In the window Identification, enter the identifier System (no password) 

and click 'OK'.  

If you can display the folders 'Repositories', 'Customized Shapes' and 'User 

accounts', test is a success. Otherwise, test is a failure. 

• Click the menu File > Exit. 
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Scenario #2 

• Connection to 

Windows Front-End 

• Check dispatch 

• Run HOPEX.exe. 

• In the window 'Connection to HOPEX', enter the identifier Mega (no 

password) and click 'OK'. 

A window 'HOPEX' is displayed 

• Select a repository 

Ex TestRepository 

• Select the profile 'Enterprise Architect' and click 'OK'.  

The desktop is loaded 

If the desktop is displayed, test is a success. Otherwise, test is a failure. 

• Click the menu View > Navigation Window > Home 

A tab 'Home' is displayed 

• Select the library 'MEGA' (icon of open blue book) 

• Right-click New > Sub-library and confirm creation 

• Click the menu File > Exit and answer 'Yes' to the question 'Do you want to 

dispatch modifications?' 

If the object is created and the dispatch is correct, test is a success. Otherwise, 

test is a failure. 

Scenario #3 

• Check creation of 

diagram 

 

• Run HOPEX.exe. 

• In the window 'Connection to HOPEX', enter the identifier Mega (no 

password) and click 'OK'. 

A window 'HOPEX' is displayed 

• Select a repository 

Ex TestRepository 

• Select the profile 'Enterprise Architect' and click 'OK'.  

The desktop is loaded 

• Click the menu View > Navigation Window > Home 

A tab 'Home' is displayed 

• Select the library 'MEGA' (icon of open blue book) 

• Right-click New > Sub-library and confirm creation 

• For this Library object, right-click New > Diagram. 

A wizard called 'New diagram' is displayed. 

o Check that it is possible to select 'Library diagram' and to click 

'Create' (1). A diagram will be created. 

• Click the menu File > Exit and answer 'Yes' to the question 'Do you want to 

dispatch modifications?' 

If the diagram is created, test is a success. Otherwise, test is a failure. In this 

case, change options at environment level, group 'Compatibility > Diagram' 

and set 'Diagram creation interface' to 'Menu (Compatibility mode)' (3) as a 

work-around. See also the Embedded Internet Explorer section p. 35. 

 

 

(1) Check the type and name of the license in the bottom of the page 
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(2) Check that is it possible to select 'Library diagram' and to click 'Create'. 

 

 
 

(3) Change options at environment level, group 'Compatibility > Diagram' and set 'Diagram creation 

interface' to 'Menu (Compatibility mode)'. 
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4. INSTALLATION ON MULTIPLE MACHINES 

4.1. General Steps 

Performing an installation for standard deployment includes the following steps: 

 

From each Windows Client:  
• Installing SQL Server Native client if SQL Server storage is chosen. 

No MEGA documentation is provided: use the standard documentation of the SQL Server 
native client. 

• Installing the HOPEX programs (HOPEX Kernel) targeting a shared configuration in 
command line mode. This enables to pass the path of the shared configuration folder as 

a parameter so that local configuration file (megasite.ini) is updated. 

 
From a file server:  

• Checking the HOPEX license. 
Refer to the section 'Common configuration' of this document. 

• Creating a shared configuration folder. 
Refer to the section 'Common configuration' of this document. 

• Creating a shared configuration file. 
Refer to the section 'Common configuration' of this document. 

• Installing a HOPEX Environment for test. 

Refer to the section 'Common configuration' of this document. 
 

Pre-requisites: 

Confirm that you have for each Windows client: 

• Local administrator rights for the machine (for updating the system). 

• 'Full control' of the installation folder. 

• 4 GB free space in the installation folder. 

• A system that is supported for this version of Windows Front-End 

See document 'Windows Front-End Architecture Overview HOPEX V2R1 EN'. 

• Visual C++ Redistributable for Visual Studio 2015 installed. 

See also the section 'FAQs' of this document. 

• A HOPEX license. Consult your sales representative to obtain a license. You will get a license file and 

instructions to install it. 

• SQL Server Native client installed if SQL Server storage is used. 
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4.2. Installing on the Windows client 
The installation consists in executing the installation command line for each windows client. 

Tools and solutions vary and there is no particular procedure. Anyway, the command line should be 

executed with the privilege 'Run as administrator'. 

 

If you do not have the tools, technical skills or the authorization required for this step, contact your IT 

department. 

 

Recommended command line for a Windows client: 

 

C:\WINDOWS\system32\msiexec.exe 

/package \\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi 

/passive 

/levw "C:\tmp\ScriptInstall.log" 

SELECTED_LANGUAGE="1033" 

ADDLOCAL="ALL" 

ALLUSERS="1" 

REMOVE="HOPEX_SITE_SERVICE_PROVIDER,HOPEX,HOPEX_MWAS,HOPEX_API,HOPEX_API_MWAS,HOPEX

_UAS,HOPEX_CONSOLES_PORTAL" 

INSTALLDIR="C:\Program Files (x86)\MEGA\HOPEX V2R1" 

CLUSTERDIR="\\mega\data" 

 

Note: 

• The above command line is displayed though seveval lines for better understanding. 
• Code '1033' is for English language but you can select another language code. See section 

'Full installation command line syntax for HOPEX V2R1.msi' earlier in this document. 
"\\mega\data\config" is an example of share configuration folder. For more details, see 

section See section 'Creating a shared configuration folder' earlier in this document. 

 

Result for each Windows client: 

• Windows Front-End programs are installed. 

• The system of the machine is updated (registry, libraries). 

• Windows Service are installed  

o HopexRedisBackEnd 

• Redis client programs are installed. 

• The local configuration file (Megasite.ini) contains the reference of the shared configuration folder. 

Example: 

[LAN] 

clusterrootpath=\\mega\data 

4.3. Post installation tests 
After installation of HOPEX: 

• Install the HOPEX license. 

See section ' Checking the HOPEX License', later in this document. 

• Install a test environment and a test data repository. 

See section 'Installing a test environment', later in this document. 

  

baggage/HOPEX%20V2.msi
baggage/data_2
baggage/config
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Then, perform the following tests: 

Windows client Scenario 

Workstation01 Scenario #1 

• Check license 

• Connection to Window Administration console 

Scenario #2 

• Connection to Windows Front-End 

• Check dispatch 

Scenario #3 

• Connection to Windows Front-End 

• Check creation of diagram 

 

See Post installation scenarios section p. 11. 
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5. INSTALLATION IN CITRIX/TSE DEPLOYMENT 

5.1. General Steps 

Performing an installation for Citrix/TSE deployment includes the following steps: 

 

From the Client:  
• Installing the Citrix/TSE client. 

Refer to the Citrix/TSE documentation. 
 

From the TSE server:  
• Checking the HOPEX license. 

Refer to the section 'Common configuration' of this document. 

• Creating a shared configuration folder. 
Refer to the section 'Common configuration' of this document. 

• Creating a shared configuration file. 
Refer to the section 'Common configuration' of this document. 

• Installing a HOPEX Environment for test. 
Refer to the section 'Common configuration' of this document. 

• Installing SQL Server Native client if SQL Server storage is chosen. 
No MEGA documentation is provided: use the standard documentation of the SQL Server 

native client. 

• Installing HOPEX. 
Installing the HOPEX programs (HOPEX Kernel) targeting a shared configuration in 

command line mode. Refer to the section 'Installation in standard deployment, 
Installing on the Windows client' of this document. 

 
From the Citrix server:  

• Checking the HOPEX license. 
Refer to the section 'Common configuration' of this document. 

• Creating a shared configuration folder. 

Refer to the section 'Common configuration' of this document. 
• Creating a shared configuration file. 

Refer to the section 'Common configuration' of this document. 
• Installing a HOPEX Environment for test. 

Refer to the section 'Common configuration' of this document. 
• Installing SQL Server Native client if SQL Server storage is chosen. 

No MEGA documentation is provided: use the standard documentation of the SQL Server 
native client. 

• Creating an installation package for the HOPEX programs. 

• Deploying this installation package on the server farm. 
• Publishing applications. 
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Pre-requisites: 

Confirm that you have for each Citrix/TSE server: 

• Local administrator rights for the machine (for updating the system). 

• 'Full control' of the installation folder. 

• 4 GB free space in the installation folder. 

• A system that is supported for this version of Windows Front-End. 

• A HOPEX license. Consult your sales representative to obtain a license. You will get a license file and 

instructions to install it. 

• SQL Server Native client installed if SQL Server storage is used. 

5.2. Creating an installation package 
In Citrix, build a package with the installation command line. 

 

The procedure varies with the version of Citrix. 

If you do not have the tools, technical skills or the authorization required for this step, contact your IT 

department. 

 

Recommended command line for Citrix/TSE server: 

 

C:\WINDOWS\system32\msiexec.exe 

/package \\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi 

/passive 

/levw "C:\tmp\ScriptInstall.log" 

SELECTED_LANGUAGE="1033" 

ADDLOCAL="ALL" 

ALLUSERS="1" 

REMOVE="HOPEX_SITE_SERVICE_PROVIDER,HOPEX,HOPEX_MWAS,HOPEX_API,HOPEX_API_MWAS,HOPEX

_UAS,HOPEX_CONSOLES_PORTAL" 

INSTALLDIR="C:\Program Files (x86)\MEGA\HOPEX V2R1" 

CLUSTERDIR="\\mega\data" 

 

Note: 

• The above command line is displayed though seveval lines for better understanding. 
• Code '1033' is for English language but you can select another language code. See section 

' Full installation command line syntax for HOPEX V2R1.msi' earlier in this documrent. 
"\\mega\data\config" is an example of share configuration folder. For more details, see 

section See section 'Creating a shared configuration folder' ealier in this document. 

baggage/HOPEX%20V2.msi
baggage/data_2
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5.3. Deploying a package on the server farm 
The installation for HOPEX consists in deploying the installation package created before on the appropriate 

servers of the server farm.  

 

The procedure varies with the version of Citrix. 

If you do not have the tools, technical skills or the authorization required for this step, contact your IT 

department. 

 

Result for each Citrix/TSE server: 

• Windows Front-End programs are installed. 

• The system of the machine is updated (registry, libraries). 

• Windows Service are installed  

o HopexRedisBackEnd 

• Redis client programs are installed. 

• The local configuration file (Megasite.ini) contains the reference of the shared configuration folder. 

Example: 

[LAN] 

clusterrootpath=\\mega\data 

5.4. Publishing the application 
 

The following are recommendations for publishing the Windows Front-End in Citrix: 

 

Element Comment 

Application to publish • Publish HOPEX.exe for each end-user expected to run Windows Front-

End. 

• Publish Administration.exe for each end-user expected to run the 

Administration Console. 

• Publish licensing.exe for each end-user expected to configure MEGA Must 

licenses 

Type of application Publish as 'Application' rather than 'Server desktop' or 'Content' 

Select application type 'Accessed from a server'. 

Do not select 'Streamed if possible, otherwise accessed from a server' nor 

'Streamed to client'. These modes have not been qualified by MEGA  

Control of instances per user Check the parameter 'Allow only one instance of application for each user' 

Audio Do not check 'Enable legacy audio' 

Screen resolution For the parameter 'Session windows size', select '1024 x 768' minimum 

Colors For the parameter 'Maximum color quality', select 'Better appearance (32-

bit)' or 'Better speed (16-bit)'. Do not select '256-color (8-bit)'  

Command line Do not use the '/K' command line parameter for HOPEX.exe. 

Use the parameter 'command line' in MEGA profile properties 
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5.5. Post installation tests 
After installation of HOPEX: 

• Install the HOPEX license. 

See section ' Checking the HOPEX License', later in this document. 

• Install a test environment and a test data repository. 

See section 'Installing a test environment', later in this document. 

Then, perform the following tests connection tests on all Citrix/TSE servers logged with non-
administrator windows users: 

Citrix/TSE server Logged as Scenario 

Server01 User01 on domain01 allowed to 

login on Server01 

Scenario #1 

• Check license 

• Connection to Windows Administration 

console 

Scenario #2 

• Connection to Windows Front-End 

• Check dispatch 

Server02 User02 on domain02 allowed to 

login on Server02 

Scenario #1 

• Check license 

• Connection to Windows Administration 

console 

Scenario #2 

• Connection to Windows Front-End 

• Check dispatch 

Scenario #3 

• Connection to Windows Front-End 

• Check creation of diagram 

… … … 

 

See Post installation scenarios section p. 11. 
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6. UPGRADING HOPEX PROGRAMS 

Note that upgrade command lines do not allow to change the major version. 

Ex: it does not allow to upgrade from HOPEX V1R3 to HOPEX V2R1. 

Upgrade command line enable to batch a CP upgrade within the same major version. 

Ex: upgrade from HOPEX V2R1 CP1.0 to HOPEX V2R1 CP2.0. 

 

As usual, it is possible to upgrade HOPEX by executing manually an upgrade program (.msp file). 

 

Pre-requisites: 
• Stop SSP service (Windows Service 'HOPEX Site Service Provider' and 'HOPEX Service 

Watchdog') 
• Stop IIS web site 

• Check that no HOPEX process (mgw*.exe) is running 
 

Upgrading several machines requires to batch the execution of an upgrade command line. 

6.1. Perform a backup of key configuration files 
The upgrade of HOPEX program will not upgrade data. 

It is recommended to backup key configuration files to prevent a possible initialization during upgrade. 

 

Shared 

configuration 

folder 

File Location Comment 

Yes Megasite.ini As customized 

<clusterrootpath>\Cl

usterRoot\Cfg 

See variable ClusterRoot of file Megaenv.ini. Ex 

[LAN] 

clusterrootpath=\\mega\data 

No Megasite.ini Cfg folder of HOPEX 

installation.  

By default: 
C:\Program Files (x86)\MEGA\HOPEX V2R1\Cfg 

6.2. Upgrade command line 
 

The upgrade consists in executing the installation command line for each machine. In Citrix, build a package 

with the installation command line. Tools and solution vary and there is no particular procedure. Anyway, 

the command line should be executed with the privilege 'Run as administrator'. 

 

If you do not have the tools, technical skills or the authorization required for this step, contact your IT 

department. 

The installation consists in executing the installation command line for each windows client. 
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Upgrade command line syntax for HOPEX V2R1 Cpx.msp: 

 

<path of msiexec.exe> /update <path of the HOPEX MSP file> /passive 

 

Example: 

C:\WINDOWS\system32\msiexec.exe /update "\\Srv001\CP\HOPEX\HOPEX V2R1 Patch 1.msp" /passive 

/levw "C:\tmp\ScriptInstall.log" 

 

Result for each server: 

• HOPEX programs are upgraded (according to Program Features previously installed). 

• The system of the machine is updated (registry, libraries). 

  

baggage/HOPEX
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7. REMOVING HOPEX PROGRAMS 

7.1. General recommendations 
 

With task manager, check that no HOPEX process (mgw*.exe) is running on the machine. 

If the HOPEX installation is also used by HOPEX Web Front-End, it is recommended to set the Windows 

services 'HOPEX Site Service Provider' and 'HOPEX Service Watchdog' to 'Disabled' and to stop the IIS Web 

site. 

 

Pre-requisites: 

• Stop SSP service (Windows Service 'HOPEX Site Service Provider' and 'HOPEX Service 
Watchdog') 

• Stop IIS web site 

• Check that no HOPEX process (mgw*.exe) is running 

 

As usual, it is possible to uninstall HOPEX manually through the Control Panel of the machine. 

• Select 'Programs and Features' 

• Select the program 'HOPEX V2R1' 

• Confirm uninstallation. 

 

Uninstalling on several machines requires to batch the execution of an uninstallation command line. 

7.2. Unstallation command line 
The uninstallation consists in executing the installation command line for each machine. In Citrix, build a 

package with the installation command line. Tools and solution vary and there is no particular procedure. 

Anyway, the command line should be executed with the privilege 'Run as administrator'. 

 

If you do not have the tools, technical skills or the authorization required for this step, contact your IT 

department. 

 

Uninstallation command line syntax for HOPEX V2R1.msi: 

 

<path of msiexec.exe> /x <path of the HOPEX MSI file> /passive 

 

Example: 

C:\WINDOWS\system32\msiexec.exe /x "\\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi" /passive /levw 

"C:\tmp\ScriptUninstall.log" 

 

Result for each machine: 

• HOPEX programs are uninstalled (according to Program Features previously installed). 

• The system of the machine is updated (registry, libraries). 

  

baggage/HOPEX_2
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7.3. Uninstalling SQL Server Native client 
No MEGA documentation is provided: use the standard documentation of the SQL Server native client. 
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8. FAQS 

8.1.1. Why is it necessary to install a Visual C++ Redistributable package? 
This package is required for a good behavior of both Web client and Windows client of HOPEX. It contains 

runtimes that enable to execute C++ component of the HOPEX kernel (mainly .dll files). Microsoft now 

recommends to install these runtimes through a separate installer package. 

8.1.2. How to get the package Visual C++ Redistributable for Visual Studio 

2015?  
You can download it from Microsoft web site. 

Search 'Visual C++ Redistributable for Visual Studio 2015' (offline installer, 32-bit version). The expected file 

is 'vc_redist.x86.exe'. 

Ex: https://www.microsoft.com/en-us/download/details.aspx?id=48145 

 

If HOPEX is installed, you can also find this package in the following folder: 

<HOPEX installation>\Install\vc_dedist 

Ex: C:\Program Files (x86)\MEGA\HOPEX V2R1\Install\vc_dedist 

It is recommended to run vc_redist.x86.exe as an Administrator. 

8.1.3. Why is it necessary to tinstall a Visual C++ Redistributable package?  
The offline installer can be found at this address: 

 

If you want to download it from that location, make sure to download the 32 bits’ version, file 

“vc_redist.x86.exe”. 

Moreover, once the HOPEX application is installed, you will be able to find it in the folder “<installation 

folder>\Install\vc_dedist”. 

8.1.4. How to track an installation error?  
If an installation error persists after a second try and no reason can be found, contact MEGA Technical 

support. An installshield log can be requested. 

 

To generate such a log, you can use a /levw command line parameter. 

Example: 

msiexec /package "\\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi" /passive /levw 

"C:\tmp\ScriptInstall.log" 

 

Understanding the logfile generated by this command requires an expertise. 

8.1.5. How to disable SMB 2.0?  
SMB 2.0 can be disabled on the client side or on the server side. 
If the file server is dedicated to HOPEX, it is recommended to disable SMB 2.0 on the server 

side. See the following web page: 
http://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=501D00000012dnrIAA 

https://www.microsoft.com/en-us/download/details.aspx?id=48145
baggage/HOPEX_2
http://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=501D00000012dnrIAA
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8.1.6. How can I create a HOPEX Environment in RDBMS Storage (Oracle, 

SQL Server)?  
For more details about RDBMS storage format, see the article 'RDBMS Repository Installation guide HOPEX 

V2R1 EN'. 

 

8.1.7. After upgrade of a HOPEX installation from version X to version Y, 

when a user Z runs HOPEX, the version is version X (and not version 

Y)!  
This is a known issue with Citrix deployment (XenApp). The version of the programs is cached by Citrix. As 

long as a user has a session that is disconnected, he cannot see the new version. 

Ask users to exit with logoff. In Citrix administration console, disconnect inactive users for the application 

corresponding to HOPEX. 

 

 

  

http://megaportal/doc/dug/MEGA2012/Source%32documents/EN/Repository%32-%32RDBMS%32Installation%32Guide%32HOPEX%321.0%32EN.doc
http://megaportal/doc/dug/MEGA2012/Source%32documents/EN/Repository%32-%32RDBMS%32Installation%32Guide%32HOPEX%321.0%32EN.doc
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9. APPENDIX 

9.1. Recommended file permissions for the HOPEX installation 
In this section, it assumed that only the administrator can: 

• Perform administration actions (create environment, create repository…). 

• Deploy customized resources (custom .jar files, custom files in Mega_usr). 

• Deploy licences. 

• Install Solution Packs. 

• Uncompress documentation in Javadoc format. 

9.2. Reading table 
You may configure advanced file permissions: 

 

Right / Windows permission  Read & 

execute 

Modify Delete 

denied 

Read X   

Update no delete X X X 

Update and delete X X  

9.2.1. Permissions for the license folder (Must license) 
 

File Location Administrator 

rights 

User rights 

*.must Parent license folder containing a .must license file (ex: 

License-Y999.must) 

Example: 

\\server001\Apps\Licenses 

Update and 

delete 

Update no 

delete 

*.* License subfolder (hidden, created dynamically when license 

is used) 

Example: 

\\server001\Apps\Licenses\License-Y999 

Update and 

delete  

Update and 

delete 1 

 

 

Event smarter permission can be defined. See the article 'Must License Installation Guide HOPEX V2R1 EN'. 

9.2.2. Permissions for the license folder (ELF license)  
 

File Location Administrator 

rights 

User rights 

*.elf Parent license folder containing the .elf license file (ex: 

L1345.elf). 

Example: 

\\server001\Apps\Licenses 

Update and 

delete 

Read 

 

                                                            
1 By default, user files and token files are set as 'Not visible'. 
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9.2.3. Permissions for the shared configuration folder 
 

File Location Administrator 

rights 

User rights 

*.* Shared configuration folder containing the megasite.ini file. 

Example: =\\mega\data\config 

Update and 

delete 

Update no 

delete 

9.2.4. Permissions for HOPEX installation folders (%programfiles(x86)%)  
 

By defaut, core programs are installed on %programfiles(x86)%\MEGA\V2R1. 

File Location Administrator 

rights 

User rights 

*.* <Installation folder> and subfolders ( Documentation, 

DotNet\Assemblies, Install, java, Mega_Std, System, 

Utilities). Main programs 

Update and 

delete 

Read 

*.* <Installation folder>\Cfg 
 

Update and 

delete 

Read (1) 

*.* <Installation folder>\DotNet\Assemblies_usr 
 

Update and 

delete 

Read (1) 

*.* <Installation folder>\java\lib_usr 
 

Update and 

delete 

Read (1) 

*.* <Installation folder>\Mega_Usr 
 

Update and 

delete 

Read (1) 

*.* <Installation folder>\Utilities\Solution Pack Update and 

delete 

Read (1) 

(1) To facilitate the work of developer on HOPEX, it is advised to configure 'Update and delete' 
for this folder. 

9.2.5. Permissions for HOPEX installation folders (%programfiles%) 
 

By defaut, Redis component is installed on %programfiles%\MEGA\V2R1. 

File Location Administrator 

rights 

User rights 

*.* <Installation folder> and subfolders Update and 

delete 

Read 

9.2.6. Permissions for HOPEX Environment folders 
 

Note that most folders are created dynamically during use of HOPEX. 

File Location Administrator 

rights 

User rights 

*.* <Environment folder> 

Environment main folder. 

Update and 

delete 

Read 

*.* <Environment folder>\Db 

Root repository folders. 

Update and 

delete 

Read 

*.* <Environment folder>\Db\<Repository> 

Repository folder.  

Update and 

delete 

Update no 

delete 
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File Location Administrator 

rights 

User rights 

• If the repository is stored in the GBMS storage format 

(default), each HOPEX Repository consists of 4 files (.EMA, 

.EMB, .EMS, EMV). 

• If the repository is stored in Oracle, each HOPEX Repository 

consists of 2 files (. EMV, .EMO) and files on the database 

server. 

• If the repository is stored in SQL Server, each HOPEX 

Repository consists of 2 files (. EMV, .EMQ) and files on the 

database server. 

*.* <Environment folder>\Db\<Repository>\<Approve> 

Default folder for reports (MS Word) detached from HOPEX. 

This folder can be configured (optional). 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\Db\<Repository>\Document 

Default folder reports (MS Word). This folder can be 

configured (optional). 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\Db\<Repository>\<Repository>.Lock 

Folder of data repository locks for GBMS storage. One file 

(.EMK) per lock placed. These files can be created and deleted 

during use of HOPEX 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\Db\<Repository>\<Repository>.ix 

Folder of full search indexes. These files can be created and 

deleted during use of HOPEX 

Update and 

delete 

Update  

*.* <Environment folder>\Db\<Repository>\<Repository>.Log 

Folder of data repository logfile. One file (.MGL) per 

administration session or per private workspace dispatched. 

These files can be created and deleted during use of HOPEX. 

Update and 

delete 

Update and 

delete 

*.* <Environment 

folder>\Db\<Repository>\<Repository>.Transactions 

Folder of private workspace for data repositories (for GBMS 

storage only) and repository backup logfile (for all types of 

storage). 

If the repository is stored in the GBMS format (default), each 

private workspace consists in two files (.EMB and .EMS). 

These files are created on opening a private workspace and 

deleted at each dispatch. 

One file (.MGL) per administration session or per private 

workspace dispatched. These files can be created and deleted 

during use of HOPEX. 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\Db\<Repository>\USER and sub-

folders 

Personal folders of the users.  

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\Db\<Repository>\WORK and sub-

folders 

Working folder for administration of repository.  

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\Intranet 

Default root folder for static HTML page generation.  

This folder can be configured (optional). 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\Mega_user 

Folder containing customized resources (.MGS, .DOT files) 

Update and 

delete 

Read 
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File Location Administrator 

rights 

User rights 

*.* <Environment folder>\SysDb 

Folder of system repository. It consists of 4 files 

(SystemDb.ema, SystemDb.emb, SystemDb.ems, 

SystemDb.emv) 

Update and 

delete 

Update no 

delete 

*.* <Environment folder>\SysDb\SystemDb.Log 

Folder of system repository logfile. One file (.MGL) per 

administration session or per private workspace dispatched. 

These files can be created and deleted during use of HOPEX. 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\SysDb\SystemDb.Lock 

Folder of system repository locks for GBMS storage. One file 

(.EMK) per lock placed. These files can be created and deleted 

during use of HOPEX. 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\SysDb\SystemDb.Transactions 

Folder of private workspaces for system repository (for GBMS 

storage only) and repository backup logfile (for all types of 

storage). 

If the repository is stored in the GBMS format (default), each 

private workspace consists in two files (.EMB and .EMS). 

These files are created on opening a private workspace and 

deleted at each dispatch. 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\SysDb\USER and sub-folders 

Folder of user reports (<user code>.TXT) 

Update and 

delete 

Update and 

delete 

*.* <Environment folder>\SysDb\WORK and sub-folders 

Working folder for administration of system repository. 

Update and 

delete 

Update and 

delete 
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9.3. Example of command lines for HOPEX Web Front-End 
 

Recommended command line for Web Application Server (web standalone installation): 

 

C:\WINDOWS\system32\msiexec.exe 

/package "\\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi" 

/passive 

/levw "C:\tmp\ScriptInstall.log" 

SELECTED_LANGUAGE="1033" 

ADDLOCAL="ALL"  

ALLUSERS="1" 

INSTALLDIR="C:\Program Files (x86)\MEGA\HOPEX V2R1" 

IS_NET_API_LOGON_USERNAME_HOPEX="<mydomain>\<myuser>" 

IS_NET_API_LOGON_PASSWORD_HOPEX="<mypassword>" 

IS_NET_API_LOGON_USERNAME_API="<mydomain>\<myuser>" 

IS_NET_API_LOGON_PASSWORD_API="<mypassword>" 

WEBPORTAL_USERNAME="<mydomain>\<myadminuser>"  

WEBPORTAL_PASSWORD="<myadminpassword>" 

WITHSSL="0" 

 

Note: 

• The above command line is displayed though seveval lines for better understanding. 

 

Result: 

• HOPEX core programs are installed  

• The system of the machine is updated (registry, libraries). 

• Windows Service are installed  

o HOPEX Site Service Provider 

o HOPEX Service Watchdog 

o HopexRedisBackEnd 

• Redis client programs are installed. 

• Different IIS applications are installed on the target web server 

o Hopex 

o Hopex2 

o HOPEXAdministration 

o HOPEXAPI 

o HOPEXPIMWAS 

o HOPEXLicenceManager 

o HOPEXMonitor 

o HOPEXMWAS 

o HOPEXSupervision 

o MegaSSP 

o UAS 

o WindowsAuthenticationService 

  

baggage/HOPEX_2
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Recommended command line for SSP Server: 

 

C:\WINDOWS\system32\msiexec.exe 

/package "\\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi" 

/passive 

/levw "C:\tmp\ScriptInstall.log" 

SELECTED_LANGUAGE="1033" 

ADDLOCAL="ALL" 

REMOVE="HOPEX,HOPEX_MWAS,HOPEX_API,HOPEX_API_MWAS,HOPEX_UAS,HOPEX_CONSOLES_PORTAL

" 

ALLUSERS="1" 

INSTALLDIR="C:\Program Files (x86)\MEGA\HOPEX V2R1" 

IS_NET_API_LOGON_USERNAME_HOPEX="<mydomain>\<myuser>" 

IS_NET_API_LOGON_PASSWORD_HOPEX="<mypassword>" 

IS_NET_API_LOGON_USERNAME_API="<mydomain>\<myuser>" 

IS_NET_API_LOGON_PASSWORD_API="<mypassword>" 

WEBPORTAL_USERNAME="<mydomain>\<myadminuser>"  

WEBPORTAL_PASSWORD="<myadminpassword>" 

WITHSSL="0" 

CLUSTERDIR="<configuration root path (clusterrootpath)>" 

 

Note: 

• The above command line is displayed though seveval lines for better understanding. 

 

Result for SSP server: 

• HOPEX core programs are installed  

• The system of the machine is updated (registry, libraries). 

• Windows Service are installed  

o HOPEX Site Service Provider 

o HOPEX Service Watchdog 

o HopexRedisBackEnd 

• Redis client programs are installed. 

• The system of the machine is updated (registry, libraries). 

• Windows Service 'HOPEX Site Service Provider' is installed 

• Different IIS applications are installed on the target web server 

o MegaSSP 

• The local configuration file (Megasite.ini) contains the reference of the shared configuration folder. 

Example: 

[LAN] 

clusterrootpath=\\mega\data 

  

baggage/HOPEX_2
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Recommended command line HOPEX Web Application Server nodes: 

 

C:\WINDOWS\system32\msiexec.exe 

/package "\\Srv001\Master\HOPEX\DISK1\HOPEX V2R1.msi" 

/passive 

/levw "C:\tmp\ScriptInstall.log" 

SELECTED_LANGUAGE="1033" 

ADDLOCAL="ALL" 

REMOVE=" HOPEX_SITE_SERVICE_PROVIDER" 

ALLUSERS="1" 

INSTALLDIR="C:\Program Files (x86)\MEGA\HOPEX V2R1" 

IS_NET_API_LOGON_USERNAME_HOPEX="<mydomain>\<myuser>" 

IS_NET_API_LOGON_PASSWORD_HOPEX="<mypassword>" 

IS_NET_API_LOGON_USERNAME_API="<mydomain>\<myuser>" 

IS_NET_API_LOGON_PASSWORD_API="<mypassword>" 

WEBPORTAL_USERNAME="<mydomain>\<myadminuser>"  

WEBPORTAL_PASSWORD="<myadminpassword>" 

WITHSSL="0" 

CLUSTERDIR="<configuration root path (clusterrootpath)>" 

 

Note: 

• The above command line is displayed though seveval lines for better understanding. 

 

Result for HOPEX Web Application Server nodes: 

• HOPEX core programs are installed  

• The system of the machine is updated (registry, libraries). 

• Windows Service are installed  

o HOPEX Service Watchdog 

o HopexRedisBackEnd 

• Redis client programs are installed. 

• Different IIS applications are installed on the target web server 

o Hopex 

o Hopex2 

o HOPEXAdministration 

o HOPEXAPI 

o HOPEXPIMWAS 

o HOPEXLicenceManager 

o HOPEXMonitor 

o HOPEXMWAS 

o HOPEXSupervision 

o UAS 

o WindowsAuthenticationService 

• The local configuration file (Megasite.ini) contains the reference of the shared configuration folder. 

Example: 

[LAN] 

clusterrootpath=\\mega\data 

 

 

 

baggage/HOPEX_2
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9.4. List of program features displayed in the setup wizard 
 

Program feature Comment Installation feature 

(internal) 

HOPEX BackEnd  BackEnd 

  MEGA Web Access for Hopex 

API 

Installs IIS application 

'HOPEXAPIMWAS' on IIS 

HOPEX_API_MWAS 

 

  MEGA Web Access for Hopex Installs IIS application 
'HOPEXMWAS' on IIS 

HOPEX_MWAS 

  HOPEX Site Service Provider Installs SSP component/service on 

IIS 

HOPEX_SITE_SERVICE_

PROVIDER 

HOPEX FrondEnd Installs IIS application 'HOPEX' and 

'HOPEX2' on IIS 

FrontEnd 

  HOPEX (IIS) Installs IIS application 'HOPEX' and 
'HOPEX2' in IIS 

HOPEX 

  HOPEX API Installs IIS application 'HOPEXAPI' 

on IIS 

HOPEX_API 

  Hopex Unified authentication 
service 

Installs IIS applications 'UAS' and 
'WindowsAuthenticationService' on 

IIS 

HOPEX_UAS 

  Hopex Console Portal Installs IIS application for HOPEX 

Web Consoles on IIS 

HOPEX_CONSOLES_PO

RTAL 

    Hopex Administration Installs IIS application 
'HOPEXAdministration' on IIS 

HOPEX_WADMIN 

    Hopex Web Supervision Installs IIS application 

'HOPEXSupervision' on IIS 

HOPEX_WSUP 

    HOPEX License Manager Installs IIS application 
'HOPEXLicenceManager' on IIS 

HOPEX_WLIC 

    HOPEX Web Monitor 

Manager 

Installs IIS application 

'HOPEXMonitor' on IIS 

HOPEX_WMON 

MEGA software Installs core programs (by default in 

%programfiles(x86)%\MEGA\HOPE
X V2R1) 

MEGA 

  Redis Client executable Installes redis component (by 

default in 
%programfiles\MEGA\HOPEX V2R1) 

Redis_SBS 

  Administration Program Installs a launcher 

Administration.exe in the root folder 
of core programs  

Administration.exe 

  MUST License Management 
Program 

Installs a launcher licensing.exe in 
the root folder of core programs  

Licensing.exe 

  Utilities Installs utilities in a subfolder 

'\Utilities' of the root folder of core 
programs 

See table below 

  MEGA Documentation Installs documentation in PDF 

format in a subfolder 
'\Documentation' of the root folder 

of core programs  

Documentation 

  Debugging files Installs additional files for 

debugging purpose in a subfolder 
'\System' of the root folder of core 

programs  

MEGA.DebugSymbol 
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9.5. Embedded Internet Explorer 
Certain features of Windows Front-End (start page, diagram creation wizard in graphic mode) 

use Internet Explorer in embedded mode. This use of Internet Explorer can be impacted by 

system settings. 
 

If features are not running as expected (ex: creation of diagram), it is recommended to configure 
trusted sites in Internet Explorer as follows: 

 
Pre-requisite: 

Identify the network name of the machine that hosts the HOPEX Environment, ex S0045008. 
 

Procedure: 

1. Run Internet Explorer. 
2. From the Tools menu, select Internet Options. 

3. In Security tab, select 'Trusted sites' and click Sites. 
The 'Trusted sites' window is displayed. 

4. Uncheck 'Require server verification (https:) for all sites in this zone'. 
5. Enter the network name of the machine identified before (ex S0045008), and add it to 

the trusted sites. 
 

 
 

Notes: 
• Even if you use a different HTML Browser, this configuration is relevant. It affects the 

behavior of Internet Explorer in embedded mode that is independent from the HTML 
browser used. 

• If this configuration is not allowed (security policies), ask the local system administrator 
to perform it. 

For Citrix, this configuration is required for all users of HOPEX. ask the local system administrator to 

perform it using Windows GPO (Group Policy Object). 
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9.6. Complete list of installation features 
Installation feature (internal) Comment Target folder 

Administration.exe  Installs Administration.exe INSTALLDIR 

Data.Extractor Installs MEGA Data Extractor utility INSTALLDIR\Utilities\MEGA Data Extractor 

Documentation  Installs documentation INSTALLDIR\Documentation 

EnvComparator  Installs MEGA Customisation Analyser utility INSTALLDIR\Utilities\MEGA Customisation 

Analyser 

Install Installs the folders 'Advance Reporting', 'Compatibility Tools', 'Doors', 

'Languages' 

INSTALLDIR\Install 

Install.DBMS Install RDBMS related resources INSTALLDIR\Install\RDBMS client 

Install.Licenses  Installs the folder 'Licenses' INSTALLDIR\Install\Licenses 

Install._GR  Installs the _GR files, Upgrade files, preinstalled SystemDb (GBMS), 

predefined system business documents 

INSTALLDIR\Install 

Licensing.exe Install Licensing.exe INSTALLDIR 

MEGA Installs HOPEX.exe, binary files and resources (folders 'java', 

'Mega_std', 'System' and '\Utilities\Solution Pack') 

INSTALLDIR 

MEGA.DebugSymbol  Install PDB files (optional) INSTALLDIR\System 

Optional.File Installs optional .mol files INSTALLDIR\Mega_Std 

Optional.Moka_Reference  Installs MOKA related resources INSTALLDIR\Mega_Std\Moka Reference 

RDBMS_Diagnostic  Installs RDBMS Diagnostic tool INSTALLDIR\Utilities\RDBMS Diagnostic 

System.FlexGrid  Redistributable file system Microsoft FlexGrid %systemroot% 

System.GDIplus  Redistributable file system Microsoft GDI + %systemroot% 

System.MSXML  Redistributable file MS XML3 %systemroot% 

System.Redist  Redistributable file system %systemroot% 

System.Scripting56  Redistributable file system Windows Scripting Host 5.6 %systemroot% 

System.VB6  Redistributable file system VB6 Runtime %systemroot% 

System.VC8  Redistributable file system VC8 %systemroot% 

System.VC10  Redistributable file system VC10 %systemroot% 

System.VC15 Redistributable file system VC15 %systemroot% 

System.WData  Redistributable file system WebData std library %systemroot% 

Test.Utilities  Installs utilities: 

HOPEX Server Supervisor utility, RDBMS Diagnostics… 

INSTALLDIR\Utilities 
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Installation feature (internal) Comment Target folder 

Utilities  Installs utilities and resources: 

MEGA Mail Test utility, transport order (Solman) 

INSTALLDIR\Utilities 

HOPEX  Installs IIS application 'HOPEX' and 'HOPEX2' in IIS IISROOT\wwwroot\HOPEX 

HOPEX_MWAS  Installs IIS application 'HOPEXMWAS' in IIS 

Installs service 'HOPEX Service Watchdog' 

IISROOT\wwwroot\HOPEXMWAS 

IISROOT \wwwroot\MegaMSW 

<registry> 

HOPEX_SITE_SERVICE_PROVIDER Installs IIS application 'MegaSSP’ in IIS 

Installs services 'HOPEX Site Service Provider and 'HOPEX Service 

Watchdog' 

IISROOT\wwwroot\MegaSSP 

<registry> 

HOPEX_API Installs 'HOPEX API IISROOT\wwwroot\HOPEXAPI 

HOPEX_API_MWAS Install 'MEGA web Access for HOPEX API' IISROOT\wwwroot\HOPEXAPIMWAS 

HOPEX_WEB_ACCESS Groups features HOPEX_API_MWAS et HOPEX_MWAS and  sub-

features 

 

HOPEX_UAS Installs IIS applications 'UAS' and 'WindowsAuthenticationService' on 

IIS  

IISROOT\wwwroot\UAS 

IISROOT\wwwroot\ 

WindowsAuthenticationService 

HOPEX_CONSOLES_PORTAL 

 

Installs IIS application for HOPEX Web Consoles on IIS IISROOT\wwwroot and subfolders 

HOPEX_WADMIN 

 

Installs IIS application 'HOPEXAdministration ' on IIS 

 

IISROOT\wwwroot\HOPEXAdministration 

HOPEX_WSUP 

 

Installs IIS application 'HOPEXSupervision' on IIS IISROOT\wwwroot\HOPEXSupervision 

HOPEX_WLIC 

 

Installs IIS application 'HOPEXLicenceManager' on IIS 

 

IISROOT\wwwroot\HOPEXLicenceManager 

HOPEX_WMON Installs IIS application 'HOPEXMonitor' on IIS IISROOT\wwwroot\HOPEXMonitor 

Redis_SBS Installs Redis component %programfiles%\MEGA\V2R1 

FrondEnd Groups features HOPEX_MWAS, HOPEX_API_MWAS,  

HOPEX_SITE_SERVICE_PROVIDER and  sub-features 

IISROOT\wwwroot and subfolders 

BackEnd Group features for HOPEX, 

HOPEX_API,HOPEX_UAS,HOPEX_CONSOLE_PORTAL and all their sub-

features 

IISROOT\wwwroot and subfolders 
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This document describes all the steps required to install MEGA HOPEX Web Front-end on Windows 

Server 2012 R2 or above. 
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PREREQUISITES 

Operating System 

MEGA HOPEX Web Front-End can be installed on the following systems: 

• Windows Server 2008 R2 (not recommended because of the coming end of Support 
by Microsoft, but supported) 

• Windows Server 2012 

• Windows Server 2012 R2 
• Windows Server 2016 

To install MEGA HOPEX Web Front-End, you must open a Windows session with a domain user 
that has administrator rights on the server machine. 

This document describes installation steps for Windows Server 2012 R2. Some steps might need to 

be adapted when using Windows Server 2008 R2. 

.Net 

.Net 4.6.2 is required. 

It is already installed by default with Windows Server 2016. 

For more information on installing it on previous versions, please follow the following article: 

https://www.microsoft.com/en-us/download/details.aspx?id=53345 

Visual C++ Redistributable for Visual Studio 2015 

This package is required for a good behavior of both the web client, and the Windows client of 
the application. 

The associated libraries were previously embedded with our own, but Microsoft changed its 
approach, and recommends now to install this redistributable through their official installer. 

The offline installer can be found at this address: 

https://www.microsoft.com/en-us/download/details.aspx?id=48145 

If you want to download it from that location, make sure to download the 32 bits’ version, file 
“vc_redist.x86.exe”. 

Moreover, once the HOPEX application is installed, you will be able to find it in the folder 

“<installation folder>\Install\vc_dedist”. 

 

Required roles 

If the roles are already in place, at least check that all sub features are active. 

1. Through the “Server Manager”, click “Manage” and select “Add Roles and Features”:  

 

https://www.microsoft.com/en-us/download/details.aspx?id=53345
https://www.microsoft.com/en-us/download/details.aspx?id=48145
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2. In the Roles, activate both: 

• « File Server » : 

 

• « Web Server (IIS) » and its related features : 
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3. In the “Features”, make sure to activate the “ASP.NET 4.5”. Normally, if you installed 

4.6.2 prior to this activation of features, it shouldn’t be needed: 
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4. In the “Role Services” of IIS, make sure that “Static Content” is checked: 
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5. In addition, for the “Web Server (IIS)” role, the following “Role Services” and their 

dependencies must be installed: 

• ASP.NET 4.5 (and related features) 

• CGI 
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6. To manage specific rights on the website (such as restricting access to the admin page), 
you can also: 

a. activate “URL Authorization” and “Windows Authentication”: 
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7. Install: 

 

Desktop heap configuration 

The Desktop Heap is an internal memory of Windows. It is heavily used by the web application. 

It is thus mandatory to update this value. 

Thus, when running several users simultaneously on the same server, the Windows session of 

the impersonation user might start running out of desktop heap. This will create execution errors. 

This is especially true because the impersonation user uses a non-interactive session, and the 

default value set for the non-interactive desktop heap for in this case is very low. 

With the latest version of the application, we check that the desktop heap is set to at least 8 MB. 

If it isn’t, anyone that will access the website will receive a warning message. 

This modification needs to be made in the Windows Registry. Look for the “Windows” value in 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\SubSystems. 

There's a long string for this value that will look similar to this: 
%SystemRoot%system32csrss.exe ObjectDirectory=Windows SharedSection=1024,3072,512 

Windows … 

It is the Shared Section part that might need to be modified. The three values are, in order: the 

shared heap, the interactive desktop heap, and the non-interactive desktop heap. They are 
expressed in KB. Default values vary significantly between Windows versions. You will need to 

modify the non-interactive desktop heap. 

Be careful of not using excessive values, as this could stop you from logging into your server. It 
is therefore recommended to change this value using small increments. 
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The minimum value to put is therefore: 8192. 

 

It works for small/medium deployments. For configuration when a large amount of concurrent 

users is expected on the Web Front-End server, please get in touch with your Mega contact that 
will ask for the assistance of appropriate people. 

Configuration of SSL / TLS 

To ensure data protection, it is highly recommended to use SSL/TLS. 

Therefore, the installer allows to install the web application on a website where HTTPS is already 
deployed. 

If you want to activate this feature, it is then mandatory, as a prerequisite, to configure your IIS 

platform to activate the SSL/TLS. 

You will need to have a certificate. You can bind the HTTPS protocol to any wanted port, the 

installer will ask you on which website you want to install Hopex, and on which port. 

Please note that if you want to do this, you will need to choose the “Custom Setup” type of install 

(see section “MEGA HOPEX Setup” for details). In a standalone web deployment, we deploy 
without SSL/TLS. 

You can find on the following link some documentation of IIS: 

http://technet.microsoft.com/en-us/library/cc771438%28v=ws.10%29.aspx 

We also provide a technical article that explains how to secure the Hopex platform that contains 

some guidelines about the actions of SSL/TLS, as well as an example of configuration. Please 
refer to the article “Web Front-End - Securing the platform.doc”. 

!!Warning!! Do nosession typet choose to use the SSL/TLS when installing Hopex unless you 
have made the deployment on your web server, with a proper certificate on the appropriate port. 

Windows User(s) for MEGA HOPEX 

When installing MEGA HOPEX, a user is required to manage process authentication. It is 

recommended not to execute the Web Application processes with an administrator user. You 
will therefore need a second domain user. 

This user will be used as an impersonate user in the web application. It is specifically linked to 

the feature called “Mega Web Access for Hopex”. All the actions carried out in MEGA HOPEX will 
be done under the identity of this windows user. 

This is only the user that will run some application pools for the web front-end part of the 
application.x² 

Moreover, if you need to use web services, and thus, you activate the feature called “HOPEX 
API”, you will need a second Windows user. It cannot be the same as the first one, or it will 

create side-effects such as navigation issues and errors for users. 

http://technet.microsoft.com/en-us/library/cc771438%28v=ws.10%29.aspx
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Define Group permissions 

This user must belong to specific windows groups: 

• He must belong to the “IIS_IUSRS” group of the server. To add the user to this group, 
use the “Computer Management” dialog box in the “Tools” of the “Server Manager”. Browse to 

the “Groups” node. Right-click “IIS_IUSRS” and select “Add to Group…” 

 

Example with a domain user called “…\hopexuser”: 
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Define MUST Licence Access 

He must be registered in the MUST license tool, have the rights to read and write data in the 
MUST license folder and to share data. For more details, see the “Must License Installation 

Guide” technical article located in the Documentation folder of your MEGA installation. 

Define COM Access rights 

He must be able to launch COM applications by default. To assign this right, proceed from the 

“Component Services” dialog box through the “Tools” section of the “Server Manager”: 

 

1. Expand the “Component Services” node, then Computers.  

2. Right-click “My Computer” and select “Properties”.  
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3. Select the “COM Security” tab and click “Edit Default…” on “Launch and Activation 

Permissions” group.  

 

4. Add the Windows user, in this example “…\hopexuser”, and give him “Local Launch” and 
“Local Activation” rights. 
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MEGA HOPEX SETUP 

Choosing your setup type 

HOPEX offers two ways to install the Web Front-End: 

- Standalone Setup: automatically installs the Web Front-End and its dependencies 
(SSP,…) on a single standalone server without SSL/TLS. 

- Advanced Setup: allows more complex installation scenarios. Use it for any multi-server 

installation (scale out or scale up), or if you require SSL/TLS. 

 

Web Front-End Standalone Setup 

1. Double-click Setup to launch the Setup program. 

2. If prompted, answer “Yes” to “Do you want to allow the following program to make 
changes to this computer?” 

3. Go through each of the following screens:   
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4. If needed, click Change to modify the installation folder for the Mega Software, else keep 

the default one. 

 

5. Select Web Standalone Setup. 
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6. Enter the username and password of the Windows User for Mega Hopex you have 

chosen in the previous section of this document. It will be used for impersonation of the 
Web application:  

 

 

 

7. You are now ready to launch the installation by clicking Install : 
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Advanced Setup 

Advanced Setup is similar to the standalone setup, except for the initial choice screens and 
extra parameter choices. 

Remark: if you plan to install the web components in a different location than 
“C:\inetpub\wwwroot”, you need to first configure the root directory of the website where 

you will install it. Here, an example for the “Default Web Site”: 

 

Browse to the folder where you want to install, and validate: 

 

Do not forget that you will need to grant the same permissions for the same users on that 
folder, following the steps of “Define “Windows User for MEGA HOPEX” files Access Rights” 

in a later section of this document. 
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Choice Screen 

1. Choose Customized Setup: 

 

2. Choose the features that you want to install. Depending on how many servers you have, 

and the type of deployment you choose (see the “Web Front-end Architecture Overview” 
document), you need at least : 

o HOPEX FrontEnd and its subfeature 

o HOPEX BackEnd, wih at least: 

� “Hopex Web Access” -> “Mega Web Access for Hopex”  

� Hopex Site Service Provider 

o The “Mega Software” suite, already activated by default 

In this example we install all those features on a single server: 
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 Note that by selecting each item, you can click Change to modify the installation  

 location of the files that are linked to a specific feature. 

3. The “HOPEX API” feature, above, is needed when you have to add web services on the 

platform. It requires another Windows user, different from the one used by the “Mega 
Web Access for Hopex” feature. You will also need to activate the “Mega Web Access for 

Hopen API” ni the “HOPEX BackEnd” section. 
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4. Choose to activate use of SSL/TLS or not. SSL/TLS is highly recommended; however, it 

requires some prior configuration of IIS (see Prerequisites section). Moreover, do not 
choose “Yes” unless the certificate is deployed in IIS. Otherwise, the installation 

will roll back. 

In this example, we do not have HTTPS activated on our website: 

 

 

5. Choose the IIS web-site where you want to install the Hopex Web Front-End. Please 

note that the installer will check that there is a website running on the chosen port, and 
will install in the first site using that port that is available. So make sure to properly 

manage your websites and their ports before choosing one for the Hopex deployment. If 

you choose a port that is bound to no site, and that isn’t listening during the 
installation, the setup will roll back :  
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6. Enter the username and password of the Windows User for Mega Hopex you have 

chosen in the previous section of this document. It will be used for impersonation of the 
Web application:  

 

 

 

 

Advanced Parameters 

Parameters depend of the components you have chosen to install. Here is the list of parameters 

that are not proposed in the standalone setup. 
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HOPEX API user 

 

Mega Site Provider (SSP) URL 

 

Security Token 

It should be identical on all Hopex installs (Web, Windows, SSP,..) that work together in a 
scale up or scale out scenario 
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Control Portal access limit 

You provide the credentials of the user that can access the new Web Consoles Portal, if activated. 
If more than one user needs to access it, you will need to make additional IIS configuration: 

 

 

URL of HOPEX MWAS Web Site 

Defined on a web server to indicate the application server 
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URL of HOPEX Web Site 

Defined on a MWAS server to indicate the web server 
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COMPLETING INSTALLATION 

Define “Windows User for MEGA HOPEX” files Access Rights 

 

• Go to the installation folder of MEGA HOPEX (By default, “C:\Program Files 
(x86)\MEGA\HOPEX V2R1” on 64 bits systems) and give read/write access rights to 

the IIS_IUSRS group, that contains your Windows User that does the 

impersonation. This way, if you change that user, you won’t have to change that 
security, but just update the above group: 

  

 

• Repeat this operation for: 

o The installation folder of MEGA HOPEX Web Front-End (by default at 

C:\Inetpub\wwwroot\hopex) 

o The environments folders to be reached through MEGA. 

By default, environments are created in sub-directories of 
C:\Users\Public\Documents. 

o The Temporary folder used for Web Access. Usually, it is at 

C:\Windows\Temp. 

Make sure your user is correctly configured for the MUST license (for more details see the “Must 

License Installation Guide” technical article located in the Documentation\Articles folder of your 
installation). 

 As a first test, run HOPEX application as the “windows user for MEGA HOPEX”. 
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Prerequisite: having a Mega environment referenced on your platform. Either one of the GBMS 

environments that you can activate through the installer. Or an RDBMS environment that you 
created in a separate step. 

To do so, go into the Mega installation folder. 

Hold down the “Shift” button, right-click Hopex.exe and select “Run as different user”: 

 

 

You must be able to launch MEGA. 
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Tune IIS 

A default option of IIS makes the worker process of the HOPEX/HOPEX2 recycle every 29 hours. 

This is what Microsoft chose to make sure that the w3wp.exe process, that manages websites 

and/or web applications within websites, to be stable. 

However, the fact that this process restarts, makes the browsing of connected users to fail, as 

they lose their browsing context. 

To avoid that, the installer disables completely this recycling, and use the default idle timeout, 

that says that after 20 minutes of complete inactivity, the worker process will stop (it will 

automatically start next time someone tries to access the website). 

We recommend to manually add a restart at a fixed hour, when you know that no one will actually 

be connected on the website, to be sure it restarts at least once a day. 
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To do this. 

1. Open the “Internet Information Services (IIS) Manager”, and go to Application Pools: 

 

2. Select “HOPEX”. 

3. Click on the “Advanced Settings” option in the contextual menu: 
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4. In the Recycling section, select the line Specific Times, and click on the “…” button: 

 

5. Click on Add: 
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6. Put the wanted restart time (in this example it’s at 2am everyday), and click on “OK” to 

validate : 

 

7. Close the Advanced Settings. Reproduce this procedure for the HOPEX2 application 
pool if you deployed HOPEX. 

A restart of IIS will be needed to make this configuration active. 

 

Configure Web Content expiration 

 

1. In the “Internet Information Services (IIS) Manager”, expand Web Sites, then Default 

Web Site.  

2. Select “HOPEX”  

3. Double-click the HTTP Response Headers functionality to open the feature: 
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4. Click Set Common Headers on the right panel:  

 

5. Set it to expire immediately : 

 

 

6. In the “Internet Information Services (IIS) Manager”, expand HOPEX 

7. Select the script folder and choose “HTTP Response Headers” again. 

8. Click Set Common Headers on the right panel. 
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9. Enable content expiration after 31 days. 

 

10. Repeat this step on the images folder. 
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WHAT’S NEXT? 

You have successfully installed MEGA HOPEX Web Front-end. 

You should now personalize your setup. 

The two main steps are: 

• Setting up an RDBMS environment 

• Configuring authentication 

Refer to Mega administration documentation. 
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TESTING THE INSTALLATION 

A pre-requisite for the test is to install an environment. 

On the server, run MEGA Administration Console (Administration.exe). Click the menu "Help" > 

"About MEGA" and check the license used. It must be the MUST license name generated for this 
installation. 

 

 

If the Administration Console does not start or if the license is not the one expected, you need 

to review the license configuration before going further. 
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Testing MEGA HOPEX Web Front-End 

Prerequisite: having a Mega environment referenced on your platform, either with SQL Server 
or Oracle.  

On the server, open a supported browser and browse to Error! Hyperlink reference not valid.. 

The login page should appear. 

 

Now, use another client machine with any supported browser and browse to 
http://<servername>/hopex/. The login page should appear. 

Log in to the environment with the Login “mega” and an empty password.  

Then select: 
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The web workspace should be displayed: 

 

Depending on available licenses, the displayed content may vary. 
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More required configuration 

Word, Excel and PDF exports 

Please, make sure your browser authorizes to download files. 

IE may display the following message in the status bar preventing from opening the PDF file: 

 

Reports (MS Word) 

In Hopex V2 R1, generated documents of new environments are automatically converted to the 
RTF format. 

However, the format of Reports documents was MS Word. 

So if you are performing a migration from a source that still has this MS Word format, you must 

follow the below steps, in order to use documents on the Web Front-End. 

You must exit any web session by dispatching or discarding your private workspace. 

Then, from a computer where Microsoft Word is installed, go to the Administration Tool, 

open the environment you wish to convert with the user ‘System’, navigate to the systemDB and 
right-click “Conversions > Convert data into current version > From HOPEX V1Rx data”, ‘x’ 

obviously being the version of your environment in the process of being migrated: 
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This is the last possible conversion called “MEGA Repository - Convert Report Templates (MS 

Word) to RTF Format”, that is checked by default: 

 

 

Required options configuration 

You must fill-in a number of site options using Administration.exe, at the root level: 
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The following options are required for MEGA HOPEX Web front-end to operate: 

• In the Installation > Web Application folder: 

o “Web Application path” (e.g. http://myWebServer/HOPEX/) and “Complete 
path of the web application to open a second HOPEX”, are already filled-in 

by the setup. However, you may have to change it if a DNS alias is put in 
place after the setup, or if your web servers are behind a Load Balancer or a 

reverse-proxy that has a different address than the server name itself: 

 

http://mywebserver/HOPEX/
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• In the Installation > Electronic mail folder: 

o Default address of sender via SMTP 

o SMTP Server 

o Any SMTP configuration (port, SSL, authentication, etc.) required by your 
infrastructure 

 

 

In V2R1, please note that your MegaSite.ini will contain the version number. So if you upgraded 
a V1R2 version to a V2R1 version, and wanted to keep your settings, make sure that you have 

those information in the [System] section of your MegaSite file : 

MegaCurrentVersion=30208 

 

Allowing the use of verbose logs and activation 

To allow Mega to perform deep analysis of the logs, it can be asked to activate the verbose mode. 

The verbose mode activation includes two steps: 

• Registry update 

• Mega Server Supervisor: « verbose mode » activation  

� To deactivate this configuration, see Disabling the verbose mode p. 48. 
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Registry update 

To update the registry before activating the verbose mode: 

1. Allow the impersonate account (see “Windows User for MEGA HOPEX” section) to have 

read/write access to a key (see Windows User(s) for MEGA HOPEX p. 11). 

2. Make sure that the account that runs the “Mega Site Service Provider” Windows service 
has the same access level.  

a. Check which account is running the service: 

 

If it is « Local System », you do not need to update the registry for that service, 
only for the impersonate user. 

Otherwise, if you run the service with a local account or domain account different 
than the impersonate account, we advise you to add this account in the IIS_IUSRS 

local group. 

b. Launch the “regedit.exe” executable to open the registry. 

c. The registry key on which you need to change the permissions is: 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\MEGA 

Right-click the key and select Permissions. 

 

 



Web Front-End Single-Server Installation Guide HOPEX V2R1 
EN 

page 46/59 C0 - PUBLIC 

 
 

 

d. On this key, add the “IIS_IUSRS” local group. 

The impersonate acount is normally included in the “IIS_IUSRS” local group, and 
as stated before, that can contain the account that runs the “Mega Site Service 

Provider”. 

e. Allow: “Full Control” and “Read”. 

 

f. Apply and close the registry. 
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Mega Server Supervisor: « verbose mode » activation 

1. In the MEGA installation folder, expand the Utilities > Mega Server Supervisor folder 
of Mega binaries. 

2. Right-click « MEGA Server Supervisor.exe » tool and select Run as administrator. 

 

The MEGA Server Supervisor icon  appears in the system tray of your workstation. 

3. Right-click the icon and select Options. 

 

4. Select Verbose Mode.  
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5. Close the configuration window to apply. 

6. If your application was started, you need to restart it. You can use the Mega Server 

Supervisor to do so: right-click the MEGA Server Supervisor icon  and select HOPEX 

> Restart HOPEX Processes Services and Web Application. 

 

 

Disabling the verbose mode 

To deactivate the verbose mode: 

1. Follow the Mega Server Supervisor: « verbose mode » activation procedure p. 47 and 

clear Verbose mode.  

2. Restart the application to take the modification into account. 

 

URL Rewrite 

This is a component that was added with the Update 2 of Hopex V2R1. A component that is 

added to the usual IIS features. 

If you make a new install with the Update 2 master, you shouldn’t concern yourself. 

However, if you had a previous install of Hopex V2R1, and you used this document to make you 
installation, instead of the very specific release note linked to patching to Update 2, then you 

need to install that feature. 

You can find the installer link at this address: 
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https://www.microsoft.com/en-us/download/details.aspx?id=47337 

Click on “Install” and let the component get deployed: 

 

 

https://www.microsoft.com/en-us/download/details.aspx?id=47337
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A reboot is required to be able to see the feature in IIS: 
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TROUBLESHOOTING 

Check that the Site Service Provider is running 

If you have the following message, and environments are accessible using Administration.Exe 

and Mega.exe: 

 

You should first check that the “HOPEX Site Service Provider”, and the “HOPEX Service 

Watchdog”, are running using the Services administration tool: 

 

If those are not running, check that its startup is « Automatic » and Start the services. 

If it is running, restart the service. 

Then restart IIS (see below). 
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Restarting Internet Information Services 

If errors occur, the first step is to try to restart the Web Server. 

In the “Internet Information Services (IIS) Manager”, select the server name and click “Restart” 

in the Actions panel 

 

Referencing a New Environment 

So that a new environment is fully accessible in MEGA HOPEX, do not forget to give the “Windows 

user for MEGA HOPEX” full access rights to the environment folder. 

If you have a multi-server deployment, you should reference it and check the rights on every 

server (except for pure web servers). 

Disabling Data Execution Prevention 

In rare cases, it might be necessary to disable “Data Execution Prevention (DEP)” for MEGA 

programs. 

If you are able to run the Administration.exe and/or the Hopex.exe rich clients from the web 

server, then the following procedure is unnecessary. 

To access the DEP settings: 

In the “Start” menu, right-click “Computer” and select “Properties”. In the next screen, click 
“Advanced System Settings”. Go to the “Advanced” tab, click “Settings” in the “Performance” 

group and select the “Data Execution Prevention” tab. 
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You can either turn on DEP only for essential Windows programs and services, or add exceptions 

for the following Mega programs (default installation locations): 

• C:\Program Files (x86)\MEGA\HOPEX V2R1\System\mgwspro.exe 

• C:\Program Files (x86)\MEGA\HOPEX V2R1\System\mgwmapp.exe 

• C:\Program Files (x86)\MEGA\HOPEX V2R1\System\mgwmwas.exe 

 

 

Loosening Internet Explorer Security Settings 

Although default browser security settings on client machines are sufficient for using the MEGA 
Web Application, some computers, especially servers, might have stricter security policies. For 
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instance, they might prevent the execution of JavaScript, on which the MEGA Web Application 

relies. 

 

To fix this issue, follow the steps below: 

Step 1: Enable Active Scripting on the trusted sites zone 

1. Go to the “Tools\Internet Options…” menu 

2. Select the “Security” tab 

3. Click on “Trusted Sites” then “Custom Level” 
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4. Enable “Active Scripting” 

 

Step 2: Add MEGA Web Application to the trusted Web sites list 

1. Go to the “Tools\Internet Options…” menu 

2. Select the “Security” tab 

3. Click “Trusted sites” then “Sites” 

4. Enter the Address of your Web site, click “Add” 

5. Validate 
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Manage http 503 error 

If, when trying to access the /hopex of your web application, you end up on this kind of error 
page: 

 

If this is the case, you may want to check IIS Manager, and more precisely the status of the 
application pool called “HOPEX”. 

As you can see, it is in “Stopped” status: 
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You can try to start it again, and refresh your browser. If you continue to have this error 
message, you can go back to IIS Manager, refresh the view of the application pools, and see if 

it is stopped again. 

If it is still the case, you most likely have a policy issue on that account. 

To check the local policies, execute the following command from the “Run” menu of your 
application server: 

gpedit.msc 

 

In that tool, browse to “Computer Configuration -> Windows Settings -> Security Settings -> 

Local Policies -> User Rights Management”, and locate the rules : 

- Log on as a batch job 
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- Impersonate a user after authentication 

If you open the Properties of those rules, you need to check if the groups containing the Windows 
user you set up during the installation are part of the list of granted resources. 

Here, we see that the IIS_IUSRS local group is missing: 

  

It most likely means that, at a higher level, group policies (or GPOs) are set to remove that 

group, which is normally granted that right. 

If you can modify it yourself, click on “Add User or Group…”, and add the “IIS_IUSRS” local 

group: 
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Do it for both policies. And restart the application, and IIS. Make sure that the “HOPEX” 

application pool is started. And test again. If this update was successful, you will see the login 

page: 

 

 

If editing those policies is not permitted (grayed out in the interface), you need to explain this 
to the people in charge of setting up GPOs for the servers, so that they make this modification. 
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SUMMARY 

 

This document applies to HOPEX V2R1 Update 2 and higher update. 

 

It does not describe: 

• How to perform installations (see installation documentation). 

• How to manage installations (see administrator manuals). 

• How products are licensed (see license installation documentation). 

• How to use features (see user manuals). 

 

The figures provided in this document are recommendations that may not apply to all contexts. 

In committing phases, a specific study with MEGA product management support is compulsory. 
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1. DEPLOYMENT TYPES 

The HOPEX Web Front-End can be deployed in different typical ways: 

 

Deployment type Recommended for  Comment 

Standalone Small deployment 2 tiers architecture 

All in one server. Very easy to install. 

Horizontal scaling Large deployment 

 

Multi-tiers architecture 

Also called 'Scale up' 

Vertical scaling Large deployment Multi tiers architecture 

Also called 'Scale out' 

Other deployments – For specific requirements, other deployments are possible. For further 

information, contact your sales representative. 
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1.1. Standalone Deployment 

 

 
 

 

To facilitate readability, different elements have not been displayed (authentication server, mail server, SQL 

Server Native client required for SQL Server storage). 
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1.2. Horizontal scaling Deployment 

 

To facilitate readability, different elements have not been displayed (authentication server, document 

server, mail server, SQL Server Native client for SQL Server storage). 
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1.3. Vertical scaling Deployment 

 
 

To facilitate readability, different elements have not been displayed (authentication server, mail server, SQL 

Server Native client for SQL Server storage). 
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1.4. Vertical scaling Deployment (detailed view) 

 
 

To facilitate readability, SQL Server Native client (SQL Server storage) is not displayed. 
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2. COMMON DEPLOYMENT REQUIREMENTS 

2.1. Web Client 

HTML Browser 32/64 bit MS Edge (1) 

Mozilla Firefox ESR (1) 

Google Chrome (1) 

Apple Safari (1) 

Configuration Screen resolution 1280x800 

16 M colours 

JavaScript enabled 

Cookies enabled 

HTML 5 enabled 

Download of files enabled 

Popup blocker disabled 

Web storage enabled 

Additional Software PDF reader 

RTF/DOC/DOCX reader 

XLS/XLSX reader 

 

(1) Supported with minor restrictions. See FAQs section p. 26. 

2.2. Application Server 

Operating system Windows Server 2012 

Windows Server 2012 R2 

Windows Server 2016 

Microsoft Azure deployment (1) 

For other systems a specific study is necessary 

Visual C++ Redistributable for Visual Studio 2015 (2) 

Hardware Processor 

Multi core 

RAM 

6 GB minimum. 

2 GB for the system  

2 GB for data cache in memory 

Per environment SSP 

400 MB 

Per equivalent concurrent modeller user 

600 MB intensive use 

300 MB low use 

Disk space 

4 GB recommended for HOPEX Kernel 

200 MB recommended for IIS applications  

500 MB recommended for logs 

Additional Software SQL Server Native client 11.0 (SQL Server 2012, SQL Server 2014, 

SQL Server 2016) 

If data is stored in SQL Server 
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Web Server MS Internet Information Services 8.0 

MS Internet Information Services 8.5 

MS Internet Information Services 10.0 

Script layer ASP .NET 

.NET Framework 4.6.2 or higher 

 

(1) With specific parameters. See Appendix 

(2) Required for each Window machine running HOPEX kernel (workstation or server). 

 

Note that these are general indications. You should contact MEGA to discuss a more suitable sizing, 

especially if more than 5 users are expected. 

2.3. File Server 

Operating system Windows Server 2012 

Windows Server 2012 R2 

Windows Server 2016 

Microsoft Azure deployment (1) 

For other file systems a specific study in necessary 

Hardware Processor 

Multi core 

RAM 

1 GB minimum. 1 GB for the system 

Disk space 

5 GB recommended per HOPEX Environment (environment 

folder) 

10 MB for HOPEX License 

 

(1) With specific parameters. 

2.4. Database Server 

Server System see RDBMS requirements 

RDBMS Oracle Database Server 12C (12.1, 12.2),  

SQL Server 2014 

SQL Server 2016 

Disk space Data: 

2 GB minimum per system database 

3 GB minimum per data repository 

Refer to the separate article 'RDBMS Repository Installation guide 

HOPEX V2R1'. 

Hardware  RAM: a specific study is required. Refer to the separate article 

'RDBMS Repository Installation guide HOPEX V2R1'. 

CPU: see hardware requirements of the RDBMS. 
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3. COMMUNICATION 

3.1. Between Web Client and Web server (Web Application Server) 
 

Protocol HTTP by default 

Port 80 by default 

Network bandwidth Per equivalent modeller user 

60 Kbit/s average bandwidth 

512 Kbit/s peak bandwidth 

Network latency 100 Ms maximum (A) 

(A) For a ping of 5 KB (It is recommended to use the hrping utility). Refer to the separate article 'RDBMS 

Repository Installation guide HOPEX V2R1'. 

Note that a proxy configuration can be required: see section 'Security' of this document. 

 

3.2. Between Environment SSP or MIK and Database server (Oracle, 

SQL Server) 
 

Protocol Oracle: Oracle Native Protocol 

SQL Server: SQL Server Protocol 

Port Oracle: Example TCP 1521 (B) 

 SQL Server: Example UDP/TCP 1433 (B) 

Network bandwidth 1 Gbit/s minimum full duplex (C) 

Network latency 1 Ms maximum (A) 

(A) For a ping of 5 KB (It is recommended to use the hrping utility). Refer to the separate article 'RDBMS 

Repository Installation guide HOPEX V2R1'. 

(B) Default port, check the appropriate port with the database administrator. 

(C) For 30 concurrent users. 

 

3.3. Between Environment SSP or MIK and mail server 
 

Protocol SMTP 

Port 25 by default, configurable 

Network bandwidth 1 Gbit/s minimum full duplex (C) 

Network latency 1 Ms maximum (A) 
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3.4. Between Environment SSP or MIK and file server (file access, 

license access) 

 

Protocol SMB/CIFS 

Port UDP/TCP 138 

UDP/TCP 137 

UDP/TCP 139 

UDP/TCP 445 

Network bandwidth 1 Gbit/s full duplex 

 

3.5. Between Environment SSP and LDAP Server 
Protocol LDAP 

Port TCP 389 by default (B) 

Direction Bidirectional 

(B) Default port, check the appropriate port with the LDAP server administrator. 
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4. INSIDE 

4.1. Administration tools 
Several administration tools can be used: 

 

Administration tool Component Tasks 

Web Administration Desktop Desktop of HOPEX Web 

Front-End 

Functional administration (user, permissions, 

workspaces, LDAP configuration, 

import/export...) 

Web Supervision console .NET application Monitoring of running processes and events… 

Web Monitoring console .NET application  Monitoring of connected user, management of 

logs, installation checks… 

Web Licensing console .NET application  Monitoring of license use, assignment of users 

to the license… 

Windows Administration 

Console  

Win32 (Administration.exe) Data storage management (environment, 

repositories, stored procedures) 

Functional administration (user, permissions, 

workspaces, LDAP configuration, 

import/export...) 

Monitoring Console .net web page (XX.aspx) Supervision of HOPEX (IIS) application 

IIS manager Win64 (InetMgr.exe) Management of IIS server 

Must license manager Win32 (Licensing.exe) Management of Must license 

Windows Front-End  Win32 (HOPEX.exe) Fix unexpected configuration issue 

HOPEX Server Supervisor  Win32 (Hopex Server 

Supervisor.exe) 

System supervision of the server 

 

Reference: 

See online documentation, HOPEX Administration … Administrator Guide 

4.2. Anti-virus Configuration 
To maintain good performances, it is recommended to exclude certain file extension from antivirus 

scanning (on access scanning) 

 

Machine Location/File Comment 

Each machine running 

HOPEX 

%programdata%\MEGA and subfolder 

Ex: C:\ProgramData\MEGA 

File extension: *.MGC 

Folders of the Compiled data 

cache and RDBMS local cache 

Each machine running 

HOPEX 

Location: check with the HOPEX 

administrator 

Ex: C:\Program Files (x86)\MEGA\MEGA 

HOPEX V2R1 

File extension: *.* 

Folders of HOPEX core 

programs 

Each machine running 

HOPEX IIS application 

Location: see HOPEX administrator 

Ex: C:\inetpub\wwwroot\HOPEX 

File extension: *.* 

Folders of HOPEX IIS 

application 
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4.3. Authentication 
Basic authentication (variant MEGA) is available immediately after installation. 

Other authentication models need to be configured in HOPEX or integrated with HOPEX after installation. 

From HOPEX V2R1, an authentication framework called 'UAS (Unified Authentication Service) is used. It 

enables to: 

• Secure authentication requests. 

• Use standard identity providers. 

• Develop custom identity provider. 

 

Several authentication models can be implemented: 

 

Authentication models Description Comment 

OpenID authentication Authentication process is 

managed within HOPEX Platform. 

Users are declared in an external 
directory. 

Standard providers are available 
for the following identity 

providers: Microsoft, Salesforce, 
Google 

This model is recommended for 

standard deployments where 

OpenID is used. 
No integration is required for the 

3 identity providers addressed, 
only configuration and testing. 

For other identity providers, a 
specific integration is required. 

SAML2 authentication Authentication process is 

managed within HOPEX Platform. 
Users are declared in an external 

directory. 

A standard provider is available, 
implemented using AD FS (Active 

Directory Federation Services). 

This model is recommended for 

standard deployments where 
SAML2 is used. 

No integration is required, only 

configuration and testing. 

Windows Authentication Authentication process is 
managed within HOPEX Platform. 

Users are declared in an external 
directory. 

A standard provider is available, 

implemented using WIF (Windows 
Identity Foundation)  

This model is recommended for 
standard deployments where 

Windows Authentication is used. 
No integration is required, only 

configuration and testing. 

Basic authentication Authentication process is 

managed within HOPEX Platform. 
Users are declared explicitly in the 

HOPEX Environment and possibly 
mapped individually with an 

external directory. 3 variants: 
MEGA, LDAP, Windows 

This model is recommended for 

basic deployments. 
No integration is required, only 

configuration. 

Fully custom 
authentication 

Authentication process is external 
to the HOPEX platform (UAS is 

skipped). 
All types of IT corporate directory 

can be addressed (customized 
identity provider) 

This model is not recommended. 
It can be used for advanced 

deployments with specific 
requirement. It requires a specific 

integration. 
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Password values storage, encryption and update vary with the configuration chosen. 

 

Authentication models Storage  Encryption 

OpenID authentication According to identity 

provider specifications 

According to identity 

provider specifications 

SAML2 authentication Active Directory According to directory 

specifications 

Windows Authentication Active Directory According to directory 

specifications 

Basic authentication (MEGA) System repository Encrypted, hashed 

Basic authentication (Windows) Active Directory According to directory 

specifications 

 

Basic authentication (LDAP) LDAP directory 

Fully custom authentication According to 

implementation 

According to 

implementation 

 

Reference: 

• Online documentation, HOPEX Administration … Authentication in HOPEX 

• Article 'HOPEX Unified Authentication Service Installation guide' 

 

4.4. Cluster, scalability and load balancing 
This document contains metrics for a small deployment. Sizing is a complex matter that is closely linked to 

infrastructure and can be impacted by security policy. As a consequence, medium or large deployments 

need specific studies: 

• Initial sizing according to load hypothesis. 

• Load tests in the final infrastructure to check that sizing is appropriate. 

For large deployments, scalability and load balancing is required. 

Service Principle 

Scalability Install on a cluster/farm server. 

A configuration file is used to share configuration between nodes. 

Load balancing Install on a cluster/farm server. 

Use a load balancer mechanism to balance load between nodes. 

A specific integration is required. 

High availability Install on a cluster/farm server. 

Use server SSP nodes (multiple SSP servers) 

Use a load balancer mechanism to balance load between nodes. 

A specific study is recommended. 

 

To implement load balancing, various solutions are available on the market. In all cases the solution must 

be qualified and supported by customers and/or third parties. 
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4.5. Data access 
Access to data is mainly controlled using profiles (repository access, data permissions, and GUI 

permissions). 

Other features are available: 

• Writing access management: control of updates on existing objects. 

• Reading access management: control of visibility regarding existing objects. 

• Data access rules: computed control of visibility regarding existing objects. 

 

Reference: 

See online documentation. 

• HOPEX Administration … Managing Data Reading Access 

• HOPEX Administration … Managing Data Writing Access 

4.6. Data storage 
Each HOPEX Environment consists of one system repository and one/several data repositories. 

By default, data is stored in a database server (SQL Server, Oracle). This is called RDBMS storage. RDBMS 

storage is mandatory Web Front-End. 

 

Storage Mapping Comment 

SQL Server A data repository is an SQL 

Server database. 

A system repository is an 

SQL Server database. (1) 

Create one SQL server user for the environment with 

specific privileges. 

Only SQL server authentication is supported. 

Install and schedule stored procedures by data 

repository or system repository. 

No dedicated instance is required. 

SQL Server native client. 

Default port can be used. 

Oracle A data repository is a 

user/schema. 

A system repository is a 

user/schema. 

Create one Oracle user by data repository or system 

repository with specific privileges. 

Install and schedule stored procedures by data 

repository or system repository. 

No dedicated instance is required. 

No client-side installation (Oracle instant client). 

Default port can be used. 

Create one tablespace for each environment 

(recommendation). 

 

(1) This the standard recommendation. It is also possible to store a data repository in a schema of a SQL 

Database. 

 

Reference: 

• Article 'RDBMS Repository Installation guide HOPEX V2R1' 

• See online documentation, Products. 
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4.7. Document management 
A document management system is available through a solution or a pack. RDBMS storage is required. 

 

Object Location  Storage 

Business Document Data repository Database server 

System Business Document System database Database server 

 

If document management is enabled, web users can add, update and consult documents. 

 

Reference: 

• See online documentation, Common Features … Using Business Documents 

4.8. Error and trace logfiles 
No log is generated on the client side. All errors are displayed using popup windows or via the 
HTML browser. An option enables to control the display of errors to end users (GUI). 

For advanced diagnostic, a verbose mode can be enabled to generate more detailed logfiles. 
 

Different files can be created on server side: 
 

File Comment Default location (example) 

sspsprvsYYYYMMDD.txt Supervision log (3) %programdata%\MEGA\HOPEX 

V2R1\ClusterRoot\Supervision 
Ex: C:\ProgramData\MEGA\HOPEX 

V2R1\ClusterRoot\Supervision 

SSPLOGYYYYMMDD.txt Core SSP log (3) %programdata%\MEGA\Logs 
Ex: C:\ProgramData\MEGA\Logs 

ssperrYYYYMMDD.txt Environment SSP 
log (3) 

%programdata%\MEGA\Logs 
Ex: C:\ProgramData\MEGA\Logs 

MWASLOGYYYYMMDD.txt MWAS component 

log (5) 

%programdata%\MEGA\Logs 

Ex: C:\ProgramData\MEGA\Logs 

megaerrYYYYMMDD.txt MIK component 

log (1)  

%programdata%\MEGA\Logs 

Ex: C:\ProgramData\MEGA\Logs 

uas-YYYY-MM-DD.log UAS component 
log (4) 

%programdata%\MEGA\Logs \UAS 
Ex: C:\ProgramData\MEGA\Logs\UAS 

SWDLOGYYYYMMDD.txt Service Watchdog 
log (2) 

%programdata%\MEGA\Logs 
Ex: C:\ProgramData\MEGA\Logs 

event-YYYY-MM-DD.log Event logs  %programdata%\MEGA\Events 
C:\ProgramData\MEGA\Events 

dtpxYYYYMMDD.txt DTPX component 
log (4)  

<iis root>\HOPEX\App_Data\DTPX 
Ex 

C:\inetpub\wwwroot\HOPEX\App_Data\DTPX 

redis_server_log.txt Redis component 
log (2) 

%programdata%\MEGA\HOPEX V2R1\Logs  
Ex: 

C:\ProgramData\MEGA\HOPEX V2R1\Logs 
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Where 

• DD is a number indicating the day in the month. 

• MM is a number indicating the month in the year. 

• YYYY is a number indicating the year. 

 
(1) Location can be configured 

(2) Generated for each server where HOPEX components are installed 

(3) Generated for the server running SSP 
(4) Generated for the server running HOPEX Front-end 

(5) Generated for the server running HOPEX Back-end  
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4.9. Full search and indexing 
Solutions of HOPEX platform can use full search. A parameter at data repository and/or system 

repository level enables to activate indexing. 

There are 2 levels of indexing: 
• Full indexing: the data repository/system repository is scanned, and index files are 

created in a subfolder of the data repository/system repository. 
• Incremental indexing: the log (internal) of the data repository/system repository is 

scanned and index files are updated in a subfolder of the data repository/system 
repository. 

Full search and indexing are available with RDBMS storage only. 

Reference:  

See online documentation 

• HOPEX Administration … Enabling and Customizing Repository Indexing 

• Common Features … Presentation of search tools 

4.10. Licensing 
Products and solutions of HOPEX platform are protected by Must licenses. Must licenses can be shared 

between multiple users. 

 

Must licensing is not server-based (there is no Windows process for a license server). At runtime with 

HOPEX Web Front-end, a set of files are generated dynamically by service account.  

 

However, a domain user (Active directory) is required for: 

• Each service account running the HOPEX (IIS) application. 

• Each user running the Administration Console (system administrator, functional administrator). 

• Each user running the Windows Front-end (developer, functional administrator, user associated to a 

scheduled task). 

 

To obtain a license, contact your sales representative. A UNC will be requested and a .must license file 

(locked on this UNC) will be sent with installation instructions. 

 

Reference: 

Article 'Must License Installation Guide HOPEX V2R1'. 

4.11. Mail system 
A mail server needs to be configured so that mail notifications can be used within workflows. 

SMTP parameters (server, port, proxy...) can be configured for the installation using the 
Administration console. 
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4.12. Multi-language 
Web Front-End enables to work with multiple languages. 

 

Nature List Installation Comment 

GUI Language Core languages (1) Core languages are installed 

by default. With additional 

languages, it can be 

requested to install a 

language pack on the 

Application Server. 

Controls the display of the user 

interface (menus, pages…) 

Different end users can have 

different GUI languages. 

Data language More than 30 

languages available 

Core languages are installed 

by default. Additional 

languages are installed at 

environment level 

Enables data entry in several 

languages for objects. 

A end user can switch between 

several data languages within 

his session 

 
(1) Core languages are English, French, Italian, Spanish and German. 

 

4.13. Physical backup 
In case you face a real disaster recovery scenario, presence of a valid and restorable backup is very 

important. 

 

Element Recommendations 

Frequency Every 24 hours (1) (2) 

Retention In the last 30 days keep daily backup 

In the last 12 months keep a monthly backup 

Other files to backup By default folder of each HOPEX Environment 

 

(1) For HOPEX Environment used by an active project 

(2) In particular before a major update concerning data. E.g.: system repository customization, data 

reprocessing, CP/RP upgrade of MEGA data 

 

Specific recommendations 

 

Storage  Mode 

SQL Server Cold/warm backup recommended 

Oracle Cold/warm backup recommended 
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4.14. Redo logs and activity tracking 
 

Service Activation Comment 

Embedded log 

(repository log) 

Enabled by 

default 

Enables to generate a log of updates (redo log), activity tracking. Also 

used by specific features (full search, alert management…) This log 

can be partially/completely initialized and disabled using Windows 

Administration Console. 

External log 

(backup logfile) 

Enabled by 

default 

Enables to generate additional command files logging the updates of 

a user (backup log) that can be useful to recover quickly data after an 

incident. This log can be disabled using Windows Administration 

Console. 

 

Reference: 

See online documentation 

• HOPEX Administration … Managing Repositories. 

• HOPEX Administration … Managing logfiles.  

• HOPEX Administration … Optimizing Repository Access Performance. 

4.15. Regular administration tasks 
A few tasks need to be run and can often be automated: 

 

Task Server involved Comment 

Conservation of repository 

performance 

Database server Stored procedure to be installed and scheduled for 

each data repository and system repository. Can be 

automated. SQL server only. 

Deletion of historical data Database server Stored procedure to be installed and scheduled for 

each data repository and system repository. Can be 

automated. 

Deletion of private workspace 

temporary data 

Database server Stored procedure to be installed and scheduled for 

each data repository and system repository. Can be 

automated. 

Environment compilation Application server 

 

To build system cache. System updates are 

impossible during compilation. Need to stop HOPEX 

Services and HOPEX related processes 

Full indexing Server running SSP Manual.  

Incremental indexing Server running SSP Automated using HOPEX Scheduler. 

Information about 

fragmentation and statistics 

Database server Generates a technical report regarding physical 

indexing (statistics gathering) 

Maintenance Plan Database server Need to stop SSP when running maintenance plan 

(SQL server) 

Maintenance plan (SQL Server 

storage 

Database server Required with several tasks. Can be automated. 

Refer to the article 'RDBMS Repository Installation 

Guide HOPEX V1R2 EN 

 

Physical backup of data 

(RDBMS) 

Database server Required. Daily backup recommended. Can be 

automated. 

Restart HOPEX Web site Web server For HOPEX program upgrade (CP upgrade) 

Can be required in case of problem 

Restart IIS server Web application 

server 

Can be required in case of problem 

For IIS programs upgrade 

https://eu1.salesforce.com/50120000000mrAi?srPos=1&srKp=501
https://eu1.salesforce.com/50120000000mrAi?srPos=1&srKp=501
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Task Server involved Comment 

Restart server Application server Can be required in case of problem 

Restart SSP service (1) SSP server For HOPEX program upgrade (CP upgrade) 

For certain changes (license, list of environments, 

and list of repositories…) 

Can also be required in case of problem 

 

(1) Windows service 'Mega Site Service Provider'. 

4.16. Reporting 
There are three categories of reports: 

 

Category Native 

format 

conversion 

format 

Comment 

Report HTML RTF, XLS, 

XLSX, PDF 

Window or web Front-End 

Generated from a Report template 

According to the Report template considered, certain 

conversion formats may not be available. 

Report (MS Word) RTF - Window or web Front-End 

Generated from a list or from a Report template (MS 

Word). 

Instant report HTML - Web Front-end only 

Generated from a list or from a Report DataSet. A 

report DataSet is a table of data generated from a 

Report DataSet Definition 

 

To open a report from the web client, a reader corresponding to the format should be installed. 

Example: MS Excel to read .XLS documents, Adobe reader to read .PDF documents, Open Office/MS Word 

to read .RTF documents. 

 

(1) Web Front-End does not enable to design Report templates (MS Word): templates must be developed 

on Windows Front-End with MS Word 32-bit and delivered using a specific procedure. 

 

Execution mode Compatible Web 

Front-End 

Comment 

.RTF mode Yes Set by default 

Look and feel can be slightly different as style application is not 

enforced. RTF macros are not supported. MS Word (such as 

table of content) are not refreshed. Reports can be convert to 

DOCx 

.DOC mode No Can be configured by default 

 

Reference: 

See online documentation 

• HOPEX Power Studio … Report DataSet Definition  

• HOPEX Power Studio … Report Studio 

• HOPEX Power Studio … Customizing Reports (MS Word) 
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4.17. Security 
All ports used in the HOPEX platform are either configurable or set elsewhere. No specific port is required 

or hard-coded. To configure firewall ports, see the 'Communications' section earlier in this document. 

 

MEGA strongly recommends configuring HTTPS to improve the security of flows between the Web Client 

and the Web Server. This requires a specific configuration of IIS and HOPEX. 

 

If a local enterprise proxy is used, it should be configured by adding an excluding rule on the proxy. The rule 

refers to the IP address of the HOPEX web server involved. 

 

File permissions should enable access to: 

• Error and trace logfiles (see section 'Error and trace logfiles' in this document). 

• License folder. 

• Environment folder. 

 

Reference: 

Article 'Web Front-End - Securing the platform'. 

4.18. Services and running processes 
Serveral Windows services are created by the installation: 
 

Service Executable Startup type User (1) Server 

HOPEX Site Service Provider mgwssp.exe Automatic Local system SSP server 

HOPEX Service Watchdog mgwswd.exe Automatic Local system Each server used to 

deploy Web Front-

end 

HopexRedisBackEnd redis-server.exe Automatic Local system Each server used to 

deploy Web Front-

end 

 

At runtime, several processes can be created. 

 

Process User Comment Number 

mgwssp Local system (1) Core SSP One/several per installation. Runs on SSP server. 

Started by windows service mgwmapp 

mgwspro Local system (1) Environment SSP 

(MIK) 

One per HOPEX Environment. Runs on SSP 

server 

mgwspro Local system Scheduled job According to scheduler configuration 

mgwmwas Service account  MWAS (HOPEX) One per web application server 

 mgwmapp 

mgwspro Service account  Web session (MIK) One per end user (single session), one per group 

of user (multi session) 

mgwswd.exe Service account Service Watchdog One per server application server. Started by 

windows service 

mgwmapp Current user Administration 

Console 

One per running instance of Administration 

Console. Started manually. 

HOPEX Server 

Supervisor  

Current user  HOPEX Server 

Supervisor utility 

One per running instance of the utility. Started 

manually. 



 
Web Front-End Architecture Overview HOPEX V2R1 EN 

 

C0 - PUBLIC page 24/29 

 

 

(1) Can be configured 

4.19. Supervision 
The HOPEX platform enables system monitoring. 

Supervision logfiles are updated by the server running the SSP when various events occur. 
This information can be consulted via 

• Web Supervision console 
• HOPEX Server Supervisor (Windows utility) 

A WMI probe can also enable to supervise HOPEX from standard tools supporting WMI (a specific 
integration is required). 

 

Reference: 

See online documentation, HOPEX Administration … Managing Events 

4.20. System caches 
Several caches are created on the Windows client. For Citrix/TSE deployment, the Citrix/TSE server is 

considered as the Windows client. 

 

Cache type Location Average disk 

space  

Comment 

RDBMS local 

cache 

Default location: 

%programdata%\MEGA\<version 

code>\Cache\RDBMS data 

Ex: 

C:\ProgramData\MEGA\HOPEX 

V2R1\Cache\RDBMS data 

1-20 GB (1) One folder per HOPEX 

environment. Cache of data 

saved in database server. Can 

be disabled. Updated 

dynamically at runtime. 

Compiled data 

cache 

Default location: 

%programdata%\MEGA\<version 

code>\Cache\Compiled data 

Ex: 

C:\ProgramData\MEGA\HOPEX 

V2R1\Cache\Compiled data 

10-30 MB 

(1) 

One folder per HOPEX 

environment. Cache of 

systemdb configuration. Cannot 

be disabled. Updated by 

environment compilation. 

Cache of 

MetaPicture 

Default location: 

%programdata%\MEGA\<version 

code>\Cache\Compiled data 

Ex: C:\ProgramData\MEGA\HOPEX 

V2R1\Cache\Compiled data 

1-5 MB Cache of images. Cannot be 

disabled. Updated dynamically 

at runtime. 

Cache of 

resources 

Default location: 

<iis root>\wwwroot\HOPEX\ 

App_Data\MWAS\res 

Ex: C:\inetpub\wwwroot\HOPEX\ 

App_Data\MWAS\res   

1-10 MB (1) Cache of resources for MWAS. 

Cannot be disabled. Updated 

dynamically at runtime. 

 

(1) For one HOPEX environment 
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4.21. Technical documentation 
 

Category Audience Format Language code 

Installation and 

deployment guides 

System administrator, functional 

administrator 

PDF EN 

Online documentation End user, functional administrator web site EN, FR, IT*, DE* 

Technical articles Developer, functional administrator PDF EN 

Javadoc Developer HTML pages EN 

 

Installation and deployment guides and user manuals are installed in the subfolder \Documentation of 

HOPEX programs folder 

Example: C:\Program Files (x86)\MEGA\HOPEX V2R1\Documentation 

 

Language codes: 

 

EN : English IT: Italian 

FR: French DE: German 

 

* can be available a few months after the initial release 
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5. FAQS 

5.1.1. What about HTML browsers other than Edge, IE, Chrome, Firefox 

and Safari?  
MEGA has decided to focus on Chrome, IE, Firefox and Safari. This does not mean that solutions do not run 

on HTML browsers. It means only that these HTML browsers are not supported. 

5.1.2. Is SQL Server 2017 supported? 

SQL Server 2017 is not qualified yet. It is candidate for support in a future update or version. 

5.1.3. What is web storage for HTML browsers?  
This is a capability of HTML browsers to store data (localstorage mode) 

This capability is supported by recent browsers (IE11, Edge, Firefox, Chrome) 

5.1.4. What is supported for Azure? 
Here are the options qualified by MEGA so far: 

• Premium storage (SSD disk) 

• VM DSv2 

• SQL on local VM (private cloud, IaaS, SQL Server Web Edition) 

5.1.5. What is Mozilla Firefox ESR?  
As Firefox versions change very rapidly, MEGA has decided to focus on ESR versions. 

Extended Support Release (ESR) based on an official release of Firefox for desktop is used by organizations 

that need extended support for mass deployments. 

See also http://www.mozilla.org/en-US/firefox/organizations/faq/ 

5.1.6. What is the list of minor restrictions for Edge / IE / Chrome / 

Firefox / Safari?  
There are non-conformities to standards such as HTML browser zoom. 

The list is documented in the document ‘Known issues version HOPEX V2R1 CPX'. 

5.1.7. Is IE 9.0 still supported?  
With HOPEX V2R1, Internet Explorer 9.0 is not supported. 

5.1.8. Is Internet Explorer 10 still supported?  
From HOPEX V2R1, Internet Explorer 10.x is supported as web client but not recommended (end 

of mainstream support). See https://support.microsoft.com/en-en/lifecycle 

5.1.9. Is Internet Explorer 11 still supported?  
From HOPEX V2R1 update 01, Internet Explorer 11.x is supported as web client but not 

recommended (end of mainstream support). See https://support.microsoft.com/en-en/lifecycle 

 

http://www.mozilla.org/en-US/firefox/organizations/faq/
https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
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5.1.10. Is Windows Server 2008 R2 still supported?  
With HOPEX V2R1, Windows Server 2008 R2 SP2 is supported as application server and file 

server but not recommended as support end date has passed 

See https://support.microsoft.com/en-en/lifecycle 

5.1.11. Is Oracle Database Server 11 still supported?  
With HOPEX V2R1, Oracle Database Server 11 is supported as database server but not 

recommended as support end date has passed. 

5.1.12. Are SQL Server 2008/2008 R2/SQL Server 2012 still supported?  
With HOPEX V2R1, SQL Server 2008/2008 R2/SQL Server 2012 are supported as database 

server but not recommended as support end date has passed. 
See https://support.microsoft.com/en-en/lifecycle. 

5.1.13. Are there requirements or recommendations regarding 

security policies (GPOs)?  
It is assumed that standard policies (installed by default with the system) are available. In 
particular, the policy 'Impersonate a client after authentication' can be necessary for the HOPEX 

service account and IIS related users, based on your deployment. If certain policies are not 
available, a specific study is required. 

5.1.14. How to configure HTTPS?  
This can be done through the installation program. See the article 'Web Front-End Installation Guide MEGA 

HOPEX V2R1'.  Note that a certificate should be configured before installing HOPEX: see your IIS 

administrator. 

5.1.15. It is possible to use a Must licence that is not located on the 

SSP Application Server?  
This is possible. An additional configuration is required. 

5.1.16. Can the HOPEX web Front-End run on a web server other than 

IIS?  
HOPEX V2R1 is designed for IIS only. 

5.1.17. Can HOPEX solutions and products run on a mobile platform?  
Most HOPEX products and solutions are designed for a web client running on a desktop or laptop computer 

with screen resolution 1280x800. They have not been designed for pads or smart phones. 

 

Viewer users can use tablets running Android or iOs. Viewer users can consult data usually though a 

simplified desktop. 

 

Note that technologies used by the HOPEX platform enabled to develop web application that can run on 

mobile platforms. Tuning of web desktops is required. 

  

https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
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5.1.18. What are the web technologies used by HOPEX Platform?  
For HOPEX Web Front-end, the HOPEX platform uses HTML5 and various JavaScript related technologies 

mainly: 

• Ajax. 

• Extjs (6.5.x). 

• Dojo. 

 

On the server side, nothing is required except the .NET Framework. All necessary execution layers are 

installed by default. HOPEX V2R1 uses an embedded JRE (version 8). 

 

A more detailed list can be sent upon request. 

5.1.19. What about other database servers?  
MEGA has decided to focus on widespread and recent versions of Oracle and SQL Server. 

5.1.20. What is the HOPEX2 folder?  

This is a clone of the HOPEX (IIS) web application. It is used in specific scenario when users 

need to work simultaneously in two different contexts (RFC…). 

5.1.21. Are there supervision tools?  
The HOPEX installation generates supervision logfiles. The standard utility HOPEX Server Supervisor 

provides a supervision interface. It is also possible to setup a WMI probe to communicate with supervision 

tools (Nagios…). For this, a specific integration is required. 
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1. SUMMARY 

This document describes the system requirements and deployment types for the installation of the 

Windows Front-End. 

 

This document only applies to HOPEX V2R1 Update 3. 

 

It does not describe: 

• How to perform installations (see installation documentation). 

• How to manage installations (see administrator manuals). 

• How products are licensed (see license installation documentation). 

• How to use features (see user manuals). 

 

The figures provided in this document are recommendations that may not apply to all contexts. 

In committing phases, a specific study with MEGA product management support is compulsory. 
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2.  TYPICAL DEPLOYMENTS 

The Windows Front-End can be deployed in different typical deployment: 

• Standard deployment 

• Citrix/TSE deployment 

 

It is of course also possible to install Windows Front-End on a standalone machine (Stand-alone 

deployment). 

 

Deployment type Recommended for Comment 

Standard deployment Small or medium 

deployment with good 

network performances 

(LAN, VPN) 

No TSE/Citrix license required. 

2-tiers architecture: 

• Windows clients (presentation and business 

logic). 

There are as many clients as end user 

workstations. 

• Database server (data). 

A shared configuration folder is used. 

Citrix/TSE deployment Large deployment, reduced 

bandwidth 

3-tiers architecture: 

• Client (presentation). 

• Application server (business logic). 

• Database server (data). 

A shared configuration folder is used. 

A server farm enables scalability, load 

balancing, centralized administration and 

deployment 

 

Bandwidth / user * 2 - 50 concurrent 

users 

More than 50 concurrent 

users ** 

> 5 Mbit/s Standard deployment 

Citrix/TSE deployment 

Citrix/TSE deployment 

< 2 Mbit/s Citrix/TSE deployment 

 

Other deployment models – For specific requirements, other deployment models are possible. For 

further information, contact your sales representative. 

 

* Bandwidth considered is the bandwidth available between Windows client and database server (RDBMS 

storage) or file server (GBMS storage). 

** Above 50 concurrent users, we recommend a specific study to confirm that the deployment type and 

the administration procedures are appropriate for project activity and the technical architecture used. 
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2.1. Standard Deployment 
There is one MIK (running instance of HOPEX Kernel) per workstation running Windows Front-End. 

 

 
 

In this example, it is assumed that the repository storage is RDBMS (Oracle, SQL Server). SQL Server Native 

client is required only with SQL Server storage. 

 

 



 
Windows Front-End Architecture Overview HOPEX V2R1 EN 

 

C0 - PUBLIC page 6/30 

 

2.2. Citrix/TSE Deployment 
There is one MIK per TSE/Citrix session running Windows Front-end. 

 

 
 

In this example, it is assumed that the repository storage is RDBMS (Oracle, SQL Server) and there is only 

one Citrix/TSE server. To facilitate readability, the SQL Server Native client required for SQL Server storage 

is not displayed on the Application Server. 
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3. DEPLOYMENT REQUIREMENTS 

3.1. Windows Client  

Client System Windows 10.0 (64-bit) 

Visual C++ Redistributable for Visual Studio 2015 (1) 

Additional Software PDF reader: 

Adobe reader 10.0 or higher recommended 

RTF/DOC/DOCX reader 

XLS/XLSX reader 

SQL Server Native client 11.0 (SQL Server 2012, SQL Server 2014, 

SQL Server 2016) 

If data is stored in SQL Server 

Hardware Processor 

multi-core 

RAM 

4 GB minimum 

6 GB or higher recommended 

2 GB for data cache in memory 

Resolution and colors 

16 M colors 

Screen resolution 

800 x 600 minimum 

1024 x 768 or better recommended 

Disk space 

4 GB for HOPEX Kernel 

50 MB recommended for logs 

 

(1) Required for each Window machine running HOPEX kernel (workstation or server). 
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3.2. File Server 

Server System Windows Server 2012 SP2 

Windows Server 2012 R2 

Windows Server 2016 

For other file systems a specific study is necessary 

Hardware Processor 

See hardware requirements of the system. 

RAM 

See hardware requirements of the system, 1 GB recommended. 

Disk space 

5 GB recommended per HOPEX Environment (environment folder). 

Select superior quality components for disks and disk controller 

cards. 

 

3.3. Citrix Client/Remote Desktop Client 

Client System Citrix Client 

The list varies with the version of the Citrix server 

Examples: Windows 32/64-bit client, Linux client, UNIX client, Mac 

client 

Citrix Web Client 

The list varies with the version of the Citrix server 

Examples: Edge, Mozilla Firefox, Safari 

Remote Desktop Connection Client 

The list varies with the version of the TSE server 

Examples: Windows 32/64-bit client, Mac client 

Remote Desktop Web Connection Client 

Edge 

Hardware No specific requirement for HOPEX. 
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3.4. Application Server (Citrix Server/Terminal Server) 

Server System See also requirements for Citrix Presentation Server or Citrix 

XenApp 

Application Server Layer TSE on Windows Server 2012  

TSE on Windows Server 2012 R2 

Citrix XenApp 7.x For 2012 R2 

Citrix XenApp 7.x For 2016 

Visual C++ Redistributable for Visual Studio 2015 (1) 

Additional Software PDF reader 

Adobe Reader 10.0 or higher recommended 

SQL Server Native client 11.0 (SQL Server 2012) 

If data is stored in SQL Server 

Hardware Processor 

1 cores minimum per group of 15 users 

3-4 cores recommended per group of 15 users 

RAM 

6 GB minimum 

1 GB minimum for the Terminal Server system and for the Citrix 

system 

2 GB for data cache in memory 

Per concurrent modeller user 

600 MB intensive use 

300 MB low use 

Resolution 

65000 colors minimum. 

Disk space 

4 GB for HOPEX Kernel  

500 MB recommended for logs 

 

(1) Required for each Window machine running HOPEX kernel (workstation or server). 

(2) When running HOPEX Windows Front-End, IE is used in embedded mode. It is installed with the system. 
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3.5. Database server 

Server System see RDBMS requirements 

RDBMS Oracle Database Server 12C (Release 1, Release 2) 

SQL Server 2014 

SQL Server 2016 

Disk space Data:  

2 GB minimum per system database 

2 GB minimum per data repository 

Refer to the separate article 'RDBMS Repository Installation guide 

HOPEX V2R1'. 

Hardware  RAM: a specific study is required. 

Refer to the separate article 'RDBMS Repository Installation guide 

HOPEX V2R1'. 

CPU: see hardware requirements of the RDBMS. 
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4. COMMUNICATION 

4.1. Between MIK and File Server (file access, license access) 
 

Protocol SMB/CIFS 

SMB 2.0 is not supported (1) 

Port UDP/TCP 138 

UDP/TCP 137 

UDP/TCP 139 

UDP/TCP 445 

Network bandwidth Standard deployment 

10 Mbit/s minimum full duplex 

Citrix/Terminal server deployment 

1 Gbit/s or higher recommended 

Network latency 1-5 Ms maximum* 

 

(1) For GBMS storage. 

4.2. Between Citrix client and Citrix Server 
 

Protocol Independent Computing Architecture Protocol (ICA Protocol) 

Port Example: UPD/TCP 1604 (2) 

Network bandwidth 100 Kbit/s or higher full duplex 

Network latency 100 Ms maximum* 

 

(2) Default port, check the appropriate port with the Citrix administrator. 

4.3. Between Citrix web client and Citrix Server 
 

Protocol HTTP 

Port UPD/TCP 80 (HTTP) 

Network bandwidth 100 Kbit/s or higher full duplex 

Network latency 100 Ms maximum* 

4.4. Between Remote Desktop Client and Remote Desktop Services 
 

Protocol Remote Desktop Protocol (RDP) 

Port UDP/TCP 3389 (MS WBT Server) 

Network bandwidth 100 Kbit/s or higher full duplex 

Network latency 100 Ms maximum* 
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4.5. Between Remote Desktop Web Client and Remote Desktop 

Services 
 

Protocol HTTP 

Port UPD/TCP 80 (HTTP) 

Network bandwidth 100 Kbit/s or higher full duplex 

Network latency 100 Ms maximum* 

 

* For a ping of 5 KB (It is recommended to use the hrping utility. Refer to the separate article 'RDBMS 

Repository Installation guide HOPEX V2R1'). 

 

4.6. Between MIK and Database server (Oracle, SQL Server) 
 

Protocol Oracle: Oracle Native Protocol 

SQL Server: SQL Server Protocol 

Port Oracle: Example TCP 1521 (2) 

 SQL Server: Example UDP/TCP 1433 (2) 

Network bandwidth 1 Gbit/s minimum full duplex 

Network latency 1-5 Ms maximum* 

 

(2) Default port, check the appropriate port with the database administrator. 

 

4.7. Between MIK and mail server 
 

Protocol SMTP 

Port 25 by default, configurable 

 

 

4.8. Between MIK and Document server (file access) 
 

Protocol SMB/CIFS 

Port UDP/TCP 138 

UDP/TCP 137 

UDP/TCP 139 

UDP/TCP 445 

  



 
Windows Front-End Architecture Overview HOPEX V2R1 EN 

 

C0 - PUBLIC page 13/30 

 

4.9. Between MIK and LDAP Server 
 

Protocol LDAP 

Port TCP 389 by default (2) 

 

(2) Default port, check the appropriate port with the LDAP server administrator. 
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5. INSIDE 

5.1. Administration tools 
Several administration tools can be used: 

 

Administration tool Component Tasks 

Windows Administration 

Console  

Win32 

(Administration.exe) 

Data storage management (environment, 

repositories, stored procedures) 

Functional administration (user, permissions, 

workspaces, LDAP configuration, 

import/export...) 

Must license manager Win32 (Licensing.exe) Management of Must license 

Windows Front-End  Win32 (HOPEX.exe) Fix unexpected configuration issue 

XenApp AppCenter Console See Citrix documentation Management of Citrix session 

Monitoring of HOPEX processes 

HOPEX Server Supervisor  Win32 (Hopex Server 

Supervisor.exe) 

System supervision of the server 

 

Reference: 

• See online documentation, HOPEX Administration : Administrator Guide 

5.2. Anti-virus Configuration 
To maintain good performances, it is recommended to exclude certain file extension from antivirus 

scanning (on access scanning) 

 

Machine Location/File Comment 

Each machine running 

HOPEX 

%programdata%\MEGA and subfolder 

Ex: C:\ProgramData\MEGA 

File extension: *.MGC 

Folders of the Compiled data 

cache and RDBMS local cache 

Each machine running 

HOPEX 

Location: check with the HOPEX 

administrator 

Ex: C:\Program Files (x86)\MEGA\MEGA 

HOPEX V2R1 

File extension: *.* 

Folders of HOPEX core 

programs 
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5.3. Authentication 

Windows Front-End uses standard authentication. 

Authentication model Description Comment 

Basic authentication Authentication process is managed 

within HOPEX Platform. Users are 

declared explicitly in the HOPEX 

Environment and possibly mapped 

individually with an external 

directory. 3 variants: MEGA, LDAP, 

Windows 

This model is recommended 
for basic deployments. 

No integration is required, only 

configuration. 

 

Password values storage, encryption and update vary with the configuration chosen. 

 

Authentication models Storage  Encryption 

Basic authentication (MEGA) System repository Encrypted, hashed 

Basic authentication (Windows) Active Directory According to directory 

specifications 

 

Basic authentication (LDAP) LDAP directory 

 

Reference: 

• See online documentation, HOPEX Administration : Administrator Guide : Managing Users : 

Authentication in HOPEX 

 

5.4. Cluster, scalability and load balancing 

For large deployments, scalability and load balancing is required. 

Service Principle 

Scalability This service is provided by Citrix/TSE server deployment. 

A configuration file is used to share configuration between nodes. 

Load balancing This service is provided by Citrix/TSE server deployment. 

A shared configuration file is used to share configuration between nodes. 

 

5.5. Data access 
Access to data is mainly controlled using profiles (repository access, data permissions, and GUI 

permissions). 

 

Other features are available: 

• Writing access management: control of updates on existing objects. 

• Reading access management: control of visibility regarding existing objects. 

• Data access rules: computed control of visibility or update regarding existing objects. 

 

Reference: 

See online documentation. 

• HOPEX Administration : Administrator Guide : Managing Data Reading Access 

• HOPEX Administration : Administrator Guide : Managing Data Writing Access 
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5.6. Data storage 
Each HOPEX Environment consists in one system database and in one/several data repositories. 

By default data is stored in a database server (SQL Server, Oracle). This is called RDBMS storage. GBMS 

storage format (MEGA proprietary) is available for compatibility. 

 

Storage Mapping Comment 

SQL Server A data repository is an SQL 

Server database 

A system database is an 

SQL Server database (1) 

Create one SQL server user for the environment with 

specific privileges 

Only SQL server authentication is supported 

Install and schedule stored procedures per data 

repository or system database. 

No dedicated instance is required 

SQL Server native client (SQL Server 2012). 

A specific license token (Repository Storage (SQL 

Server)) is required for each end user. 

Default port can be used. 

Oracle A data repository is a 

user/schema 

A system database is a 

user/schema 

Create one Oracle user per data repository or system 

database with specific privileges. 

Install and schedule stored procedures per data 

repository or system database. 

No dedicated instance is required. 

A specific license token (Repository Storage (ORACLE)) 

is required for each end user. 

No client-side installation (Oracle instant client) 

Default port can be used. 

Create one tablespace for each environment 

(recommendation). 

GBMS A data repository is a set of 

files.  

A system database is a set 

of files. 

A specific license token (Lan) is required for each end 

user. 

No client-side installation. 

File-based.  

Protocol SMB 2.0 is not supported and must be 

disabled. 

GBMS storage is not supported for data repository or 

system database with size higher than 4 GB.  

 

(1) This the standard recommendation. It is also possible to store a data repository in a schema of a SQL 

Database. 

 

Note that RDBMS storage can be mandatory for certain products and the bundles including such products. 

It is also a requirement for Web Front-end. 

 

Reference: 

• Article 'RDBMS Repository Installation guide HOPEX V2R1' 

See online documentation, Products. 
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5.7. Document management 
A document management system is available through a solution or a pack. RDBMS storage is required. 

 

Object Location  Storage 

Business Document Data repository Database server 

System Business Document System database Database server 

 

If document management is enabled, web users can add, update and consult documents. 

 

Reference: 

• See online documentation, Common Features : Managing Documentation : Using Business 

Documents 

5.8. Error and trace logfiles 
Different files can be created on the Windows client side (2): 

 

File Comment Default location (example) 

megaerrYYYYMMDD.txt Error log of MIK 

(1) 

%programdata%\MEGA\Logs 

Ex: C:\ProgramData\MEGA\Logs 

MEGASETTINGS.INI 

 

User settings %userprofile%\AppData\Roaming\MEGA\HOPEX V2R1 
Ex: C:\Users\my user\AppData\Roaming\MEGA\HOPEX V2R1 

MEGAWKS.INI Workstation 

settings 

%programdata%\MEGA\HOPEX V2R1\Cfg 

Ex: C:\ProgramData\MEGA\HOPEX V2R1\Cfg 

sspsprvsYYYYMMDD.txt Supervision log  %programdata%\MEGA\HOPEX 

V2R1\ClusterRoot\Supervision 

Ex: C:\ProgramData\MEGA\HOPEX 

V2R1\ClusterRoot\Supervision 

redis_server_log.txt 

 

Redis component 

log 

%programdata%\MEGA\HOPEX V2R1\Logs  

Ex: C:\ProgramData\MEGA\HOPEX V2R1\Logs 

 

(1) location can be configured 

(2) For Citrix/TSE deployment, the Citrix/TSE server is considered as the Windows client. 

(3) Where XX is the login name. Ex: MegaSettings-U1.ini for login U1 

 

When using Windows Front-End, each end user must have 'modify' access to : 

• The files and folders described above. 

• A temporary folder (%tmp%, ex: C:\Users\myuser\AppData\Local\Temp). 

 

For Citrix/TSE deployment, if a cluster of server is used, a configuration is available so that errors logs of 

MIK are saved in a central location and not on each server of the cluster. 
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5.9. Licensing 
Products and solutions of HOPEX platform are protected by Must licenses. Must licenses can be shared 

between multiple users. 

 

Must licensing is not server-based (there is no Windows process for a license server). At runtime with 

HOPEX Web Front-end, a set of files are generated dynamically by service account.  

 

However, a domain user (Active directory) is required for: 

• Each service account running the HOPEX (IIS) application. 

• Each user running the Administration Console (system administrator, functional administrator). 

• Each user running the Windows Front-end (developer, functional administrator, user associated to a 

scheduled task). 

 

To obtain a license, contact your sales representative. A UNC will be requested and a .must license file 

(locked on this UNC) will be sent with installation instructions. 

 

Reference: 

• Article 'Must License Installation Guide HOPEX V2R1'. 

5.10. Mail system 
A mail server needs to be configured so that mail notifications can be used within workflows. 

SMTP parameters (server, port, proxy...) can be configured for the installation using the 

Administration console. 

 

5.11. Multi-language 
Windows Front-End enables to work with multiple languages. 

 

Nature List Installation Comment 

GUI Language Core languages (1) Core languages are installed 

by default. With additional 

languages, it can be 

requested to install a 

language pack on the 

Application Server. 

Controls the display of the user 

interface (menus, pages…) 

Different end users can have 

different GUI languages. 

Data language More than 30 

languages available 

Core languages are installed 

by default. Additional 

languages are installed at 

environment level 

Enables data entry in several 

languages for objects. 

A end user can switch between 

several data languages within 

his session 

 

(1) Core languages are English, French, Italian, Spanish and German. 

 
To ensure a correct display under Windows with specific languages, it can be requested to set 

the system parameter 'Languages for non-Unicode programs’ for each Windows machine: 
• Standard deployment: each windows client. 

• Citrix/TSE deployment: each Citrix/TSE server. 
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5.12. Physical backup 
 

In case you face a real disaster recovery scenario, presence of a valid and restorable backup is very 

important. 

 

Element Recommendations 

Frequency Every 24 hours (1) (2) 

Retention In the last 30 days keep daily backup 

In the last 12 months keep a monthly backup 

Other files to backup By default folder of each HOPEX Environment 

 

(1) For HOPEX Environment used by an active project 

(2) In particular before major update concerning data. E.g.: system database customization, data 

reprocessing, CP/RP upgrade of HOPEX data 

 

5.13. Specific recommendations 
 

Storage  Mode 

SQL Server Cold/warm backup recommended (3) 

Oracle Cold/warm recommended (3) 

GBMS Cold/warm recommended (3)(4) 

 

(3) No HOPEX end-user should be connected while backup is performed 

(4) We have found that with some file systems, differential/incremental backup did not save HOPEX 

repository files correctly. We cannot guarantee hot backup mode either. 

 

5.14. Redo logs and activity tracking 
 

Service Activation Comment 

Embedded log 

(repository log) 

Enabled by default Enables to generate a log of updates (redo log), activity 

tracking. Also used by specific features (full search, alter 

management…) 

This log can be partially/completely initialized and disabled 

using Windows Administration Console. 

External log 

(backup logfile) 

Enabled by default Enables to generate additional command files logging the 

updates of a user (backup log) that can be useful to 

recover quickly data after an incident. 

This log can be disabled using Windows Administration 

Console. 

 

Reference: 

See online documentation 

• HOPEX Administration … Managing Repositories. 

• HOPEX Administration … Managing logfiles.  

• HOPEX Administration … Optimizing Repository Access Performance. 
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5.15. Regular administration tasks 
A few tasks need to be run and can be automated (a specific integration is required): 

 

Task Machine involved Comment 

Conservation of repository 

performance 

Database server Stored procedure to be installed and scheduled for 

each data repository and system database. Can be 

automated. SQL server only. 

Deletion of historical data Database server Stored procedure to be installed and scheduled for 

each data repository and system database. Can be 

automated. 

Pointless with GBMS 

Deletion of transaction 

temporary data 

Database server Stored procedure to be installed and scheduled for 

each data repository and system database. Can be 

automated. 

Pointless with GBMS 

Environment compilation Application server To build system cache. System updates are 

impossible during compilation. Need to stop HOPEX 

related processes 

Information about 

fragmentation and statistics 

Database server Generates a technical report regarding physical 

indexing (statistics gathering) 

Maintenance plan (SQL Server 

storage 

Database server Required with several tasks. Can be automated. 

Refer to the article 'RDBMS Repository Installation 

Guide HOPEX V1R2 EN 

 

Physical backup of data 

(GBMS) 

File server  Required. Daily backup recommended. Can be 

automated. 

Physical backup of data 

(RDBMS) 

Database server Required. Daily backup recommended. Can be 

automated. 

Repository reorganization 

(GBMS) 

Application server 

Database server 

Required with GBMS. Can be automated. 

Pointless with RDBMS 

Restart server Citrix/TSE Application 

server 

Can be required in case of problem 

 

5.16. Reporting 
There are two main categories of reports: 

 

Category Native 

format 

conversion 

format 

Comment 

Report HTML RTF, XLS, 

XLSX, PDF 

Generated from a Report template 

According to the Report template considered, certain 

conversion format may not be available. 

Report (MS Word) RTF - Generated from a Report template (MS Word). 

 

To open a report from the windowd client, a reader corresponding to the format should be installed. 

Example: MS Excel to read .XLS documents, Adobe reader to read .PDF documents, Open Office/MS Word 

to read .RTF documents. 

 

To design Report templates (MS Word), Windows Front-End and MS Word are required. The Office 

2010/2013/2016 versions 32 bit versions should be used (64 bit versions are not supported). 

 

https://eu1.salesforce.com/50120000000mrAi?srPos=1&srKp=501
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Execution mode Compatible Web 

Front-End 

Comment 

.RTF mode Yes Set by default 

Look and feel can be slightly different as style application is 

not enforced. RTF macros are not supported. MS Word (such 

as table of content) are not refreshed 

.DOC mode No Can be configured by default 

 

Reference: 

See online documentation 

• HOPEX Power Studio … Report Studio 

• HOPEX Power Studio … Customizing Reports (MS Word) 

5.17. Security 
All ports used in the HOPEX platform are either configurable or set elsewhere. No specific port is required 

or hard-coded. To configure firewall ports, see the 'Communications' section earlier in this document. 

 

If a local enterprise proxy is used, it should be configured by adding an excluding rule on the proxy. The rule 

refers to the IP address of the HOPEX web server involved. 

 

File permissions should enable access to: 

• Error and trace logfiles (see section 'Error and trace logfiles' in this document). 

• License folder. 

• Environment folder. 

 

Reference: 

Article 'Web Front-End - Securing the platform'. 

5.18. Services and running processes 
One Windows service is installed on the machine: 
 

Service Executable Startup type User  Server 

HopexRedisBackEnd redis-server.exe Automatic Local system Each server used to 

deploy Web Front-

end 
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Several processes can run on the machine: 
 

Process User Comment 

mgwmapp Current user One per end-user session (per running instance of HOPEX.exe) 

mgwmapp Current user One per running instance of Windows Administration Console 

(Administration.exe) 

redis-server Local system One per machine. 

 

If SSP is installed (custom setup), a service is installed and additional process will run. 

 

5.19. Supervision 
The HOPEX platform enables system monitoring. 
Supervision logfiles are updated by the server running the SSP when various events occur. 

This information can be consulted via HOPEX Server Supervisor (Windows utility). 
A WMI probe can also enable to supervise HOPEX from standard tools supporting WMI (a specific 

integration is required). 

 

Reference: 

See online documentation, HOPEX Administration … Managing Events 
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5.20. System caches 
Several caches are created on the Windows client. For Citrix/TSE deployment, the Citrix/TSE server is 

considered as the Windows client. 

 

Cache type Location Average 

disk space  

Comment 

RDBMS local 

cache 

Default location: 

%programdata%\MEGA\<version 

code>\Cache\RDBMS data 

Ex: C:\ProgramData\MEGA\HOPEX 

V2R1\Cache\RDBMS data 

1-20 GB (1) One folder per HOPEX 

environment. Cache of data 

saved in database server. 

Can be disabled. Updated 

dynamically at runtime. 

Compiled 

data cache 

Default location: 

%programdata%\MEGA\<version 

code>\Cache\Compiled data 

Ex: C:\ProgramData\MEGA\HOPEX 

V2R1\Cache\Compiled data 

10-30 MB 

(1) 

One folder per HOPEX 

environment. Cache of 

systemdb configuration. 

Cannot be disabled. Updated 

by environment compilation. 

Cache of 

MetaPicture 

Default location: 

%programdata%\MEGA\<version 

code>\Cache\Compiled data 

Ex: C:\ProgramData\MEGA\HOPEX 

V2R1\Cache\Compiled data 

1-5 MB Cache of images. Cannot be 

disabled. Updated 

dynamically at runtime. 

 

(1) For one HOPEX environment 

 

5.21. Technical documentation 
 

Category Audience Format Language code 

Installation and 

deployment guides 

System administrator, functional 

administrator 

PDF EN 

Online documentation End user, functional administrator web site EN, FR, IT*, DE* 

Technical articles Developer, functional administrator PDF EN 

Javadoc Developer HTML pages EN 

 

Installation and deployment guides and user manuals are installed in the subfolder \Documentation of 

HOPEX programs folder 

Example: C:\Program Files (x86)\MEGA\HOPEX V2R1\Documentation 

 

Language codes: 

 

EN : English IT: Italian 

FR: French DE: German 

 

* can be available a few months after the initial release 
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6. FAQS 

 

6.1.1. Is Windows 7.0 SP1 (64-bit) still supported? 

With HOPEX V2R1, Windows 7.0 is supported but not recommended (end of mainstream 

support). See https://support.microsoft.com/en-en/lifecycle 

6.1.2. Is Windows 8.0 (64-bit) still supported?  

With HOPEX V2R1 update 01, Windows 8.0 is supported but not recommended (end of 
mainstream support). See https://support.microsoft.com/en-en/lifecycle 

6.1.3. Is Windows 8.1 (64-bit) still supported?  

With HOPEX V2R1 update 01, Windows 8.1 is supported but not recommended (end of 

mainstream support). See https://support.microsoft.com/en-en/lifecycle 

6.1.4. Is Windows Server 2008 (64-bit) still supported?  

Windows Server 2008 is no longer supported as support end date has passed. See 
https://support.microsoft.com/en-en/lifecycle 

6.1.5. Is Windows Server 2008 R2 still supported?  
With HOPEX V2R1, Windows Server 2008 R2 is supported as file server and application server 

but not recommended (end of mainstream support). See https://support.microsoft.com/en-en/lifecycle 

6.1.6. Is Internet Explorer 10 still supported?  
From HOPEX V2R1, Internet Explorer 10.x is supported as web client but not recommended (end 

of mainstream support). See https://support.microsoft.com/en-en/lifecycle 

6.1.7. Is Internet Explorer 11 still supported?  
From HOPEX V2R1 update 01, Internet Explorer 11.x is supported as web client but not 
recommended (end of mainstream support). See https://support.microsoft.com/en-en/lifecycle 

6.1.8. Is Citrix XenApp 6.x (6.0, 6.5) still supported?  
With HOPEX V2R1, Citrix XenApp 6.x is supported as application server but not recommended as support 

end date has passed. 

 

6.1.9. Is Oracle Database Server 11 still supported?  
With HOPEX V2R1, Oracle Database Server 11 is supported as database server and file server 

but not recommended as support end date has passed. 

6.1.10. Is SQL Server 2008/2008 R2 still supported?  
With HOPEX V2R1, SQL Server 2008/2008 R2 is supported as database server and file server 
but not recommended as support end date has passed. 

https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
https://support.microsoft.com/en-en/lifecycle
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6.1.11. Is remote execution still possible?  
Yes. It is still technically possible to install Windows Front-End on a file server and run it remotely. However, 

this deployment is not supported nor recommended. Note that: 

• Registration on each client machine can be required. 

• This type of execution requires an excellent network (bandwidth). 

6.1.12. Is .NET Framework required to install Windows Front-end?  
No additional version of .NET Framework is required that the one installed with the system. 

However NET Framework 4.6.1 or higher is required for HOPEX Web Front-End, SSP and to run certain 

utilities. 

6.1.13. Why is SMB 2.0 not supported for GBMS storage?  
GBMS storage is deprecated and not supported with Web Front-End. MEGA has decided to focus 
on RDBMS storage. HOPEX V2R1 supports only SMB 1.0. It will be required to disable SMB 2.0 

for file server access. See the article 'Windows Front-End Installation Guide HOPEX V2R1'. 

6.1.14. Can HOPEX Windows front-end run on Microsoft App-V?  
This version is not qualified. MEGA recommends to user Citrix XenApp or VmWare. 

6.1.15. Is GBMS storage recommended?  
GBMS storage is deprecated and not supported with Web Front-End. MEGA has decided to focus on 

RDBMS storage. GBMS is kept for compatibility and is supported with certain products. Note that certain 

features are NOT available with GBMS storage. 

GBMS storage is not supported if the size of a repository in GBMS storage format exceeds 4 GB. In such 

situations, it is required to switch to RDBMS storage (Oracle, SQL Server). 

 

7. GLOSSARY 

Term Definition 

.NET, NET Framework Software framework developed by Microsoft that runs primarily on 

Microsoft Windows. It includes a large library and provides language 

interoperability (each language can use code written in other languages) 

across several programming languages 

Active Directory Directory system for Microsoft environments. It provides centralized 

services to identify and authenticate to a network of MS Windows 

machines. 

Administration Console, 

Windows Administration 

Console 

Administration console of the HOPEX platform that performs core 

administration tasks including: 

• Managing HOPEX environments. 

• Managing HOPEX repositories. 

• Managing HOPEX users. 

• Managing HOPEX profiles. 

Win32 component (Administration.exe) 

Application server Server playing the application server role.  

Authentication Authentication defines whether the user exists and if it can connect to the 

software (for example a web site). 

Availability A measure of a computer system's ability to maintain services despite 

hardware or software failures. A highly available system delivers services to 

clients a high percentage of the time. 
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Term Definition 

Bandwidth Rate of data transfer. Usually measured in KBit/s or GBit/s.  

Cluster A group of independent computer systems, referred to as nodes, working 

together as a unified computing resource 

Concurrent license License where products or bundles are programmed in concurrent mode. 

Example: 5 concurrent accesses users for 10 possible users  

Database Server A database server is a machine providing database services to other 

machines. In this document the database server is a machine running 

relational database management systems. A database server can host one 

or several instances. 

Example: 

• Server 'iba.company.com' 

• Server '192.888.777.666' 

• Server 'SQL02' 

DBA (DB Administrator) Person that ensures an operational and effective functioning of a database 

server. 

Dedicated license License assigned to a particular user. It cannot be shared. 

Directory, Directory services Software application for organizing information about a computer 

network's users and resources. 

DMS (Document 

Management System), 

Document Management 

System used to track and store electronic documents 

Document Repository Group of documents within a document server. 

Documentation Server Server hosting a Document Management System. 

Domain User User in Active Directory (Microsoft product). 

End-user Person that uses a product. 

Environment folder, HOPEX 

Environment folder  

Folder of a HOPEX Environment. It has several subfolders such as 'Db' and 

'SysDb'. It contains configuration and output files. With GBMS storage, it 

also contains core data files of HOPEX repositories. 

Environment, HOPEX 

Environment 

A HOPEX Environment is a working area, storing data of a user group. 

Within a HOPEX Environment, a set of data repositories share within a 

system repository a metamodel definition, users and profiles. An 

environment is thus made of a single system repository and of one or 

multiple data repositories. 

 

Workspace for a group of HOPEX users. A HOPEX Environment references a 

system repository and one or several data repositories. It has its own 

metamodel. It corresponds to a folder on the disk. 

Failover Technique of switching to a redundant or standby server, system, 

hardware component or network upon the failure or abnormal termination 

of the previously active application, server, system, hardware component, 

or network 

File Server Server used to share files. Hardware must include superior quality 

components for disk and disk controller card. Configuration must favor file 

access performances in read and write mode. 

Functional Administrator, 

HOPEX Administrator 

Person responsible for operational functioning of a HOPEX installation 

(manage users, workareas, logs...) 

High availability High availability refers to a system or component that is continuously 

operational for a desirably long length of time. Availability can be 

measured relative to "100% operational" or "never failing." 

http://msdn.microsoft.com/en-us/library/aa371764(v=VS.85).aspx
http://en.wikipedia.org/wiki/Electronic_document
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Term Definition 

HOPEX (IIS) HOPEX .NET application. It communicates with HOPEX Kernel to access to a 

repository and provides the services of HOPEX Web Front-End. 

HOPEX Component A component is a piece of the HOPEX platform delivering a defined service. 

It may be (or not) activated or used by products or solutions. A component 

cannot be isolated from the overall platform. Ex: Authentication engine, 

Permission engine, Versatile Desktop engine, Workflow engine… 

HOPEX Directory System repository seen as a directory services (for user definition) 

HOPEX Disk CD/DVD containing the installation program of HOPEX software. The 

content of this disk can be copied to a network folder and installed from 

the network. 

HOPEX Kernel Core of the HOPEX Platform. Back-end set of programs used seamlessly by 

end users through all Front-Ends. It is a generic component instantiated in 

every MIK. 

HOPEX Programs folder, 

HOPEX Programs folder, 

HOPEX Kernel folder 

Folder of a HOPEX Kernel installation on a machine. It can be identified by 

the two subfolders 'Cfg' and 'System'. 

HOPEX Web Front-end  Access to HOPEX platform through a web client. HOPEX Web Front-End 

may be used to access solutions (ex: Internal Audit) or products (ex: MEGA 

IT Architecture) in a HTML Browser. 

HOPEX, HOPEX Platform HOPEX is an acronym for Holistic OPerational Excellence. It is the technical 

platform underlying HOPEX Solutions and Products. Its components 

provide graphical user interface, data management, roles and profiles 

management, reporting, collaborative functions, and functional tools. It 

evolves though versions, for example: HOPEX V1R1, HOPEX V1R2, HOPEX 

V1R3, HOPEX V2… 

Impersonate user See service account 

Latency Measure of time delay experienced for a network component, usually 

measured in milliseconds (ms). 

LDAP Server Server supporting the LDAP protocol and providing directory services. With 

HOPEX platform, it is used to authenticate web user. 

License, HOPEX license License used to run HOPEX Software (Product, Module). There are different 

technologies available. The most common one is the HOPEX Must license. 

Load Amount of work being done by a node. In Network Load Balancing, load is 

measured as a raw number of connections. 

Load Balancing Technique for scaling performance by distributing requests across multiple 

nodes. 

Mail Server Server hosting a mail system. With HOPEX platform, SMTP server is used to 

send mails. 

Megasite.ini HOPEX Kernel configuration file. It is created at installation. 

Megawks.ini Windows Front-End configuration file used to set machine related settings. 

The file is not created at installation. 

MIK (MEGA Instantiated 

Kernel) 

Running instance of a HOPEX Kernel. Multiple running instances of HOPEX 

Kernel allow a large number of users to be connected simultaneously. Each 

Windows Front-End runs its own MIK. For HOPEX Web Front End, a MIK 

may manage a single user or several users, depending on the product or 

solution used. 

Monitoring Console, 

HOPEX Monitoring Console 

 

Web page that enables monitoring tasks: 

• Managing web user connections. 

• Managing caches. 

Used for HOPEX Web Front-end 

http://msdn.microsoft.com/en-us/library/aa371764(v=VS.85).aspx
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Term Definition 

Must license Type of HOPEX license. It is file based and relies on Active Directory. Each 

Must license is locked on a UNC. 

Must license folder Folder containing one or several .Must license files. This folder can be 

referenced by one or several HOPEX installation(s).  

Must license utility HOPEX utility (licensing.exe) used to monitor and configure Must license. 

Oracle Instant Client Oracle Instant client is an Oracle technology. It is a client side for an Oracle 

database server. It avoids deploying an oracle client on client workstations. 

For HOPEX Windows Front-End, it is installed with HOPEX Programs: no 

installation is required on the Windows client. 

Person Group, Group Group account used with Web Front-end. A person group determines 

various permissions (profile, reading access, writing access…). The list of 

users (Person (System)) that belong to the group can be defined explicitly 

or dynamically. When a user logs in on behalf of a person group, it gets the 

associated permissions. 

Product, HOPEX Product A product is a functional unit identified and saleable. As opposed to a 

solution, a product is not role-oriented, and does not provide collaborative 

functions. Users of products have to define their own usage mode of tools 

provided in products. 

Product portfolio covers mainly all the Enterprise Architecture offering 

existing in versions prior to HOPEX. 

Examples of products: HOPEX Business Data, HOPEX Database Builder, 

HOPEX IT Architecture… 

Profile assignment Mapping between a user (Person (System)) and a profile or between a 

person group and a profile. This enables login to Windows Front-End or 

Web Front-end. 

Profile, HOPEX Profile Consistent definition of GUI and permissions for a business role. It makes 

it easier to manage HOPEX user (options, permissions, license, web 

desktop…) 

Each HOPEX Solution provides different profiles. HOPEX products use a 

generic profile (Enterprise Architect). 

Program features Installation component selected during the installation of software (setup). 

Examples for HOPEX setup: 

• HOPEX (IIS) 

• MEGA Software  

o Administration Program  

o Utilities  

o Documentation… 

RDBMS Server Relational Database server. With HOPEX platform, core data is saved in 

database instance of SQL Server or Oracle. 

Remote Desktop (client, 

services, protocol) 

Remote Desktop is a Microsoft technology that allows a use to access 

applications and data on a remote computer over a network. It is based on 

Remote Desktop Protocol (RDP). 

The client side is called Remote Desktop Client (formerly called Terminal 

Services Client). 

The server side is called Remote Desktop Services (formerly called Terminal 

Services). 

Repository, HOPEX Repository, 

data repository 

A HOPEX Repository is a database hosting HOPEX data compliant with a 

metamodel definition. It contains objects with attributes, and associations 

between objects. Storage format (GBMS, Oracle, and SQL Server) is defined 

when creating the repository. 
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Term Definition 

A HOPEX Repository belongs to a HOPEX Environment.  

Role, Business Role A businesss role is the function of a person in the business meaning 

Ex: Audit director, Auditor, Application portfolio manager…With HOPEX 

platform, it is implemented by a profile. 

Scalability Scalability is the ability of a system to continue to function well when it is 

changed in size or volume. 

Server farm Collection of server machines usually maintained by an enterprise to 

accomplish server needs far beyond the capabilities of one machine. 

Synonym: server cluster 

Service account Active directory user dedicated to execution of a given application. 

Sometimes called 'Impersonate user' A service account should be used for 

HOPEX Web Front end (ex: hopex01@mydomain.com)  

Shared configuration 

(Megasite.ini) 

Configuration file shared between several installations. The group of 

installations is called a cluster. 

Shared license License where products or bundles are programmed in shared mode. 

Example: 5 concurrent accesses users for 10 possible users  

SMB (Server Message Block 

Protocol) 

Protocol used by a client machine to request file and print services to a MS 

Windows file server. Previously called CIFS protocol. 

SMTP Server Mail server supporting the SMTP protocol 

Solution A HOPEX solution tools up different business roles to execute a function 

across an enterprise through collaborative tasks. 

A solution is a self-sufficient offer. 

Example: Internal Audit, ITPM, ERM, Internal Control… 

SQL Server Native Client SQL Server Native Client is a Microsoft technology. It is a client side for an 

SQL Server database server. It should be installed in the Windows client 

using a Microsoft setup program. 

Storage Format, HOPEX 

Storage Format 

Typology of storage formats for a data repository or a system repository: 

• Oracle (RDBMS, Oracle). 

• SQL Server (RDBMS, SQL Server). 

• GBMS (MEGA DBMS, proprietary format kept for compatibility). 

System Administrator Person that ensures an operational and effective functioning of a computer 

system or network 

System database, system 

repository, systemdb 

A system database contains data shared between all data repositories 

within an environment. It contains at least: 

• A HOPEX directory (definition of users/roles/profiles). 

• A set of templates of deliverables. 

• A metamodel definition. 

UNC (Universal Naming 

Convention) 

A UNC address is a shared folder that has a unique address on the network 

User, HOPEX User User account in a HOPEX Environment. The user can be declared in HOPEX 

or declared in a directory service and replicated in HOPEX. In all cases, 

users are saved in the system repository. Technically, it is the association of 

a Person (System) with a Login. 

Windows Front-End Windows Front-End is a Microsoft Windows based program accessing the 

HOPEX platform. Windows Front-End is compatible with Citrix/Terminal 

Server environments. 

Currently designed for Microsoft Windows 32/64 platforms. 

Windows user A user configured in the active directory. This is completely independent of 

HOPEX. This configuration is required to enter the company network. 
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Term Definition 

Example: User U0001 is configured for domain D01 

WMI (Windows Monitoring 

Instrumentation) 

Interface proposed by Microsoft Servers. It enables providers to pull 

events to supervision utilities and applications (ex: Windows Performance 

Monitor, Nagios…) 

Scheduler  HOPEX component running on SSP environment. It enables to schedule 

execution of various jobs. It is used by various features (full search 

indexing, alert management, LDAP user synchronization…) 

Supervision Set of tools and techniques that enable to monitor computer system. In 

particular, running applications can be monitored through events. 
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Summary 

This technical article describes the procedures and best practices for deploying the HOPEX application 

on a relational database server (Oracle, SQL Server). 

This deployment applies to HOPEX V2R1. 
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Generalities 

Supported Versions of RDBMS 

MEGA has qualified some versions of RDBMS for HOPEX V2R1. Those versions can be found in the 

following documents (depending on your type of deployment): 

• Web Front-End Architecture Overview HOPEX V2R1 EN 

• Windows Front-End Architecture Overview HOPEX V2R1 EN 

Unsupported HOPEX Features in RDBMS Storage 

When a HOPEX repository is stored on an RDBMS, HOPEX does not support the following features: 

• MySQL RDBMS 

• Offline mode 

• Repository protection 

• Mixed environments  

o MEGA proprietary format (GBMS storage format) repository and repositories stored on 

an RDBMS. For example, a GBMS environment (SystemDb) and one or more 

repositories stored on Oracle or SQL Server. The opposite is also not supported (Oracle 

or SQL Server environment with GBMS repositories within). 

o It is allowed to have an environment on Oracle (which SystemDb is Stored on an Oracle 

instance) and repositories on SQL Server. 

o The opposite is also supported (SQL Server SystemDb and with Oracle repositories). 

Expected Advantages 

The advantages expected from an RDBMS deployment are: 

• Compliance with company-wide IT standards. 

• Guarantee of scalability and security. 

• Quicker dispatch time. In particular with “big” HOPEX private workspaces (HOPEX private 

workspaces with many creations/deletions/updates). 
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With this type of architecture, HOPEX supports global deployment on the same repository. In 

particular, it enables bypassing some limits related to the GBMS storage format. 

• Maximum limit of 510 concurrent private workspaces per environment. No limit is identified in 

the HOPEX application for Oracle/SQL Server storage format. 

• Maximum limit of 24 GB of data per HOPEX repository. No limit is identified in the HOPEX 

application for Oracle/SQL Server storage format. 

With the RDBMS storage format, the HOPEX environment contains unshared files. All the data accessed 

during the execution of the HOPEX application is stored in the RDBMS. The RDBMS guarantees 

scalability and security. 

Licensing 

The “HOPEX repository storage (Oracle)” or “HOPEX repository storage (SQL Server)” product is 

required on the license to gain access to the RDBMS storage feature. The license can be dedicated to 

the workstation or shared by a group of users. All users connecting to HOPEX must have access to 

this license as well as to other products (HOPEX IT Architecture…). 
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Infrastructure Requirements 

RDBMS Client 

An RDBMS Client is necessary on each workstation that uses HOPEX with data stored on an 

RDBMS. 

• Oracle 

No additional installation is required. Oracle instant client is embedded in the HOPEX programs. 

(http://www.oracle.com/technetwork/database/features/instant-client/index-100365.html) 

• SQL Server 

Installation of Microsoft SQL Server 2012 Native Client is required. This client is compatible with the 

2008, 2012, 2014, and 2016 versions of SQL Server. See corresponding Microsoft articles for more 

details:  

http://msdn.microsoft.com/en-en/library/cc280356.aspx 

The SQL Server 2012 Native Client installation program is available in a subfolder of the HOPEX 

installation, for: 

• 64bits Windows operating systems: 

Under < HOPEX installation>\Install\RDBMS client\Sqlserver\x64\sqlncli.msi 

• 32bits Windows operating systems: 

Under <HOPEX installation>\Install\RDBMS client\Sqlserver\x86\sqlncli.msi 

http://www.oracle.com/technetwork/database/features/instant-client/index-100365.html
http://msdn.microsoft.com/en-en/library/cc280356.aspx
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Network Capability to Database Server 

On a client computer running HOPEX, it is recommended to ping the RDBMS server with a filled buffer 

to have an evaluation of the infrastructure. To do this, download the hrPING freeware tool available 

at https://www.cfos.de/en/ping/ping.htm. To use this tool, you must first accept the terms of the 

licence. Use it with the following command in a command window from a computer that will be running 

HOPEX: 

hrping.exe -W -l 5000 -n 50 -y <RDBMS Server name or IP> 

Example for this command output: 

 

If the value returned for “RTTs of replies in ms/avg” (0.535 in the example) is higher than 1 ms, 

contact MEGA. See hrPING help for details on this command. 

File Server and RDBMS local cache 

See Deployment guide for generality. 

For RDBMS deployments, there is a specific data caching option that is enabled by default. The 

purpose of this option is to improve the application response time by saving the environment data to 

the disk so that fewer roundtrips to the database server are necessary (Oracle or SQL Server). This 

cache is filled as the data is accessed during the use of HOPEX. The data cached that is out of date is 

deleted from that cache during dispatches. 

The “Activate RDBMS local cache” is both accessible at the site level, or at the environment level.  

 

https://www.cfos.de/en/ping/ping.htm
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To modify the RDBMS local cache globally for all environments: 

 Start Administration.exe. 

 At the top of the tree, right-click HOPEX and select Option > Modify. 

 Expand the Installation folder. 

 Select Advanced. 

 In the right pane, for the Scope of HOPEX-RDBMS local cache option, use the drop-down list to 

modify the range of that cache: 

o “SystemDb only” (default value). 

o “Disabled”: if you do not want to use it, for example if your RDBMS instance is located 

on the same server as your application. 

o  “All repositories”: if for example you have a network latency with your RDBMS server. 

 

By default the cache is located under the ProgramData folder: 

C:\ProgramData\MEGA\HOPEX V2R1\Cache\RDBMS data\<CacheName> 

<CacheName> is the identifier of the environment. It can be found in the 

megasite.ini file.  

For example, given this section in the megasite.ini file: 

[Environment Shortcuts] 

466046A854876473=C:\Users\Public\Documents\HOPEX V2R1\Demonstration_RDBMS 

 the demonstration cache folder name will be: 

C:\ProgramData\MEGA\HOPEX V2R1\Cache\RDBMS data\466046A854876473 

 

The size of the cache varies depending on the amount of data contained in an environment. At least 

500MB must be available on the disk. It can grow up to several GB for big environments/repositories. 

To send this cache to a different location, modify the Path of HOPEX cache option and make sure 

that it is a local folder. 

Architecture Model 

All the architecture models described in the “Windows Front-End Architecture Overview HOPEX V2R1” 

document can use the RDBMS storage. 
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Database Server 

The following sections will help your database administrator (DBA) size the Database server according 

to the profiles and the number of HOPEX users you plan to use. 

Server disk size 

Each new object takes up 30 KB on a disk (object with its attributes and links). 

If you activate the HOPEX Repository Log file each action on the HOPEX repository creates an object. 

It is recommended that for Oracle you initialize each new schema in a TABLESPACE that has a 

minimum of 5 GB available. For SQL Server, the same 5GB size should be reserved on the server disk. 

Reminder:  

HOPEX will stop working if the TABLESPACE is full. To avoid this, the TABLESPACE could be created 

with the MAXSIZE UNLIMITED option. If this is not possible, the TABLESPACE growth must be 

monitored carefully in order to provide more space if fullness is about to be reached. 

Number of connections opened by HOPEX on the RDBMS for each HOPEX 
workstation 

This information will help you define the amount of memory (RAM) required for the database instance 

used to run HOPEX on the database server 

• Oracle 

One connection is used for each RDBMS storage. It means that, when a HOPEX User is connected to 

HOPEX, two connections to Oracle are open (one for the SystemDb and one for the User repository).  

An additional connection is used for each RDBMS storage when DDL instructions are issued to the 

RDBMS (for example when there is a first creation of an object type, in other words, when the first 

occurrence of a MetaClass or MetaAssociation is created). 

An additional connection is used for each RDBMS storage when you use the HOPEX locks. 

Each connection opened uses 1 MB of memory on the Oracle server 

 

• SQL Server 

One connection is used for each RDBMS storage. It means that, when a HOPEX User is connected to 

HOPEX, two connections to SQL Server are open (one for the SystemDb and one for the User 

repository). 

An additional connection is used for each RDBMS storage when you use the HOPEX locks. 

Each opened connection uses 24 KB of memory on the SQL Server. 
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HOPEX RDBMS Diagnostic Utility 

Purpose 

HOPEX provides a Java based utility that should be used before starting to use environments and 

repositories on an RDBMS. This utility runs several tests for which the results will be compared to 

some memorized values corresponding to a situation where HOPEX is likely to have close-to-optimum 

performances. 

The RDBMS Diagnostic utility is stored at this path: 

< HOPEX Installation Path>\Utilities\RDBMS Diagnostic\ 

Running the RDBMS Diagnostic Utility 

A batch file was created to run the tool. 

To run the RDBMS Diagnostic Utility: 

 Extract the content of the “PerfTestExe.zip” compressed file in the same location: 
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 You need to set the JAVA_HOME, so that you can run the batch that will launch the proper JAR 

file. One way of doing it, is to open the “Environment variables” of the server: 

 

 In the System variables pane, click Edit. 

 

 Create the variable “JAVA_HOME” with the value targeting the “<Hopex installation>\java\jre” 

folder.  

For example: ‘‘C:\Program Files (x86)\MEGA\hopex v2r1\java\jre‘‘ 
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 Click OK 

 

The key is created. 

 Click OK to close the Environment Variables window. 

 Go back to your file explorer, into the PerfTestExe folder, and execute the “PerfTestExe.bat”: 
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 Select the RDBMS type (SQL Server or Oracle): 

 

 Enter the connection information to the RDBMS storage that is the target for hosting the HOPEX 

data: 

o a database name for SQL Server 

 

o a schema (Oracle User) name for an Oracle target 
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 In order to have consistent times, the Expected  Execution Time values were recorded after 

running the utility more than once and noticing that the values were stable.  

So to have results that can be considered valid, run the utility twice and consider the values of the 

2nd run. 

 

Here is an example of some test results. The test was run on SQL Server: 
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Oracle support 

Oracle Database Requirements 

Encoding 

The HOPEX application requires UTF8 encoding. 

Select 'Use UNICODE (AL32UTF8). (parameter NLS_CHARACTERSET= AL32UTF8) 

User privileges 

The Oracle user requires the following privileges for the database instance: 

GRANT CREATE SESSION TO <MEGAUSR>; 

GRANT CREATE TABLE TO <MEGAUSR>; 

GRANT CREATE PROCEDURE TO <MEGAUSR>; 

GRANT SELECT on V_$PARAMETER to <MEGAUSR>; 

Note: here is the only query that is run against the V_$PARAMETER system view 

SELECT VALUE FROM V$PARAMETER WHERE UPPER(NAME) = ‘OPEN_CURSORS’ 

Purpose: calculate the number of distinct queries that can be put in the Oracle statement cache. To 

learn more about this mechanism, see Oracle documentation. 

http://docs.oracle.com/cd/B28359_01/appdev.111/b28395/oci09adv.htm
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Defining a HOPEX Oracle Connection 

An “SQL Connection” menu is available in the HOPEX Administration program at different levels (site, 

environment, and repository) if the license contains “Repository Storage (Oracle)" products. 

To define a HOPEX Oracle connection: 

 Start HOPEX Administration.exe. 

 Right-click HOPEX (the root of the administration tree) and select SQL Connection > Oracle. 

  

 Set the connection parameters: 

• Instance: <Database Host Id >/<Oracle Service Name>  

Database Host ID can be an IP address or the name of a machine network. If the listener 

service is configured on a port other than the default port, you must suffix the "Database 

Host ID" with the port number: 

- My Server 

- 174.12.5.3 

- My Server:1523 

- 174.12.5.3:1523 

Oracle Service Name is db_unique_name. 

Example for a standalone installation with Oracle Express with a listener on the 1524 port: 

My Machine:1524/XE 

A complete connection description can be used: 

(DESCRIPTION = (ADDRESS = (PROTOCOL = TCP)(HOST = <DB server Id>)(PORT = <listener port 

number>)) (CONNECT_DATA = (SERVER = DEDICATED) (SERVICE_NAME = <Oracle service 

name>))) 

The connection description can be used for defining a connection to an Oracle Cluster (RAC). 

• User:   user enabled to access/update Oracle 

• Password:  password of the user enabled to access/update Oracle 

• Parameters:  additional parameters of the connection string. 

It is possible to use a specific Tablespace (different from the Oracle user’s default one): 

tablespace=TablespaceName 

 Click Connection Test to check connection parameters. 
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Note that clicking Grants Test  has no use at this point. 

  

 

Important note: 
 

If the test returns the “ORA-12705: Cannot access NLS data files or invalid 

environment specified parameters” error message, this could be due to a 

previous installation of Oracle. 

In this case, in the registry editor: 

-  delete the “HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG, or 

-  rename it to NLS_LANG.OLD” key. 
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Creating an Environment 

The environment creation mainly consists in creating a SystemDb repository where MetaModel 

definitions are stored. 

Prerequisite: 

• Identify the SQL connection parameters (RDBMS instance, user and password). 

• Identify the location of the environment folder on the file server. 

• Verify that the Oracle database was created with the appropriate encoding 

(NLS_CHARACTERSET= AL32UTF8). 

To create an environment: 

 Start HOPEX Administration.exe. 

 Right-click the Environments folder and select New. 

  
 

 Enter the environment Name. 

 (If needed) Change the Location. 

 Select “Oracle” Repository Storage Support. 

 

You can use the parameters specified at the root level for Oracle as they will be shown as default 

or overload them. In any case, when creating an environment, some more specific tests are carried 

out regarding the capabilities of the Oracle user to see if they match the prerequisite. 
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 Click Test connection to check that the Oracle server is reachable. 

This step must be successful for the process to continue. 

 Click Test GRANTs to test different actions (table creations, indexing columns etc.) that are 

necessary for HOPEX to be able to work. 

This test must be successful for the process to continue. 

 Click OK to start the environment creation. 

Result: 

• A SystemDb repository stored in the selected RDBMS instance is created. 

• A folder (HOPEX environment folder) is created on the file server. 

This folder contains several files and subfolders (Db, Mega_Usr, SysDb).  
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Creating a Repository 

Prerequisite: 

• You can create the repository in the same Oracle User’s Schema as that of the SystemDb, 

however, it is strongly recommended you isolate each HOPEX repository in a separate 

Oracle User’s Schema especially for keeping the database administration simpler. 

• Verify that the Oracle database was created with the appropriate encoding 

(NLS_CHARACTERSET= AL32UTF8). 

To create a repository: 

 Start HOPEX Administration.exe. 

 Connect to the environment concerned. 

 Right-click the Repositories folder and select New. 

  

 Enter the repository Name. 

 Select a Location. 

 Select the “Oracle” Repository Storage Support. 

 Click OK. 

  

 Change the Oracle User’s Schema and password as recommended above or use the default 

parameters. 

 Click “Test connection”. The test must be successful for the process to continue. 

 Click “Test GRANTs”. The test must be successful for the process to continue. 

 Click OK to start the repository creation. 
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Results: 

• HOPEX repository tables are created in the Oracle User's Schema. 

• A folder is created in the specified location. 
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HOPEX Private Workspaces Cleanup 

This procedure is used to delete the data of the terminated private workspaces of HOPEX Users. It is 

necessary to clean up these data often in order to reduce database growth and preserve good 

performances. MEGA recommends running this procedure every week if you have less than 10 users 

and every night if you have more than 10 users. 

Installing the procedure 

Warning: You must repeat this procedure for each HOPEX Repository and the SystemDb. 

 Right-click your HOPEX Database and select Deletion of private workspace 

temporary data. 

  

This launches SP_CLEAN_MEGA_DATABASE and if the procedure: 

o does not exist, the application creates it. 

o already exists, it is overwritten by this action. 
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HOPEX Historical Data Cleanup 

This procedure is used to delete the historical data of the HOPEX database. Each time a HOPEX object 

is updated, the previous data is kept in a database. This method ensures a high level of data security 

even when connection to SGBD is interrupted. It is necessary to often clean up these data in order to 

reduce database growth and preserve good performances. This clean-up will have no impact on the 

repository logfile. MEGA recommends running this procedure every week if you have less than 10 

users and every night if you have more than 10 users. 

Before cleaning Historical Data 

Historical data are used in the Repository Snapshot mechanism. See HOPEX Common Features > 

Other Features > Using Repository Snapshots > Repository Snapshot Prerequisites section for 

more details. 

If you need to have Repository Snaphots taken, be aware that it will not be possible anymore for the 

period of time covered by the cleanings. In other words, if you need Repository Snapshots, be sure to 

take them before the procedure runs. 

 

In this first illustrated case, all archived states were deleted, so all the space that these archived states 

were using is reclaimed physically (an actual delete in the tables was issued for every one of them). 
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In this second example, all archived states were also deleted except those corresponding to the state 

of the repository when the two Snapshots were taken. 

In this case, the data corresponding to the repository state for the Snapshot(s) is saved and it is 

thanks to this saving that special features will be available within this repository regarding this data. 
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Installing the procedure 

Warning: You must repeat this procedure for each HOPEX Repository and the SystemDb. 

 Right-click your HOPEX Database and select Deletion of historical data from repository. 

This launches SP_CONSOLIDATE_MEGA_DATABASE and if the procedure does not exist, the 

application creates it. If the procedure already exists, it is overwritten by this action. 
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Batching Cleanup procedures for Oracle 

It is very important to run both of the procedures on a regular basis. So If you do not want to have 

to remember to click the corresponding menus in the Administration.exe program every time that 

each of the procedure should be run, you can batch it using Oracle Scheduler. 

To batch cleanup procedures for Oracle: 

 In Oracle enterprise Manager, select Server tab. 

 In Oracle Scheduler section, click Jobs. 

 

 Select Create.  

 Enter a job name. 

 In the Command section click Change Command Type to change for Stored Procedure. 

 Look for the Stored Procedure in the corresponding Schema: 

 

a. Enter the three arguments values for the job: 

• 1 : Schema name (ex: ‘MEGAUSER’) 

• 2 : HOPEX environment name (ex : ‘Demonstration’) 
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• 3 : HOPEX repository name (ex : ‘Adventure’) 

 

b. Schedule its execution for running every night 

 

 Repeat the same actions for the other procedure. 

 Schedule the two Stored Procedures for each repository and do not forget the SystemDb. 

Maintenance tasks 

By default, when the installation of the Oracle is done, an automatic job is set to update the statistics 

of all schemas : 

exec DBMS_STATS.GATHER_DATABASE_STATS 

If that job was disabled or modified, and set to refresh a set list of schemas, make sure that it includes 

the Mega HOPEX schemas. 
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SQL Server support 

SQL Server Requirements 

Encoding 

After the database has been created, verify that “Collation” is set to 

“SQL_Latin1_General_CP1_CS_AS”. If the database is created from the HOPEX application, the 

appropriate encoding is automatically configured. 

User management 

When the HOPEX application accesses the HOPEX data stored in the RDBMS, it uses an SQL connection 

string. This connection string refers to a user account that has certain privileges for the instance. 

This user can either be a native account, or a Windows account : 

• Native account:  

o Pros: Unique account, configured for everyone that runs the thin or thick clients. 

o Cons: Thought to be less secure. 

• Windows accounts: 

o Pros: Don’t set up any connection string in the tool. 

o Cons: Need to authorize several Windows accounts to have direct access to the data : 

the impersonate user that runs the processes of the web users, the service account that 

runs the SSP, every user that needs to run the thick client (either the Administration.exe 

or the Hopex.exe tools). 

 

Privileges for native account 

You can have several kinds of SQL server users in relation to the customer security policy: 

• Standard security policy: the user account is enabled to manage databases. This is the 

easiest solution especially if the SQL Server instance is dedicated to HOPEX. 

 
User type Comment Server roles Database roles Server permissions 

User with  

maximum 

privileges 

Allowed to manage any database 

(create database, delete database, 

data read access, data write access, 

update database structure) 

dbcreator 

 

db_owner (1) 

 

View server state (2) 
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• Advanced security policy: only the DBA is allowed to create new databases following specific 

naming rules. A user is required to use the existing databases. 

 
User type Comment Server roles Database roles Server permissions 

User with  limited 

privileges 

Allowed to use an existing database 

(data read access, data write access, 

update database structure) 

public 

 

db_owner (3) 

 

View server state (2) 

(1) db_owner role is automatically assigned by the system when a database is created. 

(2) To consult the view 'sys.dm_exec_sessions' for the server. 

(3) db_owner role is manually assigned by the DBA after database creation. 

The HOPEX application will create table, columns and index objects dynamically. The right to create 

Procedures is mandatory. Trigger, functions and view objects are not used. 

Privileges for Windows accounts 

Since this configuration requires to grant access to the different databases to several Windows 

accounts, and especially to accounts of people running the thick client of the application, it is 

recommended to limit those rights to a minimum, to reduce the risk of harming the application by 

directly modifying or deleting data. 

• Advanced security policy: only the DBA is allowed to create new databases following specific 

naming rules. A user is required to use the existing databases. 

 
User type Comment Server roles Database roles Server permissions 

User with  limited 

privileges 

Allowed to use an existing database 

(data read access, data write access, 

update database structure) 

public 

 

db_ddladmin, 

db_datawriter 

and 

db_datareader (3) 

 

View server state (2) 

(2) To consult the view 'sys.dm_exec_sessions' for the server. 

(3) those roles are manually assigned by the DBA after database creation. 

The HOPEX application will create table, columns and index objects dynamically. The right to create 

Procedures is mandatory. Trigger, functions and view objects are not used. 

The Windows users should not have the “db_creator” server role. 
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Defining a HOPEX SQL Server Connection 

A Configure SQL Connection menu is available in the HOPEX Administration application at 

different levels (site, environment, and repository) if the license contains the Repository Storage (SQL 

Server) product. 

Procedure with a native SQL account 

 Start HOPEX Administration.exe. 

 Right-click HOPEX (the root of the administration tree) and select Configure SQL connection > SQL 

Server. 

  

 Enter the connection parameters. 

o Instance: <machine network name>\<SQL Server instance name> (1) 

Example for a standalone installation with SQL Express: MyMachine\SQLEXPRESS 

o User: user enabled to access/update SQL Server 

o Password: password of the user enabled to access/update SQL Server 

o Repository creation mode: by default you create your environment in the “dbo” 

schema, in the database prefixed with the environment name (here, “Standard”). You 

can choose to target a different database using the same schema “dbo” using the 

dropdown list. 
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 Click Test Connection to check the connection parameters. 

 

Procedure when using Windows authentication 

 Start HOPEX Administration.exe. 

 Right-click HOPEX (the root of the administration tree) and select Configure SQL connection > SQL 

Server. 

 

 Set the connection parameters. 

o Instance: <machine network name>\<SQL Server instance name> (1) 

Example for a standalone installation with SQL Express: MyMachine\SQLEXPRESS 

o User: leave blank 

o Password: leave blank 

o Parameters : set “Trusted_Connection=Yes;” 

o Repository creation mode: same as the native authentication settings. 

 Click Test Connection to check the connection parameters. 
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Creating an Environment 

The environment creation mainly consists in creating a SystemDb repository. For SQL server, two 

creation modes are available from HOPEX: 

• Create a new database on the SQL Server (standard security policy) 

• Use an existing database of the SQL Server (advanced security policy) 

Creating a new SystemDb database 

Prerequisite: 

• Identify the SQL connection parameters (RDBMS instance, user, password) 

• Identify the location of the environment folder on the file server 

Procedure: 

 Start HOPEX Administration.exe. 

 Right-click the Environments folder and select New. 

 Enter the environment Name. 

This creates a folder on the file server. 

 (If needed) Change the Location. 

 Select “SQL server” Repository Storage Support. 

 Click OK. 

 Confirm or change SQL Connection parameters. 

 As the Repository Creation Mode select “Create Database” . 

 Click Test Connection to check that the SQL Server is reachable. This step must be successful for 

the process to continue. 

 Click Test GRANTs to check different actions (table creations, indexing columns etc.) that are 

necessary for HOPEX to be able to work. This step must be also successful for the process to 

continue.  

 Click OK to start the environment creation. 

Result: 

• A SystemDb repository stored in the selected RDBMS instance is created. 

• A folder (HOPEX environment folder) is created at the selected location. 

This folder contains several files and subfolders (Db, Mega_Usr, SysDb). 
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Using an existing SystemDb database 

Prerequisite: 

• Identify the SQL connection parameters (RDBMS instance, user, and password). 

• Identify the location of the environment folder on the file server. 

• Verify that the “Collation” property of the database is set to 

“SQL_Latin1_General_CP1_CS_AS”. 

• Identify the exact name of the user database in the SQL Server. It follows this naming rule: 

<EnvironmentName>_SystemDb 

Example: MyEnvironment_SystemDb 

Note: the environment name must match the environment folder. 

Procedure: 

 Start HOPEX Administration.exe. 

 Right-click the Environments folder and select New. 

 Enter the environment “Name” (in this example : “Name” = “MyEnvironment”) 

This creates a folder. 

 (If needed) Modify the Location. 

 Select “SQL server” Repository Storage Support. 

 Click OK. 

 Confirm or change the SQL Connection parameters. 

 As Repository creation mode select “Uses an existing SQL database (“[dbo]” default schema)”. 

 Click Test connection to check that the SQL Server is reachable.  

This step must be successful for the process to continue. If “Use existing database” option was 

specified, this test tries to connect to the database matching the following pattern: 

“MyEnvironment_SystemDb”. This test must be successful for the process to continue. 

 Click Test GRANTs to check different actions (tables creations, indexing columns etc.) that are 

necessary for HOPEX to be able to work. This test must be also successful for the process to 

continue. 

 Click OK to start the environment creation. 

Result: 

• The SystemDb repository is initialized. 

• A folder (HOPEX environment folder) is created at the selected location. 

This folder contains several files and subfolders (Db, Mega_Usr, SysDb). 
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Creating a Repository 

For SQL Server, two creation modes are available from HOPEX: 

• Create a new database on the SQL Server (standard security policy). 

• Use an existing database of the SQL Server (advanced security policy). 

Creating a new SQL Server database 

Prerequisites: 

• Identify the SQL connection parameters (RDBMS instance, user, and password). 

Procedure: 

 Start HOPEX Administration.exe. 

 Connect to the environment concerned. 

 Right-click the Repositories folder and select New. 

 Enter the repository Name. 

 Keep the default Location. 

 Select “SQL server” Repository Storage Support. 

 Click OK. 

 Confirm or change the SQL Connection parameters. 

 As Repository creation mode select “Creates the SQL database ("[dbo]" default schema)". 

 Click Test connection. The test must be successful for the process to continue. 

 Click Test GRANTs. The test must be successful for the process to continue. 

 Click OK to create the new database 

Result: 

• A repository is created in SQL server. It follows this naming rule: 

<EnvironmentName>_<RepositoryName> 

Example: MyEnvironment_SQLServerRepository 

• A folder is created in the specified location. 

This folder contains an EMV and an EMQ file. 
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Using an existing SQL Server database 

Prerequisites: 

• Identify the SQL connection parameters (RDBMS instance, user, and password). 

• Verify that the property 'Collation' of the database is set to 

'SQL_Latin1_General_CP1_CS_AS' 

• Identify the exact name of the user database in the SQL Server. It follows this naming rule: 

<EnvironmentName>_<RepositoryName> 

Example: MyEnvironment_SQLServerRepository 

Note that the environment name must match the actual environment folder. 

Procedure: 

 Start HOPEX Administration.exe. 

 Connect to the environment concerned. 

 Right-click the Repositories folder and select New. 

 Enter the environment Name. 

E.g.: SQLServerRepository 

 Select SQL server Repository Storage Support.  

 Click OK. 

 Confirm or change the SQL Connection parameters. 

 As Repository Creation Mode select “Uses an existing SQL database (“[dbo]” default schema)”. 

 Click Test to check that the login can be performed and that the database exists. 

 Click Test connection. The test must be successful for the process to continue. 

 Click Test GRANTs.  The test must be successful for the process to continue. 

 Click OK. 

Result: 

• A repository is referenced in the SQL server and initialized. 

Example: MyEnvironment_SQLServerRepository 

• A folder is created in the specified location. 

<this folder contains a .EMV and a .EMQ file. 
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HOPEX Private Workspaces Cleanup 

This procedure is used to delete the data of terminated private workspaces of HOPEX Users. It is 

necessary to clean up these data often in order to reduce database growth and preserve good 

performances. We recommend running this procedure every week if you have less than 10 users and 

every night if you have more than 10 users. 

Installing the procedure 

 

Warning: You must repeat this procedure for each HOPEX Repository and the SystemDb. 

 

 Right-click your HOPEX repository and select RDBMS Administration > Remove private workspace 

temporary data. 

This will launch SP_CLEAN_MEGA_DATABASE and if the procedure: 

o does not exist, the application will create it. 

o already exists, it is overwritten by this action. 
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HOPEX Historical Data Cleanup 

This procedure is used to delete the historical data of the HOPEX repository. Each time a HOPEX object 

is updated, the previous data is kept in database. That method insures a high data security even when 

connection to SGBD is interrupted. It is necessary to clean up these data often in order to reduce 

database growth and preserve good performances. This clean-up will have no impact on the repository 

logfile. We recommend running this procedure every week if you have less than 10 users and every 

night if you have more than 10 users. 

Before cleaning Historical Data 

Historical data are used in the Repository Snapshot mechanism. See HOPEX Common Features > 

Other Features > Using Repository Snapshots: Repository Snapshot Prerequisites section for more 

details. 

If you need to have Repository Snapshots taken, be aware that it will not be possible anymore for the 

period of time covered by the cleanings. In other words, if you need Repository Snapshots, be sure to 

take them before the procedure runs. 

 

In this first illustrated case, all archived states were deleted, so all the space that these archived states 

were using is reclaimed physically (an actual delete in the tables was issued for every one of them). 
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In this second example, all archived states were also deleted except those corresponding to the state 

of the repository when the 2 Snapshots were taken. 

In this case, the data corresponding to the repository state for the Snapshot(s) is saved and it is 

thanks to this saving that special features will be available within this repository regarding this data. 
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Installing the procedure 

Warning : You must repeat this procedure for each HOPEX Repository and the SystemDb. 

 Right-click your HOPEX repository and select RDBMS Administration > Shrink unused repository 

historical data. 

This launches SP_CONSOLIDATE_MEGA_DATABASE and if the procedure does not exist, the 

application creates it. If the procedure already exists, it is overwritten by this action. 
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Batching Cleanup procedures for SQL Server 

It is very important to run the two procedures on a regular basis. So If you do not want to have to 

remember to click on the corresponding menus in the Administration.exe program every time that 

each of the procedure should run, you can batch it using SQL Server agent job. 

 Using SQL Server Management Studio, find the SQL Server database that corresponds to the 

HOPEX repository for which you want to batch the stored procedure. 

Reminder : the database will be named following this rule <EnvironmentName_RepositoryName>.  

 In Programmability > Stored Procedures folder,  right-click this procedure and select Script Stored 

Procedure as > Execute to > Agent job. 
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Enter a name for the job and the schedule. 

 

The job is created. 

 Right-click this job and select Properties. 

 Select the Schedules tab and click Edit. 
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 Set up the schedule to execute the job every night. 

 
 

Maintenance tasks 

The SQL Server databases need to be maintained, in order to keep the best possible performances. 

Tasks such as “update of the statistics”, “reorganize or rebuild of the indexes”, “shrink of the 

databases”, as well as backups, need to be run regularly. 

We recommend set up the standard maintenance plans of SQL Server to manage those tasks. The 

backups can be excluded, if they are done through another chanel. 

Also, we can imagine to put the execution of the HOPEX cleanup procedures (see previous chapter) 

as the preliminary step to the SQL Server job that will run the maintenance tasks. 

You can find below some screenshots of a default maintenance plan (with backups), with SQL Server 

2012. It can be adapted to your version, and your rules : 

 Create a maintenance plan using the SQL Server wizard (in SQL Server Management Studio). 

 Give it a name and a schedule (click Change). 
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 Select the following maintenance tasks: 

 

 Order the maintenance tasks as follows: 
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 Check all databases (including the system databases): 

 

 Rebuild indexes for the user databases: 
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 Same thing for the update of the statistics: 
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 Define how long the log files will be kept: 

 

 Shrink all user databases, or at least the HOPEX databases: 
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 Backup all databases, choose the destination folder, and if you want to have subfolders for each 

database: 

 

 Provide the folder where the backups are being stored, the extension, and if you want to include 

subfolders, as well as how long you want to keep the files before deleting them: 
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 Keep the default : 



p. 53/76  
RDBMS Repository Installation Guide - HOPEX V2R1 

C0 - PUBLIC 

 
 

 

 Click Finish to create the maintenance plan, and the SQL Server job: 
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HOPEX RDBMS repositories specific administration 
actions 

Migrating Your Data from One Storage Support to Another  

General procedure: 

 Start HOPEX Administration.exe. 

 Connect to the environment containing the repositories to be migrated. 

 Expand the Repositories folder. 

 Right-click a repository and select Reorganize. 

NB: Launch a complete environment migration starting with the data repositories and finishing 

with the SystemDb repository. 
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To reorganize a repository: 

  

 Select the expected Target storage support. 

 

 Click Apply to start the reorganization. If the Target storage support is: 

• GBMS: 

A basic Reorganization of the file based repository takes place. 

• Oracle: 

You are required to confirm or change the SQL Connection parameters. 

Note: For Oracle storage it is strongly recommended to isolate each HOPEX repository in 

a separate Oracle Schema. 

 

The “Test connection” step must be successful for the process to continue. 

The “Grants Test” step must be successful for the process to continue. 

Note: To be successful, there should be no storage on the Oracle Server that concerning 

a HOPEX Database with the same name in a same HOPEX environment. 

 

• SQL Server: 

You are required to confirm or change the SQL Connection parameters. 
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The “Test connection” step must be successful for the process to continue. 

The “Test GRANTs” step must be successful for the process to continue. 

Note: To be successful, there should be no storage on the Sql Server concerning a HOPEX 

repository with the same name in a same HOPEX environment.  

 

If your Sql Server User does not have the right to create databases, you need to ask your 

DBA to create an Sql Server database following the naming rule: 

<EnvironmentName>_<RepositoryName>. You should then choose the option “Use 

existing Sql Server Database”. 

 

Results: 

• The database is now migrated to the storage you chose. 

• The .emb (GBMS), .emq (SQL Server), .emo (Oracle) file corresponding to the newly created 

repository storage is created. 

• The Megaenv.ini file is updated. 

• The logical backup file, used during the process, is stored in the 'work' folder of the source 

repository. 

• This backup is named according to the following format: Bkp_Date_BaseName.mgr . 



p. 58/76  
RDBMS Repository Installation Guide - HOPEX V2R1 

C0 - PUBLIC 

 
 

Restoring a HOPEX environment from formatted  data 

There are some cases when it is needed to recreate a repository in HOPEX Administration from an 

existing set of data (a previously HOPEX formatted repository). For example, after a physical 

corruption (disk crash) of the machine hosting the HOPEX repository folder tree. 

In such a situation, since the repository folder contains files indicating the way to reach the data and 

on which database server it can be found, the data could be considered lost from the HOPEX point of 

view. 

It is necessary to understand that, from then on, HOPEX needs a new way to access the data inside 

the RDBMS. This is why this action is seen as a Restoration of the data: a re-creation of the repository 

folder structure allowing to re-save the way to access the data. 

This method can also be used for duplicating an environment from a production infrastructure to a 

test infrastructure (or vice versa). For doing so, all the repositories (including the SystemDb) must be 

duplicated first in the RDBMS. The restoration can then be done on the duplicates repositories, starting 

with the SystemDb. 

Restoring an environment (SystemDb repository) 

 Start HOPEX Administration.exe. 

 Right-click the Environments folder and select New. 

  

 In Name, enter the name of the environment that is to be restored (the exact same name as the 

one used for the first creation). 

 Select Restore. 

  

 Click OK. 
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 Specify the connection parameters for accessing the RDBMS where the HOPEX -yet-unreachable 

data is located. 

  

 Click Test Connection. 

The test must be successful for the process to continue. 

 Click Test GRANTs. 

The test must be successful for the process to continue. 

 Click OK. 

The SystemDb repository is restored.  

 

Once these actions are performed successfully, there are a few more actions to perform to be able to 

restore the repositories that were referenced into the newly restored environment.  

At this point, if you open the environment that was just restored, you will see the following warning 

message: “The <repository name> is not referenced”). 
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The reason is that the environment that was just restored has “a knowledge” of the repositories that 

should be referenced in it but the references for those repositories do not yet exist in the folder tree 

structure of the newly restored environment. 

To be able to re-reference the required repositories by restoration in this environment, you must first 

purge that “knowledge”: 

 Right-click the Environment and select Remove not referenced repositories: 

 

 

 

Important notes 

 

• DO NOT use Remove not referenced repositories if the environment is in use somewhere else 

as it will delete the references to the repositories there too ! 

• Use it only on an environment that is a physical copy on the RDBMS storage side. 

• Be carefull that the repositories also must be restored from a physical RDBMS copy (see next 

chapter for repositories restoration). 

 

• Not taking care of this will lead to situations where users might think that they are using 

different sets of data when they are actually using and modifying the same repositories ! 

Restoring a data repository 

Note: A repository can only be restored within an environment that has the same name as 

the one in which the repository was originally created. An environment with the same name 

can be recreated before restoring the repository in it or the actual environment can be 

restored beforehand. 

To restore a data repository: 

 Start HOPEX Administration.exe. 

 Connect to the environment in which you want to restore the repository 

 Right-click the Repositories folder and select New. 
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 In Name, enter the name of the repository that is to be restored (the exact same name as the one 

used for the first creation). 

 Select Restore. 

  

 Click OK. 

 Specify the connection parameters for accessing the RDBMS where the HOPEX -yet-unreachable 

data is located. 

 

NB: For SQL Server, the “Creation Mode” parameter is disable (the choice is not possible) when 

the “Restore” checkbox is checked. This is because in this situation, HOPEX is actually told to re-

attach to physical data so no database creation or repository initialization will be carried out. 
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 Click Test Connection. 

The test must be successful for the process to continue. 

 Click Test GRANTs. 

The test must be successful for the process to continue. 

 Click OK. 

The repository is restored. 
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Handling of HOPEX RDBMS repositories specific internal format 

There is an internal format used by HOPEX when accessing a repository that is stored on Oracle or 

SQL Server.  

To view this internal format version: 

 Start HOPEX Administration.exe. 

 Right-click the HOPEX repository (either SystemDb or data repository) and select Properties. 

  

 

When upgrading your HOPEX installation (applying a Cumulative Patch or migrating your data from a 

HOPEX SP version to the next one), there might be some modifications leading to a new internal 

format version. 

From Mega 2009 SP5, new menus are available to manually activate this internal format upgrade. 

Note: Before Mega 2009 SP5, the upgrade was made “on the fly” when first accessing the Mega 

repository with a Mega program corresponding to a more recent internal format version. 

When you need to upgrade the internal format version, you are prompted to do it with the following 

window: 
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Note: The technical conversion of the repositories of the environment must be done before upgrading 

to the environment:  

 Apply the technical conversion on the SystemDb: 

Right-click the environement and select Technical conversions. 

  

 Apply the technical conversion on the other data repositories of the environment: 

For each repository, right-click the repository and select RDBMS Adminsitration > Technical 

conversions. 
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ORACLE Case: From Test Environment to Production 

Note: Even though the following was written for MEGA 2009 SP5, the same method can be 

used with HOPEX V2, taking into account that Oracle 10g is no longer supported. 

This section includes a detailed scenario on how to switch from a Mega 2009 environment that has 

been migrated from an Oracle testing environment (OTE) to an Oracle Production environment (OPE). 

For the purposes of this guide, the different components are of the following versions: 

• Mega:  2009 SP5 

• Oracle: 10g R2 (10.2.0.4) 

 

This document applies for more recent Oracle version as well. 

The Chosen Method: Using the Data Pump Tool 

Several methods exist in HOPEX for switching from an OTE to an OPE but only one will be detailed 

here. 

This method is based on Oracle export and import tools. As you might know, there has been an export-

import couple that has been used for quite some time with Oracle: these are called EXP and IMP. From 

Oracle 10g, a new set of tools is available (EXPDP and IMPDP) called Oracle Data Pump. The Data 

Pump technology will be used for the switching. The reasons for this are: 

• It offers more flexibility (remapping of SCHEMAS and/or TABLESPACES). 

• It is quicker. 

• There are no compatibility problem that can be encountered with certain data types. 

• The “old” tools have been deprecated by Oracle and will probably disappear in a near future. 

   Note that data exported with EXP cannot be imported with IMPDP and vice versa. 

   The tools must be used symmetrically. 

  

http://download.oracle.com/docs/cd/B19306_01/server.102/b14215/dp_overview.htm
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These tools can be found under the Oracle Home, as shown below for a “typical” windows installation 

of Oracle: 

 

How about HOPEX Then? 

Let us see how we can switch from an OTE to an OPE from the Mega point of view. 

We will focus only on the phase: moving from OTE to OPE, assuming that the first step, which is the 

transfer of pre-existing HOPEX data from a Mega proprietary database format (GBMS) to a HOPEX 

database on Oracle, has been carried out normally (see relevant documentation on how to carry out 

this action). 

In this example, we will show the manipulations on a simple HOPEX environment that contains only a 

HOPEX “SystemDb” repository and a single HOPEX repository (only the HOPEX repository “Mega 

(Tutorial)” has been kept in the “Demonstration” environment). 

 

Note that the data of the “SystemDb” repository and of the “Mega (Tutorial)” repository have been 

isolated from each other (as recommended by Mega) in different SCHEMAS. 
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The Actual Export – Re-Import Phase 

In our case, we have decided that the SCHEMAS hosting HOPEX data in both the OTE and the OPE are 

named identically. At this stage, you should keep in mind that this will lead to an Oracle error(*) when 

importing, since the dump produced by the export bears the creation of the SCHEMAS that it contains. 

(*)It is totally normal, thus you will see the process of the import going on. 

The Export 

To perform the export: 

 

The export starts: 
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Parameter description: 

expdp Invokes the export utility. 

Oracle user The user who does the export (here “system”) followed by ‘/’ and his password and 

“@<OracleDatabaseInstanceName>”. 

DIRECTORY Specifies an Oracle Directory object. It is an Oracle object that is mapped to a path to 

a physical folder where the dump will be created. 

Here, “DATA_PUMP_DIR” is used because it does not need to be created as it is 

pre-existing within Oracle 10g. You can create another one if needed (refer to 

Oracle Documentation: see link at the beginning of this document). 

DUMPFILE The name of the dump that will be created in the DIRECTORY object. 

LOGFILE This is the name of the file where the output of the command window will be 

redirected. 

SCHEMAS The name of the Oracle SCHEMAS that are to be exported into the dump. 

The Import 

Prerequisite:  

Copy the dump created during the import and paste it into the Oracle DIRECTORY object that will be 

specified for the import. 

Note: in this example, both Oracle Databases are on the same machine, but it is highly possible that it will 

not be the case in a client situation. 
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It is also implied that on the OPE, the target SCHEMAs have been created on pre-existing 

TABLESPACE(S). 

The import command: 

 

Note: the name of the LOGFILE is different to enable keeping both the export and import logs (this 

notes only applies if the dump is read from where it was created since the LOGFILE is created next to 

the dump). 

 

Launching this command will cause a few errors: 

1. 

ORA-31684: Object type USER:"ORASCHEMA" already exists 

ORA-31684: Object type USER:"ORASCHEMASYS" already exists 

This has been discussed earlier in this document and can be ignored. 

2. 

ORA-39083: Object type TABLESPACE_QUOTA failed to create with error: 

ORA-00959: tablespace 'TESTTBL' does not exist 

This is another error that needs to be explained. 

• When importing the dump, Oracle “wants” to create the SCHEMAS in the same tablespace from 

which they were exported. 

• Simply put, this tablespace was there in the OTE (obviously), but it is probably missing in the 

OPE. 

In this case, in the OTE the tablespace is TESTTBL and in the OPE, the tablespace is PRODTBL. 

Solution: 

The REMAP_TABLESPACE parameter! 
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The correct import command is therefore: 

 

  Note that the equivalent (REMAP_SCHEMA) can be used if the hosting SCHEMAS are named 

differently in the OTE and the OPE. 

Finalization: Switching in HOPEX from Test to Production 

Ensure that the HOPEX repositories point toward the OPE: 

 In HOPEX Administration, change the SQL connection parameters so that they indicate the way to 

the database instance host machine and the correct equivalent SCHEMA to the one used in the 

OTE. 

 

 

 

 Repeat this for all the repositories and their respective SCHEMAS. 
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  Note: from the HOPEX installation point of view, nothing has changed except for the content of 

the HOPEX repositories files. It is as if the repository were the same: same name, same repository 

idAbs, same content (this is the aim after all). 
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What if… 

The HOPEX environment for the production also needs to be moved to another location? 

• In this case, you can copy the entire HOPEX environment folder tree and paste it somewhere 

else since it has no impact on the indirection to the Oracle Database server and its SCHEMAS.  

The SQL connection parameters needed to reach the RDBMS are present in the HOPEX 

repository file ([HOPEX_repository_file_name].emo in the case of a HOPEX repository on 

Oracle). 

 

• Be aware that it can only work if the HOPEX environment folder keeps the same name; only 

the path to the HOPEX environment can change. 

 

• This leads to another remark: you could copy the HOPEX Environment tree before switching 

the SQL connection parameters to the OPE and in that case you can have the 2 environments 

referenced at the same time in the HOPEX Site. Use this method to compare the HOPEX 

environment on the OTE and the OPE, for example. 

 

Advice 

• Put the HOPEX environment offline during the time of the manipulation so that you do not end 

up with differences or mix-ups (HOPEX users private workspaces started in OTE and …). 

• Because this manipulation takes places directly on the data, it is quicker and it is also a way to 

be absolutely sure that what was tested ends up being put in production. 

• It is also a way of being sure that both Oracle installations (OTE and OPE) have no important 

differences that could lead to odd behavior in HOPEX or hard-to-understand-errors: 

HOPEX SHOULD WORK LIKE IT USED TO in the OTE, otherwise the only explanation is to be 

looked for on the Oracle side. 

• When the comparison is made, ask the Oracle DBA to lock the SCHEMA(S) used so that there 

is no doubt about which Oracle SCHEMA(s) is/are being used. 

 



p. 73/76  
RDBMS Repository Installation Guide - HOPEX V2R1 

C0 - PUBLIC 

 
 

Vocabulary 

 

Term Comment 

Database A database is a collection of data, usually in the form of tables or files, under 

the control of a database management system (DBMS). 

In Oracle, a database is often called 'Instance'. Each running instance is 

associated to a specific process. 

Database server 

(hardware) 

A database server is a machine providing database services to other 

machines. In this document the database server is a machine running 

relational database management systems. A database server can host one or 

several instances. 

Example: 

• Server 'iba.company.com' 

• Server '192.888.777.666' 

• Server 'SQL02' 

 

DBA The DataBase Administrator is responsible for administering, monitoring, and 

maintaining the database. 

DBMS A DataBase Management System (DBMS) is a set of software programs that 

controls the organization, storage, management, and retrieval of data in a 

database. 

Example: GBMS, Oracle… 

GBMS GBMS is MEGA’s historical proprietary DBMS. 

Instant client Oracle technology. It enables running your applications without installing the 

standard Oracle client or having an ORACLE_HOME. 

Oracle instant client is embedded in HOPEX installations from MEGA 2009 SP1 

and higher. 

HOPEX Environment On RDBMS installations, an environment is a group of directories where 

HOPEX generates documents, log files, etc. 

RDBMS Relational DataBase Management System.  

Examples: Oracle, SQL Server, DB2 Universal Database,… 
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Term Comment 

Repository A repository is a structured collection of data. 

A HOPEX repository is a collection of HOPEX data. Data is structured in 

relation to a metamodel. Object names are often unique within the 

repository or with a namespace of the repository. 

Schema A schema object is a logical data storage structure. 

In Oracle, it is a collection of objects (example: tables, views, indexes, 

procedures, functions…) mapped to an Oracle user. A schema is stored in 

one/several tablespace objects of the database. 

It is strongly recommended to isolate each HOPEX Repository in a separate 

Oracle schema (User Repositories AND SystemDb repository) 

SID Oracle term. System Identifier. It enables identifying instances (database) 

Storage format HOPEX term. It defines the type of DBMS storing HOPEX data. 

Possible values are: 

o GBMS: storage in HOPEX historical DBMS 

o Oracle: storage in Oracle DBMS 

o SQL Server: storage in SQL Server DBMS 

 

SystemDb repository HOPEX Term. It is a HOPEX repository that stores system data, such as, user 

definition, metamodel definition, template definitions, queries, diagram 

configuration. This data can be shared by all user repositories within a HOPEX 

environment. A SystemDb repository is associated to one/several user 

repositories. 

Tablespace Oracle term. A tablespace is a logical group of data within a database. A 

tablespace usually groups table and/or index objects. 

User repository HOPEX Term. This is a HOPEX repository storing data, such as diagrams, org-

units... 
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Appendix - FAQs 

Is it possible to share user repositories and the SystemDb repository 
through user’s workgroups that do not share a file server?  

Yes. You can duplicate HOPEX Environment on each side to obtain this kind of configuration. 

 

Is it possible to have a user repository stored on a GBMS and a SystemDb 
repository stored on an Oracle/SQL server? 

No. Some features might work but it is not tested an not supported. Moreover many specific features 

will not work. 
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Is it possible to consult the data from an Oracle/SQL Server? 

It is technically possible and supported (e.g.: SELECT statement). However, this requires knowledge 

of the HOPEX RDBMS implementation and the HOPEX Metamodel. It is much easier to query the data 

from within HOPEX. 

Is it possible to update the data from an Oracle/SQL Server?  

It is technically possible but NOT supported (e.g.: UPDATE or DELETE statement). This requires the 

knowledge of the HOPEX RDBMS implementation and of the HOPEX Metamodel. Data updates must 

be performed from within HOPEX. All updates from outside the HOPEX application are made at the 

customer's risk. Consequences of inappropriate updates will not be supported. 
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1. SUMMARY 

 

This document describes the procedures necessary for installing Must licenses with HOPEX V2R1. 

 

It applies to all front-ends: 

• Web front-end 

• Windows Front-end 

 

It does not describe: 

• System requirements and possible architectures (see architecture overview documentation). 

• How to install a product release (see installation documentation). 

• How to manage installations (see administrator manuals). 

• How products are licensed (see licensing documentation). 

• How to use features (see user manuals). 
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2. FOREWORD 

 

HOPEX Must licensing is a technology of network licenses provided by MEGA. 

 

To obtain or update your license, contact your sales representative. 

• A UNC will be requested. 

• A .must license file will be sent with installation instructions. 

 

A Must license: 

• Is a file with a .must extension. 

• Contains the definition of the license (locking information, expiration date and list of products). 

• Is locked on a shared folder (UNC address). 

 

Must license installation mainly consists in: 

• Installing the license. 

• Configuring the license folder in the HOPEX installation. 

 

If you want to directly install a Must license, go to the section 'Installation procedures' of this document. 

 

After installation, the Must license can be configured to better control execution: 

• Configuring the command line (/RW code) 

• Configuring user x license mapping. 

• Configuring user to product mapping. 

 

A Must license utility is available for the license administrator to make these configurations and monitor 

license use. 

The Administration Console is still used to create and configure HOPEX users. 

 

A Web licensing console is also available to configure license. 

It does not enable to monitor use of token at a given moment. 

 

 

The list of available services varies with the front-end: 

 

Service HOPEX Web Front-

End 

HOPEX Windows 

Front-End 

Locking ● ● 

Shared licenses ● ● 

Dedicated license ● ● 

Concurrent license ● ● 

Multiple licenses ● (NR) ● 

Cluster license ● ● 

 

NR: not recommended because execution warning regarding are not displayed in HOPEX Web Front-End. 
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Definition of services:  

• Locking: 

o The license is programmed for a specific UNC address. The availability of this address is 

checked at runtime. 

• Dedicated licenses: 

o It is possible to program a license when a token for a product will be dedicated to a user. 

The number of tokens equals the number of users. The product is said to be programmed 

in dedicated mode. 

• Shared licenses: 

o It is possible to program a license when a token for a product will be assigned to a list of 

possible users. The number of tokens is lower than the number of possible users. The 

product is said to be programmed in shared mode. 

• Concurrent licenses: 

o It is possible to program a license when a token for a product will not be assigned to any 

user. The number of possible users is set to 0. The product is said to be programmed in 

concurrent mode. 

• Multiple licenses: 

o For the same HOPEX installation, it is possible to use different licenses to enable different 

access policies for different populations of end-users. 

• Cluster license: 

o The same license can be used for a set of HOPEX installations on different machines 

(cluster). 

 

Independently from the products/solutions, there are tree exclusive types of users: 

• Viewer users: consult data, search, use collaboration features 

• Contributor users: consult data, search, perform limited updates, use collaboration features 

• Main users: consult data, search, perform all updates in particular with diagram editor, use 

collaboration features 
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3. MUST LICENSE UTILITY  

A launcher licensing.exe is installed in the root folder of the HOPEX installation. It is a shortcut to the 

program mgwusrmng.exe located in the 'System' folder of the HOPEX installation. 

3.1. User Interface 
Several windows are available: 

• Select server path window: to locate a folder containing the Must license. 

• User management window: to configure Must licenses located in this folder. 

• Select HOPEX installation window: to locate the configuration folder of the HOPEX installation. 

Select server path window 

  

Click 'Browse' and select the folder containing the Must license to be configured. The 'OK' button 

is enabled as soon as a file with the .must extension is identified. 

Verify that the server path is the same as the UNC address chosen for the license. 
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User management window 

 

This window displays several elements: 

• A top menu (File, User, Administration) and a toolbar 'Add User, Remove User..) 

• The left pane displays the Must license available in the selected folder. 

• The top right pane displays the products available for the selected license. 

• The bottom right pane displays the bundle definition, if any. 

 

The top right pane has several columns. The list is different if a user or a licence is selected: 

• Code: the code of the technical product.  

• Product: the name of the technical product. 

• Connected: the number of users currently logged in to the product (this figure changes over time). 

• Used licences: the number of licence tokens currently used for the product (this figure changes 

over time). 

• Remaining licences: the number of licence tokens currently available for the product (this figure 

changes over time). 

• Total licences: the number of licence tokens programmed for the product (this figure does not 

changes over time). 

• Poss. User: the number of users that are set as possible users of the product (this figure changes 

over time). 

• Remaining Poss. Users: the number possible users currently available for the product (this figure 

changes over time). 

• Total Poss. Users: the number possible users programmed for the product (this figure does not 

changes over time). 

The license status is displayed in the left pane: 
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Display Status Possible causes 

  Valid - 

  Invalid License has expired 

Locking failed: the folder address containing the 

license file does not match the expected UNC 

 

The user status is displayed: 

Display Status 

  Connected 

 Not connected 

Select HOPEX installation window 

 

Click 'Browse' and select the folder containing the 'CFG' folder of the HOPEX installation to be 

configured. The 'OK' button is enabled as soon as the Megasite.ini file is identified. 
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4. INSTALLATION PROCEDURES 

The following procedures apply to all front-ends. They enable to install the Must license and protect a 

HOPEX installation with this license. 

4.1. Communicating with MEGA Sales Administration 
There are times where you will need a new Must license: 

• When you purchase a new HOPEX product or solution. 

• When you purchase additional licenses or users of HOPEX products or solutions. 

• When you relocate Must license folder. 

 

To obtain or update your license, contact your sales representative. 

• A UNC will be requested. 

• A .must license file will be sent with installation instructions. 

 

If a problem occurs during license installation, see the 'FAQs and troubleshooting' section of this document. 

For additional assistance, contact the appropriate Support Center. 

 

Must license installation consists in: 

• Installing the Must license file. 

• Configuring the license folder in the HOPEX installation. 

 

Must license update consists in: 

• Verifying that no user is connected to the former license. 

• Removing the former license. 

• Resetting the configuration files 

• Installing the updated license. 

4.2. Choosing a machine to host the Must license folder 
List of requirements: 

• No specific hardware requirements (CPU, Ram). However, the machine hosting the Must license 

must be an efficient file server. 

• The machine hosting the Must license must be available for all users running the HOPEX Kernel. 

 

List of recommendations: 

• The machine must be an efficient file server: 

o Select top quality components for disks and disk controller cards.  

o During installation and configuration, choose all options that favor file service performance. 

• Choose an NTFS disk. 

• Choose a DFS-based folder for the license folder 

4.3. Creating a Must license folder 
If you do not have the technical skills or the authorization required for this step, contact you system 

administrator. 

 

Steps: 

• Choose a machine to host the Must licenses. 

See above. 
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• Create a shared folder on this machine. 

This will be the license folder. See requirements below. 

• Configure this share folder. 

See requirements below. 

 

Folder sharing requirements: 

• The license folder must be accessible as a UNC address, meaning a shared folder with one unique 

address on the network. 

• Examples of authorized sharing: 

\\Server001\Apps\Licenses 

\\Domain01\Applications\HOPEX\Licenses (DFS) 

\\Server001.Domain01.com\Licenses (FQDN) 

• Examples of unauthorized sharing:  

\\Server002\c$\ HOPEX\Licenses (administrative share) 

M:\Licenses (network letter) 

 

License folder requirements: 

• The license folder must be accessible as a UNC with full control to all Windows users that are 

allowed: 

o To configure a Must license. 

o To run HOPEX Kernel programs with a Must license. 

• If you want to configure smarter permissions, consult the 'FAQs and troubleshooting' section of this 

document. 

4.4. Sending the UNC address of the license folder 
Prerequisite: 

• Create a license folder. 

 

No specific utility is provided for this step: you can use Windows explorer. 

Example: 

• Navigate to the license folder. 

• Select the folder path in the address bar. 

• Copy the folder path and send it to MEGA Sales Administration when requested. 

 

4.5. Installing a Must license file 
Prerequisites: 

• Get a Must license file. 

• Identify the license folder. This folder must match the UNC on which the HOPEX license file is 

locked. 

baggage/Licenses
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• Verify that this folder exists and is shared (Windows permissions) for every Windows user that can 

run HOPEX Kernel though a Front-end. 

Procedure: 

1. With Windows explorer, select the folder matching the UNC. 

2. Copy the .must file send by MEGA Sales Administration to this folder. 

Results: 

• The Must license is installed. 

4.6. Configuring the license folder in the HOPEX installation (direct 

reference) 
Prerequisites: 

• A Must license is installed in the license folder. 

• A target HOPEX installation is available.  

Procedure: 

1. Run the Must license utility. 

2. In the menu, select File > ‘Update config’. 

3. Click the 'Browse' button. 

4. Select the 'CFG' folder of the HOPEX installation. 

Results: 

• The Megasite.ini configuration file is updated. A section [Must licence] is created or updated. 

Example: 

[Must licence] 

Path=\\server001\Apps\Licenses 

• It is possible to run the HOPEX installation on behalf of this Must license.  

4.7. Configuring the license folder in the shared configuration folder 

(indirect reference) 
Prerequisites: 

• A Must license is installed in the license folder. 

• A shared configuration folder contains a file Megasite.ini. 

• A HOPEX installation is part of a cluster.   

Procedure: 

1. Browse the shared configuration folder. 

2. Edit the file Megasite.ini. 

3. Add a section [Must licence] and a variable 'Path'. Example: 

[Must licence] 

Path=\\server001\Apps\Licenses 

Results: 

• In the shared configuration folder, the Megasite.ini configuration file is updated. A section [Must 

licence] is created or updated. 

• It is possible that each workstation of the cluster shares the same license.  

4.8. Uninstalling the Must license  
Prerequisites: 

• Identify the Must license file to be uninstalled. 

• Identify the license folder. This folder must match the UNC on which the HOPEX license file is 

locked. 

• Verify with the Must license utility that no user is currently logged on to the license to be 

uninstalled. 
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Procedure: 

1. With Windows explorer, select the folder matching the UNC. 

2. Remove the .must file from this folder. 

Results: 

• The Must license is uninstalled. 

4.9. Resetting the configuration files 
When replacing a Must license with a license having the same name and UNC, it is recommended to reset 

the Must license configuration. 

Otherwise, the license may not run correctly in particular if the number of token has become lower for a 

product. A consequence it will be necessary to specify again the list of possible users. 

 

Prerequisites: 

• Identify the Must license file to be uninstalled. 

• Decided whether you reset the configuration 

• Verify with the Must license utility that no user is currently logged on to the license to be 

uninstalled. 

 

Procedure: 

1. Run the licensing.exe utility as Administrator. 

2. Select the server path where the license is saved. 

3. Select the license in the left tree. 

4. Right-click > Reset License configuration. 

5. Confirm reset. 

This will: 

• Delete the possible user configuration. 

• Delete the token files. 

• Delete the file Router.ini 

4.10. Converting licence 

When upgrading from HOPEX V1R2-V1R3 CP8.0 or lower CP, it is required to convert the file 
Router.ini to a new format. Otherwise, various issues can occur. 

Pre-requisites: 

• Stop all activity regarding HOPEX Windows Front-End and HOPEX Web Front-End. 

Procedure: 

1. Run the licensing.exe utility as Administrator. 

2. Click on the menu Administration > Convert. 

3. Click the button Refresh All. 

This will: 

• Archive the file configuration file 'Router.ini as 'Router.bak'.  

• Update the file 'Router.ini' to the new format: 

o A version tag is added (section [Router], version=x). 

o The reference to the domain (ex: @Domain01) is removed. 

o Duplicate line are removed. 

• Technical files are renamed. 

o The reference to the domain (ex: @Domain01) is removed. 

Example: 

Router.ini (before conversion) Router.ini (after conversion) 

[User/Licence] 

U001@Domain01=Licence-T0001 

[User/Licence] 

U001=Licence-T0001 
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U001@Domain02=Licence-T0002 

U002@Domain01=Licence-T0001 

U002=Licence-T0001 

 

[Router] 

Version=2 

4.11. Configure file permissions 
At runtime, files will be created dynamically in a hidden subfolder in the licence folder. 

It is necessary to configure file permissions so that execution is correct.  

It is recommended to grant the permission 'Modify' for the licence folder (ex: \\Server001\Apps\Licenses 

and its subfolders). 

The list of windows users varies with the front-end: 

Front-end Users to be configured 

Web Front-end Only the service account for the HOPEX (IIS) web application should be 

configured (ex: D01\hopex). Contact the person in charge of installing HOPEX 

Web Front-end 

Windows Front-end Each end-user can be configured (D01\u0001, D01\u0002…). It is therefore 

recommended that a group is created for users of the Windows Front-end. 
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5. CONFIGURATION AND MONITORING PROCEDURES 

The following procedures apply to all front-ends.  

5.1. Configuring the command line (/RO /RW code) 
 

Each product is associated to a product code. 

Ex: HOPEX IT Architecture has the code 'ARC' 

 

A property 'Command line' can be configured at several levels: 

 

Level Comment 

Profile level Configuration at this level is recommended. As there are less profiles 

than users, configuration is easier to maintain. 

User level (Login) Configuration at this level is NOT recommended. It is mainly available 

for compatibility with previous versions. 

 

At each level, it is possible to specify a command line with the following syntax: 

/RW'<list of product codes>' /RO'< list of product codes>' 

 

Example: 

 /RW'DMO;ARC' /RO'DBB' 

 

Where: 

• /RW: defines a list of product code accessed in read/write mode. 

Note that /K (previous specification) is equivalent to '/RW' 

• /RO: defines a list of product code accessed in read/only mode. 

It applies only if the product 'ReadOnly Mode' (code 'ROM') is programmed. 

 

Prerequisites: 

• Identify the HOPEX environment containing the users to be configured. 

• Get the table of product codes that you have bought. 

• Get a company specification of user/profile x product assignment. The level of configuration (user 

level or profile level) must be specified for each user for the company. 

 

Example of procedure to set /RW /RO for a profile: 

• Run the Administration Console. 

• Open the environment. 

• Select the folder 'User Accounts > Profiles and Permissions'. 

• Right-click > Manage. 

• In the tab 'Profile', select the expected profile. 

• Right-click > Properties. 

• In the tab 'Characteristics', set the property 'Command line'. 

 

Example of procedure to set /RW /RO for a user: 

1. Run the Windows Administration Console. 

2. Open the environment. 

3. Select the folder 'User Accounts > Users. 

4. Right-click > Manage.  
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5. In the tab 'Logins', select the login of the user requested. 

Ex: select the login 'Mega' for the login holder 'Mega' 

6. Right-click > Properties. 

7. In the tab 'Characteristics', set the property 'Command line'. 

 

If a value is set at both level, the intersection will be considered for /RW. 

If a value is set at both level, the concatenation will be considered for /RO. 

Example: 

Command line value set for the 

user (Login Level) 

Command line value set for 

profile 

Command line value considered 

 /RW'ARC' /RW'ARC' 

/RW'DMO;ARC' /RW'ARC' /RW'ARC' 

/RW'DMO' /RW'ARC' - 

/RW'DMO;ARC' /RO'DBB' /RW'ARC' /RO'MTS2' /RW'ARC' /RO'DBB;MTS2' 

 

Results: 

• The profile is configured to run certain products. 

• The user is configured to run certain products. 

5.2. Specifying a default licence 
 

If several licences exist in the licence folder, users must be configured explicitly. Otherwise, they 
cannot login. It is however possible to specify a default licence. 

 
Procedure: 

In the file in router.ini, manually add a section [Config] such as: 

[Config] 
DefaultLicence=<licence name>  

 
Where 'licence name' is the name of the licence file without the .must extention. 

Ex: if the file is 'License-T0002.must', the licence name is 'License-T0002'. 

5.3. Declaring users 
This is important in several situations: 

• Several Must licences exist: users should be allocated in the different licences unless a 

default licence is specified. 

• Shared licence: possible users should be specified beforehand. 
• Dedicated licence: named users should be specified beforehand. 

Adding a user to a license  

Prerequisites: 

• A Must license is installed. 

• A HOPEX installation is available and configured for Must licenses. 

• Get user x license mapping specification. Each user must be declared with its HOPEX login. The 

users must be able to know the login of each user. Ex: the HOPEX login of John Smith is 'U0001'. 

Procedure: 

1. Run the Must license utility. 

2. Select the license folder. 

3. Select the license to be configured. Ex: License-T0001. 

4. Click the 'Add user' button: enter the login name (Ex: enter 'U0001' for the user 'John Smith is 

'U0001') and click 'OK'.  
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Results: 

• The user is displayed in the left pane below the license (<user login>). Ex: U0001 

• The 'Router.ini' configuration file is created in the license folder for saving this specification. A 

section [User/Licence] is created or updated. 

Example: 

[User/Licence] 

U0001=License-T0001 

Note that you can also enter several login names separated with semicolon or line break (example: 

U0001;U0002)  

Removing a user from a license  

Prerequisites: 

• A Must license is installed. 

• A HOPEX installation is available and configured for Must licenses. 

Procedure: 

1. Run the Must license utility. 

2. Select the license folder. 

3. Select the license to be configured. Example: License-T0001. 

4. Select the login of the user to be removed. 

5. Click the 'Remove user' button. 

Results: 

• The user is no longer displayed in the left pane below the license. 

5.4. Configuring possible users of products 

Setting a user as a possible user of a product 

Prerequisites: 

• A Must license is installed in the license folder. 

• A HOPEX installation is available and configured for Must licenses. 

• Users are declared. 

• Get user x product mapping specification. 

Procedure: 

1. Run the Must license utility. 
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2. Select the license folder. 

3. Select the license to be configured. 

4. Select the product to be configured. 

5. Select the user to be set as a possible user of the product. 

6. Click the 'Possible user or not' button. 

Results: 

• When both user and product are selected, a checkbox is displayed in the 'Poss. User' column of the 

top right pane. It shows that the current user is a possible user for the product. 

• Files are created in the license folder for saving this specification. A subfolder 'USERS' exists with 

the license name. It contains a user file. Ex: U0001.usr-ARC-MEGA. 

 

Removing a user as a possible user of a product 

Prerequisites: 

• A Must license is installed in the license folder. 

• A HOPEX installation is available and configured for Must licenses. 

• Users are mapped to licenses. 

Procedure: 

1. Run the Must license utility. 

2. Select the license folder. 

3. Select the license to be configured. 

4. Select the product to be configured. 

5. Select the user to be removed as a possible user of the product. 

6. Click the 'Possible user or not' Button. 

Results: 
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• When both user and product are selected, no checkbox is displayed in the 'Poss. User' column of 

the top right pane. 

• Files are updated in the license folder for saving this specification. 

Cleaning up license tokens 

Prerequisites: 

• A Must license is installed in the license folder. 

• A HOPEX installation is available and configured for Must licenses. 

• Verify with the Must license utility that no user is currently logged on to the license to be cleaned. 

Procedure: 

1. Run the Must license utility as Administrator. 

2. Select the license folder. 

3. Select the license to be configured. 

4. Click the 'Clean up' Button. 

Results: 

• Unexpected token files are purged. 

 

Note that, if a lot of token files exist when the button 'Clean up' is first clicked, the processing can take 

several minutes according to the number of token files, the number of licenses and the file access 

performances. The token files are purged for each license displayed in the left pane. The processing will run 

faster the next times button 'Clean up' is clicked (as most token files will have been purged). 

5.5. Instant monitoring of license connections 

The Must license utility can be used to monitor connections even though it was not designed for 
this purpose. Display may be slow. 

Prerequisites: 

• A Must license is installed in the license folder. 

• A HOPEX installation is available and configured for Must licenses. 

Procedure: 

1. Run the Must license utility. 

2. Select the license folder. 

3. Select the license to be monitored. 

4. Select the user or the product to be monitored. 

5. Read the top right pane, column 'Connected'. 
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6. CONFIGURING LICENSING MODES AND USER TYPES 

In certain situation, the same product can be programmed in several licensing modes. 

Ex: 

For HOPEX IT Architecture:  

• 5 access in shared mode 

• 10 access in concurrent mode (floating mode) 

• 5 access in dedidated mode 

 

Command line parameters will be used to control user tokens (LAN_X tokens) delivery. 

By default the product named LAN is used in shared mode. 

There can also be a product named LAN_F for concurrent mode.  

There can aslo be a product named LAN_D for dedicated mode. 

 

The general steps will be: 

• Check that .Must licence is programmed in the expected mode. 

• Enable extended mode in megasite.ini. 

• Configure command line. 

 

Independantly from the products/solutions, there are tree exclusive types of users: 

• Viewer users: consult data, search, use collaboration features. VIEW counter is used.   

• Contributor users: consult data, search, perform limited updates, use collaboration features. CBTR 

counter is used. 

• Main users: consult data, search, perform all updates in particular with diagram editor, use 

collaboration features. LAN_X counters are used. 

 

Command line parameters will be used to control user tokens delivery. 

• By default, LAN counter is used if no possible user is configured. 

• To user viewer users, a specific command line should be used. 

• To user contributor users, a specific command line should be used. 
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6.1. Configuration of main users with concurrent mode (floating 

mode) 

Check .Must licence  

By convention, a product programmed in concurrent mode will use the LAN_F counter for main users. 

Other products must be programmed in concurrent mode. 

This can be checked in the licence file description: the second digit equals 0 (except for LAN_X counter). 

 

Extract of license description comment 

[MEGAComponentInfo] 

(LAN) HOPEX MainUser=3 ; 0  

(RSO) Repository Storage (ORACLE)=NO 

(RSQ) Repository Storage (SQL Server)=YES 

(DMO) HOPEX Logical Data=3 ; 5  

(SUP) HOPEX Power Supervisor=1 ; 1  

(APM) HOPEX IT Portfolio Management=1 ; 1  

(ANW) Web Front-End=NO 

(HPP) HOPEX Productivity Pack=NO 

(HBPA) HOPEX Business Process Analysis=3 ; 3  

(CBTR) HOPEX Contributor=1 ; 0  

(VIEW) HOPEX Viewer=1 ; 0  

APM_F=5 ; 0  

LAN_D=5 ; 0  

LAN_F=3 ; 0  

 

[MEGABundleInfo] 

APM_F=APM 

LAN_D=LAN 

LAN_F=LAN 

 

Counter of main users (shared mode) 

- 

- 

Programmed in shared mode 

Programmed in dedicated mode 

Programmed in dedicated mode 

- 

- 

Programmed in dedicated mode 

Counter of contributor users 

Counter of view users 

Programmed in concurrent mode 

Counter of main users (dedicated mode) 

Counter of main users (concurrent mode) 

 

 

Note that the extension _F is conventional (except for LAN_F). Although it is not called APM_F, APM is 

programmed in concurrent mode. 

Configure command line 

This property 'Command line' exists at login level and profile level. 

Use the /RW syntax and quote product codes programmed in concurrent mode. 

Ex: /RW'LAN_F,APM_F' 

 

Reminders: 

• It is recommended to configure command line for profiles rather than for logins 

• Standard profiles are protected, it is recommended to create a custom profiles that 
inherits from a standard profile. 

• Changing command lines property will reset technical data cache. A warning 'The 
technical data are not compiled…' will be displayed as long as technical data are not 

recompiled. 
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6.2. Configuration of main users with dedicated mode 

Check .Must licence  

By convention, a product programmed in dedicated mode will use the LAN_D counter for main users. 

Other products must be programmed in dedicated mode. 

This can be checked in the licence file description: the second digit equals the first one (except for LAN_X 

counter). 

Extract of license description comment 

[MEGAComponentInfo] 

(LAN) HOPEX MainUser=3 ; 0  

(RSO) Repository Storage (ORACLE)=NO 

(RSQ) Repository Storage (SQL Server)=YES 

(DMO) HOPEX Logical Data=3 ; 5  

(SUP) HOPEX Power Supervisor=1 ; 1  

(APM) HOPEX IT Portfolio Management=1 ; 1  

(ANW) Web Front-End=NO 

(HPP) HOPEX Productivity Pack=NO 

(HBPA) HOPEX Business Process Analysis=3 ; 3  

(CBTR) HOPEX Contributor=1 ; 0  

(VIEW) HOPEX Viewer=1 ; 0  

APM_F=5 ; 0  

LAN_D=5 ; 0  

LAN_F=3 ; 0  

 

[MEGABundleInfo] 

APM_F=APM 

LAN_D=LAN 

LAN_F=LAN 

 

Counter of main users (shared mode) 

- 

- 

Programmed in shared mode 

Programmed in dedicated mode 

Programmed in dedicated mode 

- 

- 

Programmed in dedicated mode 

Counter of contributor users 

Counter of view users 

Programmed in concurrent mode 

Counter of main users (dedicated mode) 

Counter of main users (concurrent mode) 

 

 

Note that the extension _D is conventional (except for LAN_D). Although it is not called HBPA_D, HBPA is 

programmed in dedicated mode. 

 

Configure command line 

This property 'Command line' exists at login level and profile level. 

Use the /RW syntax and quote product codes programmed in concurrent mode. 

Ex: /RW'LAN_D,HBPA,APM' 

 

Note that it is not required to quote all product codes programmed in dedicated mode in the command 

line. Here SUP, is not quoted because it is assigned to a specific login/profile. 

 

Reminders: 

• It is recommended to configure command line for profiles rather than for logins 
• Standard profiles are protected, it is recommended to create a custom profiles that 

inherits from a standard profile. 
• Changing command lines property will reset technical data cache. A warning 'The 

technical data are not compiled…' will be displayed as long as technical data are not 

recompiled. 
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6.3. Configuration of main users with shared mode 

Check .Must licence  

By convention, a product programmed in dedicated mode will use the LAN counter for main users. 

Other products must be programmed in dedicated mode. 

This can be checked in the licence file description: the second digit is greater that the first one (except for 

LAN_X counter). 

Extract of license description comment 

[MEGAComponentInfo] 

(LAN) HOPEX MainUser=3 ; 0  

(RSO) Repository Storage (ORACLE)=NO 

(RSQ) Repository Storage (SQL Server)=YES 

(DMO) HOPEX Logical Data=3 ; 5  

(SUP) HOPEX Power Supervisor=1 ; 1  

(APM) HOPEX IT Portfolio Management=1 ; 1  

(ANW) Web Front-End=NO 

(HPP) HOPEX Productivity Pack=NO 

(HBPA) HOPEX Business Process Analysis=3 ; 3  

(CBTR) HOPEX Contributor=1 ; 0  

(VIEW) HOPEX Viewer=1 ; 0  

APM_F=5 ; 0  

LAN_D=5 ; 0  

LAN_F=3 ; 0  

 

[MEGABundleInfo] 

APM_F=APM 

LAN_D=LAN 

LAN_F=LAN 

 

Counter of main users (shared mode) 

- 

- 

Programmed in shared mode 

Programmed in dedicated mode 

Programmed in dedicated mode 

- 

- 

Programmed in dedicated mode 

Counter of contributor users 

Counter of view users 

Programmed in concurrent mode 

Counter of main users (dedicated mode) 

Counter of main users (concurrent mode) 
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Configure command line 

This property 'Command line' exists at login level and profile level. 

Use the /RW syntax and quote product codes programmed in concurrent mode. 

Ex: /RW'LAN,DMO' 

 

Reminders: 

• It is recommended to configure command line for profiles rather than for logins 

• Standard profiles are protected, it is recommended to create a custom profiles that 
inherits from a standard profile. 

• Changing command lines property will reset technical data cache. A warning 'The 

technical data are not compiled…' will be displayed as long as technical data are not 
recompiled. 

 

6.4. Configuration for viewer users 
By convention, a product programmed in dedicated mode will use the VIEW counter for main users. Check 

the license. 

Extract of license description comment 

[MEGAComponentInfo] 

(LAN) HOPEX MainUser=3 ; 0  

(RSO) Repository Storage (ORACLE)=NO 

(RSQ) Repository Storage (SQL Server)=YES 

(DMO) HOPEX Logical Data=3 ; 5  

(SUP) HOPEX Power Supervisor=1 ; 1  

(APM) HOPEX IT Portfolio Management=1 ; 1  

(ANW) Web Front-End=NO 

(HPP) HOPEX Productivity Pack=NO 

(HBPA) HOPEX Business Process Analysis=3 ; 3  

(CBTR) HOPEX Contributor=1 ; 0  

(VIEW) HOPEX Viewer=1 ; 0  

APM_F=5 ; 0  

LAN_D=5 ; 0  

LAN_F=3 ; 0  

 

[MEGABundleInfo] 

APM_F=APM 

LAN_D=LAN 

LAN_F=LAN 

 

Counter of main users (shared mode) 

- 

- 

Programmed in shared mode 

Programmed in dedicated mode 

Programmed in dedicated mode 

- 

- 

Programmed in dedicated mode 

Counter of contributor users 

Counter of view users 

Programmed in concurrent mode 

Counter of main users (dedicated mode) 

Counter of main users (concurrent mode) 

 

Configure command line 

This property 'Command line' exists at login level and profile level. 

Use the /HV syntax and quote product codes programmed in concurrent mode. 

Ex: /HV'APM' 
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6.5. Configuration for contributor users 
By convention, a product programmed in dedicated mode will use the VIEW counter for main users. Check 

the license. 

Extract of license description comment 

[MEGAComponentInfo] 

(LAN) HOPEX MainUser=3 ; 0  

(RSO) Repository Storage (ORACLE)=NO 

(RSQ) Repository Storage (SQL Server)=YES 

(DMO) HOPEX Logical Data=3 ; 5  

(SUP) HOPEX Power Supervisor=1 ; 1  

(APM) HOPEX IT Portfolio Management=1 ; 1  

(ANW) Web Front-End=NO 

(HPP) HOPEX Productivity Pack=NO 

(HBPA) HOPEX Business Process Analysis=3 ; 3  

(CBTR) HOPEX Contributor=1 ; 0  

(VIEW) HOPEX Viewer=1 ; 0  

APM_F=5 ; 0  

LAN_D=5 ; 0  

LAN_F=3 ; 0  

 

[MEGABundleInfo] 

APM_F=APM 

LAN_D=LAN 

LAN_F=LAN 

 

Counter of main users (shared mode) 

- 

- 

Programmed in shared mode 

Programmed in dedicated mode 

Programmed in dedicated mode 

- 

- 

Programmed in dedicated mode 

Counter of contributor users 

Counter of view users 

Programmed in concurrent mode 

Counter of main users (dedicated mode) 

Counter of main users (concurrent mode) 

 

Configure command line 

This property 'Command line' exists at login level and profile level. 

Use the /HC syntax and quote product codes programmed in concurrent mode. 

Ex: /HC'APM' 
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7. INSIDE 

7.1. License deployment model 

Two types of references can be used: 

Configuration Example of Megasite.ini Comment 

Local 

configuration 

[Must licence] 

Path=\\server001\Apps\Lic

enses 

The Must license folder 

(\\server001\Apps\Licenses) is configured in the 

file Megasite.ini of the HOPEX Installation 

Shared 

configuration 

[Lan] 

clusterrootpath=\\mega\da

ta  

The file Megasite.ini of the HOPEX installation 

refers to the root of a shared configuration folder 

(ex:  \\mega\data\ClusterRoot\Cfg) containing 

another file Megasite.ini. This file contains a direct 

reference to the Must license folder 

(\\server001\Apps\Licenses). 

This type of reference must be used for Citrix/TSE 

deployment 

 

 

When HOPEX is run by user U0001: 

1. A configuration file (megasite.ini) is read to identify the license folder. 

2. The license folder can be referenced directly (local configuration) or indirectly (shared 

configuration). 

3. The license folder is read to identify the authorized license file for this user. 

4. The Must license configuration is read to identify the products authorized for this user. 

5. Connection is made if tokens are available for the authorized products. 

  

baggage/Licenses_2
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7.2. License execution 
License execution is homogenous through Front-Ends or Windows Administration Console. 

Windows Front-End 

Context Must license 

checked 

Storage 

product 

checked (1) 

Tokens requested Command line 

considered 

HOPEX.exe (main user) Yes Yes (2) One token per Product 

One token LAN_X 

Yes 

Administration.exe Yes Yes (2) One token SUP 

One token LAN_X 

No 

HOPEX.exe with HOPEX Power 

Studio (MTS2) 

Yes Yes (2) One token MTS2 

One token LAN_X 

Yes 

API component (3) Yes Yes (2) One token per Product  

One token LAN_X 

Yes 

 

(1) RSQ or RSO 

(2) Unless GBMS storage is used. 

(3) Administration component creating a running instance of HOPEX (mgwmapp.exe) 

Web Front-End 

Context Must license 

checked 

Counter used Tokens requested Command line 

considered 

HOPEX Product (multi 

front-end) 

Yes (1) LAN_X One token per Product 

One token LAN_X 

Yes 

HOPEX Product (controlled 

multi front-end) 

Yes (1)(2) LAN_X One token per Product 

One token LAN_X 

Yes 

HOPEX Solution Yes (1) LAN_X One token per Solution 

One token LAN_X 

Yes 

SSP component  Yes (1) - No token (3) No 

HOPEX Explorer Yes (1) LAN_X One token for HEXP 

One token LAN_X 

Yes 

HOPEX Contributor Yes CBTR_X One token for CBTR_X Yes 

HOPEX Viewer Yes VIEW_X One token for VIEW_X Yes 

 

(1) RSQ or RSO product should be programmed. 

(2) ANW product should be programmed. 

 

When running the SSP component, must license is checked but no token is requested. SSP is used 

systematically with HOPEX Web Front-End. It can also be used by Windows Front-End. 

7.3. File access 
File access in the license folder should be similar to that of accessing a HOPEX repository data file. Contact 

MEGA Support if you encounter problems. 
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8. FAQS AND TROUBLESHOOTING 

8.1.1. How can I use the Web licensing console? 
See online documentation. 

Note that the Web licensing console 

• Needs to be installed when installing HOPEX Web Front-End. 

• Needs to be allowed to the administrator in charge (security configuration). 

• Does not allow to see user of tokens by login. 

8.1.2. Do I have to configure possible users?  
This is not required. If products are programmed in shared mode and the command line is configured, you 

do not need to explicitly configure possible users. 

When user U0001 logs in, a token is requested for each product mentioned in the command line. If 

possible, user seats are available, U0001 is automatically configured as a possible user of the requested 

products. If tokens are available, U0001 can log in to these products. 

8.1.3. How can I secure configuration of the HOPEX Must license?  
If you do not want to configure systematically full control, you may configure advanced file permissions: 

File Location Administrator 

rights 

User rights 

*.must Example: 

\\server001\Apps\Licenses\License-001.must 

Modify Read & 

execute 

*.* License subfolders containing the user files and 

token files. Example for License-001.must: 

\\server001\Apps\Licenses\License-001 and subfolders 

Modify  Modify1 

 

 

The users considered vary with the front-end.  

Front-end Comment 

HOPEX Web Front-end Only the service account for the HOPEX (IIS) web application should be 

configured 

Windows Front-end Each end-user and administrators should be configured (ex: D01\U0001) 

 

8.1.4. How can I prevent the dynamic declaration of possible users?  
There is no way of preventing a user who is not explicitly configured from logging in. 

If a possible user seat is available, the system will set a user requesting a token as a possible user. For this 

reason, it is recommended you configure possible users beforehand. 

8.1.5. How can I get a log of license connections?  
Supervision logs contain information regarding connection and disconnection. However, this is technical 

information and MEGA does not provide a report to consolidate and display this information.  

8.1.6. What is the Router.ini file?  
This file contains the mapping of users to licenses. 

It is updated when configuration is made using the Must license utility ('Add user' and 'Remove user' 

actions). Deletion of this file will not remove possible user configurations. 

                                                            
1 By default, user files and token files are set as 'Not visible'. 

baggage/License-001
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8.1.7. How can I get the assignment of users to licenses?  

No report is available. You can consult the Must license utility (left pane) or read the Router.ini 

file. 

8.1.8. How can I get the assignment of possible users to product?  

No report is available. Consult the Must license. 

8.1.9. When adding a user, I get an error 'Bad format with user 'XX'!  

This is because the data entered does not match the format expected. 

 

8.1.10. How can I get the list of logins of users?  

No report is available. Consult the Windows Administration Console (Administration.exe). 

8.1.11. I do not know the names of the logins. Why can't the utility 

provide a list of existing login?  
This is a design option. The list of existing logins is related to a HOPEX environment 

This would require to login to a HOPEX environment which is not in the scope of the licensing utility. 
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8.1.12. How can I set possible users for a selection of users?  
It is not possible to select multiple users in the left pane of the Must license utility. However, a specific 

operating mode enables the administrator to replicate the possible user configurations of products on a 

license for other users. 

 

Procedure: 

1. Run the Must license utility. 

2. Select the license folder. 

3. Select the license to be monitored in the left pane. 

4. Select a user for this license. 

5. Configure possible users of the different products in the top right pane: 

o Select the products to be configured. 

o Click the 'Possible User or not' button. 

6. Select another user in the left pane: the same list of products is selected. 

7. Click 'Possible User or not': the same configurations are replicated on the products selected. 

8.1.13. Can I mix shared and dedicated modes?  
Yes. Note that modes are set at the product level. 

8.1.14. Is my license shared or dedicated?  
To check the licensing mode:  

1. Open the .Must license file with a text editor such as Notepad 
2. Analyze configuration: the mode depends on the combination of 2 digits 

 

<License Product>=T ; U 
Where: 

T: tokens  
U: users  

 

Licensing mode Example  

Dedicated mode (T=U) (HITA) HOPEX IT Architecture=20 ; 20 

Shared mode (T< U) (HITA) HOPEX IT Architecture=20 ; 25 

Concurrent mode/floating mode (T>U, U=0) (HITA) HOPEX IT Architecture=20 ; 0 

 

Note that modes are set at the product level. 

8.1.15. Error message 1 

 
Possible reasons: 

• The path of the folder containing the Must license file does not match the path programmed in the 

license. 

• The license file name does not match the file name programmed in the license (license file was 

renamed). 
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8.1.16. Where is the latest license folder used saved?  
With Windows Front-End, it is saved in the user settings file (MEGASETTINGS.INI) in a section 

[MGWUSRMNG]. 

Example:  

[MGWUSRMNG] 

LastServerPath=\\server001\Apps\Licenses 

8.1.17. How can I check that an HOPEX installation is part of a cluster?  
Check the file Megasite.ini of the installation. It must contain a section [Lan] and a variable clusterrootpath. 

Example: 

[Lan] 

clusterrootpath=\\mega\data 

8.1.18. A message is displayed like You are not allowed to launch 

HOPEX V2R1 with your license file “xxxx.must”. It must be 

upgraded for this version. Please contact your sales representative 

to obtain a valid license file.  
This is a standard warning with HOPEX V1R2-V1R3, HOPEX V2 or HOPEX V2R1. 

Licences generated for lower versions (MEGA 2009, HOPEX V1R1) are not compatible with higher versions. 

Please contact your sales representative. 
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Summary 

 
This document describes the procedures necessary for upgrading HOPEX Data: 

• To version HOPEX V2R1 update 3 and higher 

• From: 

• HOPEX V1R3 CP16.0 or higher CP. 
• HOPEX V2 any CP. 

 

For prior versions (MEGA 2009 SP5, HOPEX V1R1, HOPEX V1R2…), it is necessary to perform 
an intermediate upgrade to one of these versions. 

 
This document applies to version HOPEX V2R1 and higher CPs. 

 
This document applies to all Front-Ends of HOPEX: 

• Web Front-End. 
• Windows Front-End. 

 

This document also applies to the different storage formats for HOPEX Data: 
• Oracle. 

• SQL Server. 
• GBMS (supported only for Windows Front-end). 

 
It does not describe: 

• System requirements and possible architectures (see architecture overview documentation). 
• Change is product list (see your sales representative) 

• How to perform installations (see installation documentation). 

• How to install update (see how to install update documentation). 
• How to manage installations (see administrator manuals). 

• How products are licensed (see license installation documentation). 
• How to use features (see user manuals). 
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1. MAIN STEPS TO MIGRATE DATA TO HOPEX V2R1 

The data migration consists of several main steps: 

 
1. Prepare data for migration 

 
This step requires the source version (HOPEX V1R3 CP16.0 or higher CP, HOPEX V2). 

 
This step performs a validation that the existing data is compliant with the future metamodel and that 

customizations associated MetaAssociation behaviors are saved. 
 

It also checks for pre-requisites, identifies solution packs used, and helps to determine the value of 

important parameters (options). 
 

Most of this work requires human intelligence and knowledge of data that has been modelled within 
the tool. As a consequence, it cannot be automated and should be scheduled in advance of a 

production migration. 
 

2. Upgrade data 
 

This step requires HOPEX V2R1. 

 
The process upgrades the metamodel and converts data to the format required by the HOPEX platform. 

This is carried out via conversion tools that need to be run manually from the Administration Console 
(Administration.exe). The procedures vary according to the source version your existing data.  

 
In addition, this allows important parameters to be reviewed (options). 

 
3. Check upgraded data and customizations 

 

This step requires HOPEX V2R1. 
 

This step involves validation from the end user perspective since they are most familiar with the prior 
state of the data. 

 
• Modelled data has been correctly migrated. 

• Customizations have been correctly migrated. 
 

This step also requires human intelligence and knowledge of modelled data. Therefore, it cannot be 

automated. 
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2. PREPARE UPGRADE OF DATA 

2.1. Check metamodel, locks, workspaces and workflows 
In the source version (HOPEX V1R3, HOPEX V2), for each environment: 

 

Check Detail 

Check that the metamodel is stable In Windows Administration Console (Administration.exe), 
compile the environment. If the environment compilation 

generates a log entry in the HOPEX error log, you should fix 
such errors before migrating your data 

Check that no private workspace 

(ex-transactions) persists 

In Windows Administration Console (Administration.exe), 

check workspaces. If a private workspace persists, dispatch or 

delete it.  

Check that no lock persists In Windows Administration Console (Administrration.exe), 
check locks. With GBMS storage, you can delete remaining 

locks. With RDBMS storage (Oracle or SQL Server), you need 
to dispatch of delete related workspace. 

2.2. Decide format of report templates (MS Word) 
With HOPEX, two formats are available for Report (MS Word) objects and RTF stylesheets. 

 

Format Recommended or required 

RTF Required for the environment in the following situations: 

• If reports (MS Word) are generated from both Windows and Web Front-
ends (1). 

• If reports (MS Word) are generated only from Web Front-ends. 
• If Report (MS Word) are generated in batch mode with Windows scheduler. 

MS Word  Compatibility mode that can be used only if Reports (MS Word) are generated: 

• In interactive mode (no batch). 
• From Windows Front End. 

 

Format Impacts 

RTF Reports have the .rtf or .docx file extension according to an option (2). 
RTF stylesheets has the .rtf file extension. MS word is not used at runtime. 

No links exist in generated reports. Fields (such as table of content) are not 
refreshed automatically. RTF macros are not supported. Application of styles is 

not enforced after generation, which may cause differences in display. 

MS Word Reports have the .doc file extension. 
RTF stylesheets has the .doc file extension. 

MS word is used at runtime. 

Links exist in generated reports (can be removed with detach). 
This format is now deprecated. 

 

By default, with HOPEX V2R1, RTF format is used. If you need MS Word format, you must 
configure each HOPEX environment. See section 'Check format of report templates (MS Word)' 

later in this document. 
(1) A configuration enables to benefit from links and refreshing in report (MS Word). It requires 

that if MS Word is installed. 
(2)  Option 'Activate generation of documents in DOCX. 
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2.3. Identify Solution packs used 
Solutions packs are add-ins installing data or templates. There are imported in data repositories using 
the Administration Console, but they can update the system database. 

Example: DoDAF, NAF … 
 

For each HOPEX environment, identify the list of solution packs imported: 

• In the system database 
• In a data repository 

2.4. Management of login assignments 
To enable login to HOPEX, a user must be mapped to a profile (directly or indirectly). 
The management of login assignment has changed to favor better performances. 

 

Version of HOPEX Comment 

HOPEX V1R1 

HOPEX V1R2-V1R3 

An option 'Management of assignment of business roles to persons' 

enables to switch between 2 modes 
• Person assignment mode: a user (Person (System)) is 

mapped to one/several Business Roles within a data repository. 
Each Business Role is mapped to a Profile. 

• Profile mode: a user (Login) is mapped to one/several Profiles 
within an environment 

HOPEX V2 

HOPEX V2R1 

A unique mode called Profile assignment mode is available: a Person 

(System) is mapped to one/several Profiles within an environment. 
The previous configurations are converted to the new mode for login. 

The option 'Management of assignment of business roles no longer 

exists. 

 
Note that person assignment is also used to manage responsibility on object (ex: John Smith is 'Local 

Application owner' for the application 'Internal reporting'. This kind of assignment persists with HOPEX 
V2R1 as in HOPEX V1R2-V1R3. 

2.5. Decide 'Definition of path of MetaAssociation' 
This step requires a decision for each HOPEX environment. 
 

In the HOPEX options, group 'Repository', an option 'Definition of path of MetaAssociation' is available 
at installation and environment level. This option enables to control the way MetaAssociation behaviors 

are interpreted according to the value chosen: 
• Compatibility up to MEGA 2009: MetaAssociation behaviors are interpreted using the logic of 

MEGA 2009. 
• From MEGA HOPEX 1.0: MetaAssociation behaviors are interpreted using a new logic. 

 

Value Recommended  

Standard Mode Recommended for new projects. Default value. 

Compatibility Mode Recommended for compatibility with behaviors and 

customizations performed in version MEGA 2009 and lower (data 
and system database customization). When switching to 

'Standard mode', a review that may require time and expertise is 
necessary. 

 

Note that ' Standard Mode' is the default value from HOPEX V1R2/V1R3. You can change the value 
and compile the environment without impact on data except namespace. However, the change will 

affect the behaviors (namespace, navigation, extraction, protection, export, comparison…). 

2.6. Check license with your sales representative 
The list of products/solutions changes with each version: 

• Certain products/solutions are removed (not available). 
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• Certain products/solutions are deprecated (available and supported as is). 

• Certain products/solutions are repackaged (features still available through another product/ 
solution) 

 
This document will not describe the product lists or the changes between versions. Please contact your 

sales representative to see if a new license needs to be programmed. 
 

2.7. Review use of the profile 'Enterprise Architect' 
For many version, the profile 'Enterprise Architect' (ex-EA Standard) has been used for multiple 

purpose 
• Use legacy products (MEGA Process BPMN edition, MEGA Architecture…) 

• Perform customizations 
• Use HOPEX Solutions 

 
This profile is designed for use of legacy products. 

• It is not designed for customization: use the profile 'HOPEX Customizer'. 

• It is not designed for use HOPEX Solutions: use dedicated profiles and desktops. 
 

From HOPEX V2R1, the profile 'Enterprise Architect' has a command line that filters HOPEX Studio and 
HOPEX Solution: 

/RW'NAF;ARC;HBPA;DOD2;FEA;UML;ITD;ETOM;MPL;SOIA;TOG;SAP;MBS;DMO;ERML;CMDB' 
 

If projects need a profile and desktops that combines legacy product and HOPEX solutions or that 
combines HOPEX Solutions, a specific study is required. 

2.8. Review authentication mode 
With HOPEX V2R1, a new authentication framework called UAS (Unified Authentication Service) is 

available. 
Authentication configured with previous versions will run natively in most cases (see section 'Other 

checking indications' in this document). Anyway, it is recommended to consider the UAS framework 
capabilities: 

• OpenID authentication (out of the box, configuration required). 
• SAML2 authentication (out of the box, configuration required). 

• Windows authentication (out of the box, configuration required). 

• .NET project template provided to quickly develop a custom authentication provider (UAS 
custom provider). 

 
For more details, see article 'HOPEX Unified Authentication Service Installation guide'. 

2.9. Decide to keep web settings 
Web settings are user related settings. They contain information that can be considered as useful, ex: 

• List of tiles selected by user in web desktop 

• List of dashboards (widgets) selected by user in web desktop 

From HOPEX V2R1, web settings persist in different folder. 

 

If you need to restore this information when migrating from HOPEX V1R3 or HOPEX V2 to HOPEX 
V2R1, archive (file copy) the file MegaSettings-*.ini on the server hosting the source installation 

(HOPEX V1R3 or HOPEX V2). With HOPEX V1R3 and HOPEX V2, such files are saved in the folder: 
%windir%\SysWOW64\config\systemprofile\AppData\Roaming\Mega 
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3. UPGRADE DATA FROM HOPEX V1R3 OR HOPEX V2 

For each HOPEX environment, several steps are required:  

• Check data upgrade pre-requisites. 

• Perform technical conversion of the system database for SQL Server or Oracle storage. 

• Upgrade of both the system database and data repositories using an environment update wizard. It is no 

longer required to convert explicitly each data repository. Of course, if a data repository is referenced after 

environment upgrade, the environment update wizard needs to be run again so that it is converted. 

 

The procedure varies with the type of storage: 

• RDBMS (SQL server or Oracle). 

• GBMS 

 

Note that environment upgrade consists in running: 

• Technical conversions. They update SQL tables and indexes to the expected format. They apply for each 

data repository and for the systemdb database in SQL Server or Oracle storage. They do not apply for 

GBMS storage. 

• System database upgrade. It upgrades the metamodel and templates stored in the system database to 

the format expected for the target version. They apply whatever the storage format used (SQL Server, 

Oracle, GBMS). 

• Functional conversions. They update the system objects stored in system database and the data objects 

stored in the data repositories to the expected format. They apply whatever the storage format used (SQL 

Server, Oracle, GBMS). 
 

3.1. Check data upgrade pre-requisites 
 

Before proceeding, check the following: 
 

Check Detail 

Data is backed up  Check with the system administrator that all HOPEX 

environment have been backed up (physical backup). 
Archive key configuration file of IIS application related to 

HOPEX (file web.config) and HOPEX installation (Megasite.ini). 

Check that all customizations have been backed up (physical 
backup). 

Password of the login 'System'  For each HOPEX environment, check that the password of the 

login 'System' is known or set to empty before migration. 
 This is very important since it will be requested to login with 

'System'. 

All IIS web sites related to HOPEX 
are stopped 

For the machine running HOPEX, Run 'Internet Information 
Services (IIS) Manager': 

Check that All IIS web sites related to HOPEX are stopped. 

All Windows services related to 

HOPEX are disabled 

For the machine running SSP, in Control Panel, Administrative 

Tools, Services: 
Check if that all services with name beginning with 'HOPEX' are 

set to 'Disabled'. Ex: 
HOPEX Site Service Provider 

HOPEX Service Watchdog 

No processes related to HOPEX is 
running 

For the machine running HOPEX, in Windows Task Manager: 
Check if a process mgw*.exe is running. If a process persists, 

end it. 
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3.2. Upgrade environment with Oracle or SQL Server storage 
 

In the procedure, various warning messages will be displayed. Most of them will be ignored. 
If a message is displayed that is not quoted in the procedure, see the FAQs section of this document. 
 

Procedure in version HOPEX V2R1: 

 
1. Start the Windows Administration Console (Administration.exe). 

2. Reference the environment to be converted. 
3. Select the environment. 

A warning is displayed: You cannot access repository "SystemDb". Its internal structure is not 

up to date. A technical conversion is necessary. Click "OK" to run it. Once updated, your 
repository will no more be accessible by older version of Mega. 

• Click Cancel to hide the warning and avoid conversion (it will be done later). 
4. Select the environment and R click > Perform SQL conversion on the repository. 

A window 'MEGA RDBMS Technical Conversion' is displayed. 
• Click OK to trigger technical conversion of the SystemDb repository. 

• Wait until the conversion is over. Duration can vary according to various parameters 
(source and target versions, size of system database, infrastructure performances). It can 

last from few minutes (average time) to one hour. 

A line 'Technical conversion completed' is displayed'. 
• Click 'Close'. 

5. Select and open the environment to be upgraded with the login System. 
A warning can be displayed: Your environment and site are not of the same version. Your 

environment requires updating. Refer to documentation for how to carry out this action. 

• Click OK to hide the warning. 

A warning can be displayed for each data repository: You cannot access repository "XXX". Its 
internal structure is not up to date… 

• Click 'OK' to hide the warning (it will be done later). 

A Message is displayed: Your environment requires an update for compatibility with your 
version of HOPEX. Do you wish to run this procedure now? 

• Click Yes to trigger the environment upgrade. 
A first wizard Automatic Update is displayed. 

 
Example for a source environment in version HOPEX V2 

 
 

• Verify that the major version identified for the environment is correct (HOPEX V1R3 or 
HOPEX V2), read the text, check the option I have taken note of the above text and 

click OK. 
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A first upgrade processing is run. Duration can vary according to various parameters 

(source and target versions, size of system database, infrastructure performances). It 
usually lasts more than 30 min. 

Then, a second wizard Environment updating center - Welcome is displayed. 
 

 
 

• Read the text, check the option I have taken note of the above text and click Next. 

A list of actions is displayed. It is recommended to keep them checked. 

• Click Run to start the update. Duration can vary according to various parameters (source 
and target versions, infrastructure performances, size and number of repositories). It 

usually lasts about 20 min with one data repository.  
A list of reports is displayed (one tab for each action). 

• Review reports and click Close to exit the wizard. 
• Close the environment. 

• Exit the Administration Console. 
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3.3. Upgrade environment with GBMS Storage 
 

Procedure in version HOPEX V2R1: 
 

1. Start the Windows Administration Console (Administration.exe). 
2. Reference the environment to be converted. 

3. Select and open the environment to be upgraded with the login System. 

A warning is displayed: Your environment and site are not of the same version. Your 
environment requires updating. Refer to documentation for how to carry out this action. 

• Click 'OK' 
A Message is displayed: Your environment requires an update for compatibility with your 

version of HOPEX. Do you wish to run this procedure now? 
• Click 'Yes'. 

A first wizard Automatic Update is displayed. 
 

Example for a source environment in version HOPEX V2 

 
 
• Verify that the major version identified for the environment is correct (HOPEX V1R3 or 

HOPEX V2), read the text, check the option I have taken note of the above text and 
click OK. 

A first upgrade processing is run. Duration can vary according to various parameters 
(source and target versions, size of system database, infrastructure performances). It 

usually lasts more than 30 min. 
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Then, a second wizard Environment updating center - Welcome is displayed. 

 

 
 

• Read the text, check the option I have taken note of the above text and click Next. 
A list of actions is displayed. It is recommended to keep them checked. 

• Click Run to start the update. Duration can vary according to various parameters (source 
and target versions, infrastructure performances, size and number of repositories). It 

usually lasts about 20 min with one data repository.  

A list of reports is displayed (one tab for each action). 
• Review reports and click Close to exit the wizard. 

• Close the environment. 
• Exit the Administration Console. 
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3.4. Update stored procedures with Oracle or SQL Server storage 
 

This step is mandatory for each data repository or system database using RDBMS storage (Oracle, 
SQL Server). The code of existing stored procedures (created in a previous version) needs to be 

initialized with the HOPEX V2R1. 
 

Pre-requisite: 

• Permissions to delete and create stored procedures 
 

Procedure: 
 

1. Start the Windows Administration Console (Administration.exe). 
2. Select and open the environment with the login System. 

3. Select the folder 'Repositories' and R click > Manage. 
A window 'Manage repositories' is displayed 

• In the 'Repository list', check all repositories including 'SystemDb' 

• In the 'Action list', check 
o Remove private workspace temporary data 

o Shrink unused repository historical data 
• Click 'Execute and wait until the conversion is over. 

• Click 'Cancel' to exit the window 'Manage repositories'. 
4. Close the environment.  

5. Exit the Windows Administration Console.  
 

Note that it is important that the execution of all stored procedures is scheduled (batch). Refer to the 

document 'RDBMS Repository Installation guide HOPEX V2R1' to get the complete list. 
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4. COMPLETE UPGRADE OF DATA 

4.1. Re-import solutions packs 
If you did not use solution packs, you can skip this section. 

 
Otherwise, solutions packs (identified before migration) need to be imported again in HOPEX V2R1. 

Note that certain solution packs do not exist any longer: 
 

Executable Comment 

Audit.exe Solution Pack provided in HOPEX V1R2-V1R3 for HOPEX Internal Audit. 

Not used with HOPEX V2R1. 

Compliance.exe Solution Pack provided in HOPEX V1R2-V1R3 for HOPEX Regulatory 

Compliance. Not used with HOPEX V2R1. 

ERM.exe Solution Pack provided in HOPEX V1R2-V1R3 for HOPEX Enterprise Risk 
Management. Not used with HOPEX V2R1. 

ICM.exe Solution Pack provided in HOPEX V1R2-V1R3 for HOPEX Internal Control. 

Not used with HOPEX V2R1. 

ITGRC.exe Solution Pack provided in HOPEX V1R2-V1R3 for HOPEX IT Risk 
Management. Not used with HOPEX V2R1. 

ITPM.exe Solution Pack provided in HOPEX V1R2-V1R3 for HOPEX IT Portfolio 

Management. Not used with HOPEX V2R1. 

 

For each HOPEX environment, re-install each solution pack using the standard procedure. 
 

Pre-requisite: 
For each solution pack 

In the HOPEX installation: 
• Browse the folder \Utilities\Solution Pack 

• Uncompress the .exe related to the appropriate framework  
ex: DoDAF.exe for Solution Pack 'DODAF' 

 

Procedure: 
 

In HOPEX installation: 
• Start the Windows Administration Console (Administration.exe) 

• Select and open the environment. 
• Select the appropriate repository. 

• R click > Object Management > Import Solution Pack 
• For each solution pack 

o Select the appropriate framework and click 'OK' 

wait until the process is completed 
• Close the environment. 

• Exit the Windows Administration Console. 
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4.2. Set a value for 'Definition of path of MetaAssociation' 
Once a decision has been made (see section Decide 'Definition of path of MetaAssociation' sooner in 

the document), it must be implemented. 
 

For each HOPEX environment: 
1. Start the Windows Administration Console (Administration.exe). 

2. Select and open the environment with the appropriate login (ex: system). 

3. Select the environment 
4. R click > Options > Modify 

A list of options is displayed. 

• In the left tree, select the folder Repository 

• In the right pane, select a value for Definition of path of MetaAssociation according to the decision 

made. 

5. Exit Administration Console 

4.3. Review command line parameters 
A property 'Command Line' is available at two levels: 

• In properties of profile objects 

• In properties of login objects (login objects are created when converting user objects) 
 

If a string is set and contains codes that are not available for HOPEX V2R1 (ex: code 'PRO'), it will not 

be considered. No error should be displayed to screen but in the error logfile. It is therefore 
recommended to review command line parameters and remove codes that are not available for HOPEX 

V2. 
 

Before removal After removal 

/RW'PRO,DMO' /RW'DMO' 

 

To identify the objects to be updated, you can run the following queries: 
 

Object Type Example of query for the code 'PRO' 

Login Select [Login] Where [Command Line] Like '#PRO#' 

Profile Select [Profile] Where [Command Line] Like '#PRO#' 

 
You can get a list of codes not available for HOPEX V2R1 in MEGA Community, KB 00004513: 

http://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=501D00000012hECIAY 
  

http://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=501D00000012hECIAY
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4.4. Check format of report templates (MS Word) 
 
By default, with HOPEX V2R1, 

• Standard report templates (MS Word) are installed in the format RTF. 
• Generation mode is RTF (with conversion to DOCX). 

 

According to your decision (see the section 'Decide format of report templates (MS Word)' sooner in 
this document), you need to do the following: 

 

Decision Custom report 
templates (MS Word) 

Actions required 

Keep format RTF No None 

Keep format RTF Yes Convert custom report templates (MS Word) to 

format RTF. 

Switch back to format 

MS word 

- Configure MS Word generation mode for each 

HOPEX environment. 

Convert custom report templates (MS Word) to format RTF 

Standard report templates (MS Word) are natively provided in the format RTF. 

Custom report templates (MS Word) need to be converted if: 

• Project decision is to keep format RTF 
• They have not yet been converted to format RTF. 

 
Pre-requisites: 

 
Use a machine where 

• HOPEX V2R1 is installed. 
• MS Word is installed (version Office 2010/2013/2016, 32-bit version only). 

• HOPEX environment to be converted are available (update file permissions). 

• Verify that no process WINWORD.EXE is running. 
 

Procedure: 
 

For each HOPEX environment: 
6. Start the Windows Administration Console (Administration.exe). 

7. Select and open the environment with the appropriate login (ex: system). 
8. In the folder 'Repositories', select 'Systemdb'. 

9. R click > Conversions > Utilities: 

A list of conversions is displayed. 
10. Check 'MEGA Repository - Convert Report Templates (MS Word) to RTF format'. 

Wait until the processing is finished. 
11. Exit Administration Console 

 
Result: 

 
For the HOPEX environment 

• Each report template (MS word) is saved in the RTF format in the system database. 

• Each RTF style sheet used by a report template (MS Word) is duplicated and converted to the 
RTF format. The duplicate has the .RTF file extension and is saved in the folder 'Mega_usr' of 

the HOPEX environment. 
It is recommended to verify in the error logfile (megaerrYYYYMMDD.txt) that each report template 

(MS word) has been converted without error. 
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Configure MS Word generation mode for each HOPEX environment 

Procedure: 

 
For each HOPEX environment: 

• Manually edit the file Megaenv.ini with a text editor 
• Check that the following lines are present 

[Office] 
DocumentFormat=20 

• Save the file. 
 

Result: 

 
For each HOPEX environment configured, generation mode is MS Word (.doc extension). 
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4.5. Restore web settings 
 
If you need to restore this information when migrating from HOPEX V1R3 or HOPEX V2 to HOPEX 

V2R1, restore (file copy) the file MegaSettings-*.ini on the server hosting the target installation 
(HOPEX V2R1). With HOPEX V2R1, such files are expected in the folder: 

%ProgramData%\MEGA\HOPEX V2R1\ClusterRoot\UserSettings 
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5. CHECK UPGRADED DATA 

It is highly recommended to back up each environment once it has been upgraded. 

 
The standard installation and upgrading process takes care of all the conversions that can be 

automated. Technically speaking, conversion success is guaranteed by: 
• The correct execution of the environment automatic upgrade processing. 

If errors are met at this step, the migration process must be stopped so that a diagnosis is 
made. Check carefully the Mega error log. 

• The correct execution of all mandatory conversions for the system database. 
If errors are met at this step, the migration process must be stopped so that a diagnosis is 

made. 

• The correct execution of all mandatory conversions for each data repository. 
If errors are met at this step, the migration process must be stopped so that a diagnosis is 

made. 
 

After complete execution of the migration process, it is highly recommended to check data and 
customizations through: 

• First control of migration: run a quick tour to check that data looks correct. 
• Check of data consistency: run utilities to enforce rules regarding data structure. 

• Other checking indications.  

5.1. First control of migration 
It is highly recommended to run a quick tour and check that upgraded data looks correct. Of course, 
this kind of check cannot be exhaustive, but it usually enables to have a first feedback and quickly 

identify certain migration issues. 
 

Example of scenario: 
• Open a private workspace (ex-transaction). 

• Browse through objects using query tools, navigation trees and diagrams. 
• Perform insignificant updates (ex: change a character in a comment value, slightly move an 

object in a diagram...). 

• Dispatch private workspace. 

5.2. Check data modelling consistency 
In previous versions, many things were tolerated, although not recommended. In order to ensure 

better consistency, there is a need for a thorough review of the repository content and, potentially, 
some cleaning and tidying tasks to perform. This should be considered as a separate project. 
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5.3. Other checking indications 
If extensions were made to the metamodel, they must be reviewed regarding the structuring rules 

described above. A particular attention must be paid to the orientation of MetaAssociations as it 
governs the behaviors of the related objects. 

 
If customizations have been made (property pages layer, diagram configuration layer, templates, 

programs based on script APIs…), a specific check is required based on initial customization 

specifications. As customizations are often based upon standard layers, they may not be ready to use 
and they may have a different look and feel. This check requires functional and platform development 

skills. 
 

Topic Comment 

Creation tool The implementation has changed (HOPEX V2R1). 

A tool converting custom creation tool to the new format in provided. 
It is mandatory to review declarative creation tools (MetaWizard, Category 

Specification/_Kindprovider) and coded tool (java..) 

Person assignment The implementation has changed (HOPEX V1R3). 

A tool converting user and assignments to the new format is provided. 
It is mandatory to review the user configuration (connection parameters, 

administrator privilege) unless a review was already performed in HOPEX V2. 
Note that with HOPEX, it is recommended to set options and command line 

at profile level. 

Profiles The features 'Metamodel access management' and 'Metamodel filter' (MEGA 
2009 SP5) are replaced with a management of permission. 

A tool converting profiles to the new format is provided. 

It is mandatory to review the profile configuration unless a review was 
already performed in HOPEX V2. This review should be based on initial 

functional specifications. Note that profiles are renamed if the  

Workflows Configuration and implementation has evolved significantly between MEGA 
2009 and HOPEX V2 and to a lesser extent between HOPEX V1R2-V1R3 and 

HOPEX V2. Tools converting definition of workflows to the new format is 
provided. It also converts data related to workflow. It is recommended to 

review the workflow configuration if workflows have been customized. This 

review should be based on based on initial functional specifications. Note that 
the change to profile assignment can impact customization performed in 

HOPEX V1R2-V1R3. 

API script The metamodel has changed. 
No tool can be provided for specific code. No detailed indication is provided. 

It is recommended to review the customized macros and applications using 
API script in particular for Administration APIs. This review should be based 

on initial functional specifications. Note that creation of threads in java code 
is not supported.  

Authentication A new authentication framework called UAS is available. 
It is compatible with basic authentication and its 3 implementations (MEGA, 

LDAP, Windows). 
Fully customized authentication provider can work provided custom code is 

installed and called by configuration. 
Windows authentication based on sample delegatedlogin_windows.aspx.cs is 

no longer supported. Standard UAS provider for Windows Authentication 
must be used. Login data need reprocessing. See KB 00007532 in MEGA 

Community. 

 

The above list is not exhaustive. 
 



How to migrate to HOPEX V2R1 page 21/31 C0 - PUBLIC 

 
 

6. APPENDIX 

6.1. Conversion details 
 

If mandatory conversions are not made on repositories, malfunction or loss of data can occur. 

Repositories need to be converted only once. 
 

Select a repository, right-click 'Conversions > Convert data into current version' then select the source 
version 'From HOPEX V1R2 data' to display conversions. 

 

Conversions Scope Mandatory if 
upgrade from 
HOPEX V1R3 

Mandatory if 
upgrade from 
HOPEX V2 

Mapping - Performances  

This tool deletes repository log related to mapping item. It 
also disables repository log for the MetaClass 'Mapping 

Item' 
This tool is implemented by a VB script macro 

~ie(ICrKeJf1K[Mapping – Performances.Method] 

Data Yes 

KB 00004883 

Yes 

KB 00004883 

MEGA Repository - Add 'Substitutable' option to 
Report DataSet Properties 

Update existing Report DataSet objects to better control 

property display 
This tool is implemented by a macro 

(~kQoLRZ50Pb87[Mega Repository - Add 'Substitutable' 
option to Report DataSet Properties.Method]) and can be 

customized 

Data Yes 
KB 00007470 

 

Yes 
KB 00007470 

 

MEGA Repository - Alignment of Profile's name with 
Business Role's name 

This tools renames each profile according to the related 
Business Role (Ex: EA standard is renamed to Enterprise 

Architect). 

This tool is implemented in C++ and cannot be 
customized. 

SystemD
b 

Yes 
KB 00006394 

No 

'MEGA Repository - Conversion of Assessment 

(Location of Assessment Deployment Query 
Parameter Value) 

Converts location of objects of MetaClass 'Assessment 
Deployment Query Parameter Value' from system to data 

It applies only if assessment templates have been 

customized 
This tool is implemented by a macro and can be 

customized 

Data No If custom 

template 
KB 00007540 

MEGA Repository - Conversion of Assessment 
Template Definition 

This tool converts the objects of the MetaClass Scoring 
Rule to the new format.  

This tool is implemented by a VB script macro 
~dY(lkwG(ITj8[MEGA Repository - Conversion of 

Assessment Template Definition.Impl] 

Data Yes 
KB 00004592 

No 

MEGA Repository - Conversion of Assessment 

Template Location (Data to System) 
This utility converts Assessment Template to the new 

format. Location is transferred from data repository to 
system database 

Data Yes. 

KB 00006063 

No 
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Conversions Scope Mandatory if 
upgrade from 
HOPEX V1R3 

Mandatory if 
upgrade from 
HOPEX V2 

Before HOPEX V2 Assessment templates are saved in data 
repository After HOPEX V2 Assessment templates are 

saved in systemdb 
This tool is implemented by a VB script macro 

~0wxXvkv(M1YT[MEGA Repository - Conversion of 

Assessment Template Location (Data to System)] 

MEGA Repository - Conversion of assignments 
This tool creates a Profile Assignment for each Profile that 

were assigned to a user through a Business Role. 
It applies to environments using Business Role assignment 

in previous versions.  
This tool is implemented by a VB script macro 

~h5mc1AgWM16T[AssignmentConvert.Method] 

Data Yes 
KB 00006314 

No 

MEGA Repository - Conversion of assignments 

(Profile mode) 
This tool creates a Profile Assignment for each Profile that 

were assigned to a user. 
If the access was implicit, an additional assignment is 

created for all repositories. 
The target environment must be in Profile mode (option  

Assignment of profiles (Management of assignment of 
business roles to person) checked). 

This tool is implemented by a VB script macro 

~Drs0)XWiMbUP[MEGA Repository - Conversion of 
assignments (Profile mode).Method] 

SystemD

b 

Yes 

KB 00006315 

No 

MEGA Repository - Conversion of Business 

Documents or System Business Document 

This tool converts Business Document and System 

Business Document to the new format. Storage changes 
from disk (.DAT files) to database instance 

This tool is implemented in C++ and cannot be customized 

Data 

SystemD
b 

Yes 

KB 00006228 

No 

MEGA Repository - Conversion of Deprecated 

MetaAssociation instances to Generic 
MetaAssociation instances 

This tool updates the metamodel to enable a generic 
management of certain MetaAssociations (Note, 

Document, ...). 
This tool is implemented in C++ and cannot be customized 

Data 

SystemD
b 

Yes 

KB 00006311 

Yes 

KB 00006311 

MEGA Repository - Conversion of Deprecated 

MetaAssociationType to Operator 

This tool recovers behaviors associated with deprecated 
MetaAssociation Types 

The tool is implemented by a macro 
~W1X0aNWdMPs2[convert_deprecated_MetaAssociationT

ype_to_Operator] 

SystemD

b 

Yes 

KB 00006317 

No 

MEGA Repository - Conversion of diagram type 
(described element) 

This tool converts Diagram Types to the new format. The 
generic MetaClass Described Element (or System 

Described Element) is used to handle the described object. 

This tool is implemented by a VB script macro 
~piLGI9rCNfnJ[_MEGA Repository - Conversion of diagram 

type (described element)] 

SystemD
b 

Yes 
KB 00006316 

No 

MEGA Repository - Conversion of ITPM Assessment 
Updates storage of application assessment to avoid 

useless computation. 

Data Yes 
KB 00007460 

 

Yes 
KB 00007460 

 



How to migrate to HOPEX V2R1 page 23/31 C0 - PUBLIC 

 
 

Conversions Scope Mandatory if 
upgrade from 
HOPEX V1R3 

Mandatory if 
upgrade from 
HOPEX V2 

This tool is implemented by a macro 
(~YfgIXwaKPHD0[MEGA Repository - Conversion of ITPM 

Assessment]) and can be customized 

MEGA Repository - Conversion of ITPM Initiatives to 

PPM Projects 
Converts the former ITPM transformation portfolio 

initiatives into new PPM project portfolio lines. 
 This tool is implemented by a macro 

(~qrr9qL35P5NQ[MEGA Repository - Conversion of ITPM 
Initiatives to PPM Projects.Macro]) and can be customized 

Data Yes 

KB 00007464 

Yes 

KB 00007464 

MEGA Repository - Conversion of Mapping links 

Converts possible customization of mapping to the new 
format. 

This tool is implemented by a macro 

(~H8rvwXEWOTqL[_MEGA Repository - Conversion of 
Mapping links.Method]) and can be customized 

SystemD

b 

Yes 

KB 00007280 
 

Yes 

KB 00007280 
 

MEGA Repository - Conversion of name properties 

This tools aligns object names with metamodel definition 
Conversion may take a significant time depending on the 

volume of data. 
This tool is implemented in C++ and cannot be 

customized. 

Data 

SystemD
b 

Yes 

KB 00001289 

Yes 

KB 00001289 

MEGA Repository - Conversion of Notification 

<Notification From> MetaAttribute 
Converts notification objects to the new format. 

This tool is implemented by a macro 
(~qtTiDHWSPLJ5[MEGA Repository - Conversion of 

Notification <Notification From> MetaAttribute.Method]) 
and can be customized 

Data Yes 

KB 00007474 

Yes 

KB 00007474 

MEGA Repository - Conversion of old 

MetaAssociation into deprecated MetaAssociation 

This tool tags old MetaAssociations as deprecated. 
This tool is implemented by an external script 

'convert_deprecated_metaassociation.vbs' 

SystemD

b 

Yes 

KB 00004238 

Yes 

KB 00004238 

MEGA Repository - Conversion of Posts to Review 
Notes 

Converts posts (MetaClass Post, removed) to review 
notes. Attention: new objects are created every time the 

conversion it run 
This tool is implemented by a macro 

(~2b5nOh0pOrW4[Collaboration - Post Conversion]) and 

can be customized 

Data Yes  
KB 00007468 

Yes 
KB 00007468 

MEGA Repository - Conversion of Restricted 
MetaAssociation into Abstract MetaAssociation 

Converts restrictive MetaAssociation to the new format  
When specific MetaAssociations were made restrictive, 

parent MetaAssociations will be declared Abstract. 

SystemD
b 

Yes 
KB 00007462 

Yes 
KB 00007462 

MEGA Repository - Conversion of Restrictive 
MetaAssociation instances to Concrete 

MetaAssociation instances 

This tool updates the metamodel to move down restricted 
MetaAssociation instances storage on their concrete 

MetaAssociation. 
This tool is implemented in C++ and cannot be 

customized. 

Data 
SystemD

b 

Yes 
KB 00006309 

Yes 
KB 00006309 
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Conversions Scope Mandatory if 
upgrade from 
HOPEX V1R3 

Mandatory if 
upgrade from 
HOPEX V2 

MEGA Repository - Conversion of tree folder menu 
This tool recovers menu items 'New' and/or 'Connect' on folders in tree 

This tool is implemented by a VB script macro 
~(2H4f8nGNTOG[Convert_treefolder_menuitems] 

SystemD
b 

Yes 
KB 00006330 

No 

MEGA Repository - Conversion of Where Used 

Queries 

This tool converts the format of a configuration regarding 
Diagrams containing object. From HOPEX V1R2 CP1.0, 

queries are connected directly to the MetaClass. 
This tool is implemented by a macro calling a VBS script 

file (convert_where_used_queries.vbs). 

SystemD

b 

No 

KB 00004829 

No 

 

MEGA Repository - Conversion of Working 
Environment Template Group with desktops 

It is no longer possible to connect Desktop to a Working 
Environment Group Template 

This conversion converts to the new format Working 

Environment Group Template 
This tool is implemented by a VB script macro 

(Macro ~x2CwVr)YQDwB[ConvertWETGroupDesktopToCo
mmands.Method]) and can be customized 

SystemD
b 

No Yes 
KB  

MEGA Repository - Conversion of Working 

Environment Template Profile Assignments 
This conversion enables to convert Desktop objects into 

desktop manager for each concerned Working 

Environment Template Profile Assignment. 
This enables to load the appropriate Desktop for client 

device. 
This tool is implemented by a VB script macro 

(~53bgJIhXQH88[MEGA Repository - Conversion of 
Working Environment Template Profile 

Assignments.Method] ) and can be customized 

SystemD

b 

No Optional 

To run HOPEX 
Explorer (V2) 

on a tablet 

device 
KB 00007744 

MEGA Repository - Conversion of Working 
Environment Templates 

This conversion enables to define several Working 

Environment template with different desktops. 
This tool is implemented by a macro 

(~24cD8qJKP5qE[MEGA Repository - Conversion of 
Working Environment Templates.Method]) and can be 

customized 

SystemD
b 

Yes 
KB 00007475 

 

Yes 
KB 00007475 

 

MEGA Repository - Convert Property Page Link/Tree 
to PropertyPageExtension 

This utility converts property page implementation from 

_PropertyPageLink to _PropertyPageExtension. It is 
recommended to run this utility to benefit from new 

customization capabilities 
This tool is implemented by a VB script macro 

~zTupdajIIrbB[MEGA Repository - Convert Property Page 
Link/Tree to PropertyPageExtension] 

SystemD
b 

Yes 
KB 00004586 

No 

MEGA Repository - Repair Building Block 

Containment 
Creates connections between building block (ex: library) 

and building block annotation (ex: report) for compliance 

with EA grid 
This tool is implemented by a VB script macro 

(~JkZBYfprP9EV[MEGA Repository -  Repair Building Block 
Containment]) a macro and can be customized 

Data Yes 

KB 00007484 

Yes 

KB 00007484 
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Conversions Scope Mandatory if 
upgrade from 
HOPEX V1R3 

Mandatory if 
upgrade from 
HOPEX V2 

MEGA Repository - Update initial foundation : 'MEGA 
Library' 

Imports mandatory data to the data repository 
This conversion is coded in C++ and can not be customized 

by a script (convert_update_initial_foundation.vbs) and 

can be customized 

Data Yes 
00003025 

Yes 
KB 00003025 

MEGA Repository - Update Setting for Building Block 
Role extention metaclasses 

Updates custom creation tools. 
This tool is implemented by a VB script macro by a macro 

(MEGA Repository - Update Setting for Building Block Role 
extention metaclasses.Method) and can be customized 

SystemD
db 

Yes. 
KB 00007483 

Yes. 
KB 00007483 

MEGA Teamwork - Conversion of workflow instance 

This tool changes the location of workflow instance from 

system database to data repository. 
This tool is implemented by a VB script macro 

(~5m5flWg5KPfB[Mega TeamWork - Conversion of 
Workflow Instance System.Method]) and can be 

customized 

Data Yes 

KB 00005096 

No 
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6.2. Utilities details 
 

Utility Scope Comment 

Diagram (drawings) 

This tool opens, saves and closes all diagrams in the repository. Enables 
conversion of diagrams with drawings in MGE format. Also enables to 

check the status all diagrams in a repository.  

This execution is optional for the system database and data repositories. 
Conversion may take a significant time depending on the volume of data. 

This tool is implemented in C++ and cannot be customized. 

Data 

SystemDb 

Optional 

KB 00001270 

HITA - Convert Software Technology Fulfillments to Technical 
Capabilities 

This conversion converst the Business Capability Fulfillment or 
Functionality that could exist between Software technology objects and 

Business Capability objects to the new format. 

This tool is implemented by a macro (~1Ov92q21QHtG[HITA - Convert 
Software Technology Fulfillments to Technical Capabilities]) and can be 

customized 

Data Optional 
KB 00007770 

HOPEX ITPM -Conversion of Standards 
This tool converts certain objects of the Metaclass 'Standard' to objects 

of the MetaClass 'Technology'. Selection is made using the query 
'~5yCf7ugkIr9D[APM - Conversion - Get Standards Linked to Vendors Or 

Application Deployed]' 
This tool is implemented by a VB script macro ~2yCfd0hkITND[APM - 

Conversion of Standards] 

Data Optional 
KB 00004589 

MEGA Repository - Business Function to Business Functional Area 

Converts a Business Functions Hierarchy from Process or BPA solution to 
Business Architecture's Business Functional Area composite structure 

models. 
Useful to migrate data created with MEGA Process (code PRO) and/or 

MEGA Process BPMN Edition (code PMN) to the solution Business 
Architecture (code HBAS) 

This tool is implemented by a macro (~18VF)i4hNf)I[MEGA Repository - 

City planning areas to Business Capabilities.Method]) and can be 
customized 

Data Optional 

KB 00007465 
 

MEGA Repository - City planning areas to Business Capabilities 

Convert City Plans to Business Capability Maps and City Plan Areas to 
Business Capability objects. 

Useful to migrate data for the solution IT Portfolio Management (Code 
APM). 

This tool is implemented by a macro (~18VF)i4hNf)I[MEGA Repository - 
City planning areas to Business Capabilities.Method]) and can be 

customized 

Data KB 00007191 

Optional 
 

MEGA Repository - Cleanup 

This tool removes technical temporary data left invalid in repositories 
after upgrade (ex: recent queries). 

This tool is implemented by a VB script macro ~W7qD9X3HCT50[MEGA 
Repository - Cleanup.Method] 

Data Optional 

KB 00003321 

MEGA Repository - Conversion of EA Projects to PPM projects 

Converts EA Project (former MetaClass Project renamed to EA Project) 
to PPM project (new MetaClass Project) and Project scope to Project 

Deliverables, when applicable 

Useful with option Product Portfolio Management (code PPM) and a 
compatible solution (ex IT Portfolio Management...) 

This tool is implemented by a macro (~6qr9AW25PntP[Mega Repository 
- Conversion of EA Project.Method]) and can be customized 

Data Optional 

KB 00007466 
 

MEGA Repository - Conversion of ITPM Applications Exchanges 

(ARC -> HITA) 

Data Optional 

KB 00007461 
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Utility Scope Comment 

Converts the description of application exchanges (based on message 
flows) to the new format used with IT Architecture (code HITA) 

Useful with solution IT Portfolio Management (Code APM) and new 
solution IT Architecture (code HITA) 

This tool is implemented by a macro (~ougT5TtIP1eB[HOPEX ITPM - 
Conversion of Applications Exchanges (ARC -> HITA)]) and can be 

customized 

 

MEGA Repository - Conversion of name properties (long name) 

This tool aligns object names with metamodel definition (long name) for 
certain MetaClasses. 

Conversion may take a significant time depending on the volume of data. 
This tool is implemented in C++ and cannot be customized. 

Data Optional 

KB 00001892 

MEGA Repository - Conversion of Notes to Review Notes 

Creates review notes from notes 
This tool is implemented by a macro (~sa5nwd0pO5U4[Collaboration - 

Note Conversion]) and can be customized 

Data Optional 

KB 00007469 
 

MEGA Repository - Conversion of Organizational Charts 

This utility converts the nature of Organizational Chart diagrams so that 
they can be open with MEGA Process BPMN Edition. 

This tool is implemented by a VB script macro 
~YgaCFMJSGPv2[Organisational Chart Conversion] and can be 

customized 

Data Optional 

KB 00003984 
 

MEGA Repository - Conversion of Specific Name of Dictionary 
Object to Term 

This conversion updates objects based on terms to the new format in 

case name has been customized 
This tool is implemented by a VB script macro (~ltqQKs6TQLoG[Mega 

Repository - Conversion of Specific Name of Dictionary Object to 
Term.Implementation]) and can be customized 

Data Optional 
KB 00007723 

MEGA Repository - Conversion of widgets 

Converts dashboard widgets to a new format (independant from 
container of web desktop) 

To keep widgets used in previous versions, a prerequisite to this 

conversion is to restore web settings. 
This tool is implemented by a VB script macro 

~DcdsKyj4QDAE[WidgetConversion.Method] and can be customized 

SystemDb Optional  

KB 00007569 

MEGA Repository - Convert participants of projects 
This tools converts participants of projects to the new format 

This tool is implemented by a VB script macro ~MKy3t2XCNf7U[Convert 
participants of projects.Method] 

Data Optional 
KB 00006308 

MEGA Repository - Convert Report templates (MS Word) to RTF 

Format 

This tool converts Report templates (MS Word) from Word to RTF format. 
This is required to generate documents with HOPEX Web Front-end. 

This tool is implemented in C++ and cannot be customized. 
Note that MS Word is required on the machine running the 

conversion. 

SystemDb Optional 
Recommended 

If custom 

template and 
decision to 

user format 

RTF. 
KB 00003499 

MEGA Repository - Creation of links instances from MEGA fields 

This tool creates impact analysis links for objects referenced by object 
references (MEGA fields) in texts properties. 

Conversion may take a significant time depending on the volume of data. 
This tool is implemented in C++ and cannot be customized. 

Data 

SystemDb 

Optional 

KB 00002005 

MEGA Repository - Objectives -> Enterprise Objective Conversion 

Creates Enterprise Objective from Objectives 

Useful to migrate data from Business Strategy (code MBS) to Business 
Architecture (Code HBAS) 

Data Optional 

KB 00007463 
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Utility Scope Comment 

This tool is implemented by a macro (~ueHLXNrMP1sV[Objectives -> 
Enterprise Objective Converstion.Method]) and can be customized 

Shapes 

This tool updates customized shapes to the most recent format. 
Shapes located in the folder 'Mega_usr' or both installation and HOPEX 

environment are upgraded. This conversion is optional for the System 

repositories. 
This tool is implemented in C++ and cannot be customized. 

SystemDb Optional 

KB 00000362 
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7. FAQS 

7.1.1. Warning 'You cannot access repository "XXX". Its internal structure is not 

up to date… 
With specific version upgrades, the technical format of the repository can change. As explained, you 
need to run a menu (Perform SQL conversion on the repository) from the Administration Console. See 

earlier in this document. 
 

 
 

7.1.2. Warning 'Your environment and site are not of the same version. Your 

environment requires updating…' 
This warning report that the system database is not up to date. This occurs if the programs have been 

updated and the environment has not/not yet been updated. 
 

 
 

7.1.3. Warning 'The version of the stored procedure XX is not OK…' 
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With specific version upgrades, the technical format of the repository can change, and stored 

procedures need to be reinitialized. See the section 'Update stored procedures' earlier in this 
document. 

 

7.1.4. Warning 'To perform this action, the minimum version required for you 

environment is HOPEX V2R1 Update2…' 
This warning explain that the menu item Environment automatic update cannot be run given the 

version of the environment. Instead, select SystemDb and R click on Conversions > System 
Repository Update > Apply. 

 

 
 

7.1.5. Warning 'Writing access diagram is not compiled…' 
 

 
 

Certain actions can leave the writing access diagram (ex-User diagram/Authorization diagram) is in a 
state not compiled. 

 
To compile the metamodel of the environment:  

1. Start the Windows Administration Console (Administration.exe). 
2. Select and open the environment to be converted with the login System. 

3. Select the folder 'User management' 

4. R click > Compile writing access diagram 
5. Click Start to trigger the compilation 

Wait until the processing is complete. 
6. Click 'Close' 

7. Exit the Windows Administration Console 
 

7.1.6. How to run a specific conversion or utility? 

It is now recommended to use the update wizard instead of triggering explicitly conversions. 
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Before proceeding, you can consult the table 'Conversion details' in this document to understand if 

conversions are relevant in your context. This can be useful to save time for large repositories. 
Otherwise, it is recommended to keep conversions checked by default.  

 
Procedure: 

 
1. Start the Windows Administration Console (Administration.exe). 

2. Select and open the environment to be converted with the login System. 

In the folder 'Repositories', select 'SystemDb' 
• R click > Conversions > Convert data into current version and select From HOPEX 

V1R3 data or from HOPEX V2 data according to the source version. 
• Check the appropriate conversions. 

See the table 'Conversion details', later in this document  
• Click 'OK' to trigger the conversion 

Wait until the conversion is complete 
• Close the environment 

3. Select and open the environment to be converted with the login System 

In the folder 'Repositories', select a data repository 
• R click > Conversions > Convert data into current version and select From HOPEX 

V1R3 data or from HOPEX V2 data according to the source version. 
• Check the appropriate conversions. 

See the table 'Conversion details', later in this document. 
• In the right bottom, check 'Apply to all repositories of the environment'. 

The selected conversions will be applied to all data repositories. 
• Click 'OK' to trigger the conversion. 

Wait until the conversion is complete. 

• Close the environment. 
4. Exit the Windows Administration Console. 
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Summary 

 

This document describes the procedures necessary to install updates starting from HOPEX V2R1 Update 3. 

It applies to Update 3 except for solution HOPEX GDPR: see document 'How to install update HOPEX V2R1 

Update 3 GDPR EN'. 

It does not apply when installing Update 1 or Update 2. 

 

An update is a specific update package providing fixes and improvements. 

 

It applies to all front-ends: 

• Web front-end 

• Windows Front-end 

 

It does not describe: 

• System requirements and possible architectures (see architecture overview documentation). 

• How to install a product release (see installation documentation). 

• How to manage installations (see administrator manuals). 

• How products are licensed (see licensing documentation). 

• How to use features (see user manuals). 

 

Note that from HOPEX V2R1 Update 2, the component Microsoft URL Rewrite Module 2.0 is required. 

1. FOREWORD ............................................................................................................................. 3 
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2. UPGRADING HOPEX PROGRAMS.............................................................................................. 3 
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2.2. Upgrading Windows Front-end ..................................................................................................... 6 

3. UPGRADING HOPEX DATA ....................................................................................................... 7 

3.1. Upgrade HOPEX environments ..................................................................................................... 7 

3.2. Check Upgraded Data ................................................................................................................. 10 

4. APPENDIX .............................................................................................................................. 11 
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1. FOREWORD 

1.1. What is an update? 
 

An Update provides a consistent set of fixes and evolutions on existing functionalities, and/or new 

functionalities. 

Its purpose is to deliver corrections, evolutions and/or new functionalities, in-between Versions. 

An Update is specific to a Version 

 

In concrete terms, an update (U) installation program is an .EXE file. 

Example: HOPEX_V2R1_U03.0.exe 

 

The .EXE files provided for HOPEX Software do not allow skipping update levels. For each upgrade level, the 

installation of an .EXE file is necessary. 

For example, to upgrade from HOPEX V2R1 Update 1 to HOPEX V2R1 Update 3: 

• Install an EXE file #1 to upgrade from HOPEX V2R1 Update 1 to HOPEX V2R1 Update 2. 

• Install an EXE file #2 to upgrade from HOPEX V2R1 Update 2 HOPEX V2R1 Update 3. 

• Run the 'Environment Automatic Update' feature. 

 

As a consequence, verify the expected update level is required before installing an update. 

 

Before proceeding, make sure that, for all the HOPEX environments to upgrade: 

• Data is backed up (physical backup). 

• The password of the login System is known. 

This is very important since it will be requested to login with the login System. 

 

2. UPGRADING HOPEX PROGRAMS 

Note that from HOPEX V2R1 Update 2, the component Microsoft URL Rewrite Module 2.0 is required. You 

need to  

• Download it from Microsoft web site. 

Ex: https://www.microsoft.com/en-us/download/details.aspx?id=47337 

• Install it manually on each target machine. 

 

The update installation program is an .EXE file. 

For example: HOPEX_V2R1_U01.0.exe 

 

The procedure varies with the front-ends that you may use: 

o Web Front-end: an IIS web server is used, a specific SSP service (1) is used 

o Windows Front-end: no web server is used; no service is used. 

 

As a consequence, it is very important that you identify the front-ends deployed and the target machines. 

  

https://www.microsoft.com/en-us/download/details.aspx?id=47337
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Front-end Deployment Target machine 

Web Front-end Web standalone deployment Unique Server where HOPEX programs 

are installed 

Web Front-end Web cluster deployment Each application server of the cluster 

where HOPEX programs are installed 

• HOPEX Front-end 

• HOPEX Back-end 

• SSP 

Windows Front-end 

 

Windows standard deployment Each workstation where HOPEX 

programs are installed 

Windows Front-end 

 

Windows Citrix/Terminal Server 

deployment 

Each Citrix/TSE application server where 

HOPEX programs are installed 

 

Deployment Machine Windows 

Service 

IIS Web site 

(1) 

HOPEX 

processes 

Web standalone 

deployment 

Unique server Yes Yes Yes 

Web cluster 

deployment 

Server running SSP Yes  Yes 

Web cluster 

deployment 

Server running HOPEX Back-end 

Server running HOPEX Front-end 

Yes  Yes 

Windows 

Citrix/Terminal 

Server deployment  

Each workstation No  Yes 

Windows standard 

deployment 

Each Citrix/TSE application server No  Yes 

 

(1) By default, an application 'HOPEX' is configured for 'Default Web Site'. 
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2.1. Upgrading Web Front-end 
 

Pre-install: 

1. Identify the target machine(s). 

The machine varies with the chosen deployment: see above table. 

2. Archive key configuration file of IIS application (web.config file) and HOPEX installation 

(Megasite.ini). 

3. Login in as administrator of the machine. 

4. Verify ‘Control Panel > Administrative tools > Services’. 

The service HOPEX Site Service Provider must be set to 'Stopped'. 

The service HOPEX Service Watchdog must be set to 'Stopped'. 

5. Verify ‘Internet Information Services (IIS) Manager’. 

The web site hosting the IIS applications (by default it is 'Default Web Site') must be stopped.  

6. Verify the Task Manager. 

No HOPEX process (mgw*.exe or HOPEX*.exe) must be running.  

7. Check that Microsoft URL Rewrite Module 2.0 is installed 

You can download it from Microsoft web sites. 

8. Verify ‘Control Panel > Add or Remove programs’. 

The required update level must be installed. 

Ex: HOPEX V2R1 U01 (HOPEX V2R1 Update 1) is a requirement before installing HOPEX V2R1 U02 

((HOPEX V2R1 Update 2). 

 

Note: you can also use the utility Hopex Server Supervisor and R click > HOPEX > Stop HOPEX Processes 

Services and Web Application. 

 

Procedure: 

For each machine: 

1. Select the .EXE file of the update. 

Example: Select HOPEX_V2R1_U02.0.exe 

2. R click > Run as administrator 

The wizard can take more than 1 min to load. 

3. Click Update >. 

The installation process can take a minute to initialize. 

Wait until the processing is complete. 

4. Click Finish. 

 

Post-install: 

o Verify ‘Control Panel > Administrative tools > Services’. 

The service HOPEX Site Service Provider must be set back to 'Automatic (Delayed Start)' and be 

started. 

The service HOPEX Service Watchdog must be set back to 'Automatic (Delayed Start)' and be 

started. 

o Verify ‘Internet Information Services (IIS) Manager’. 

The web site hosting the IIS applications (by default it is 'Default Web Site') must be started. 

 

Notes: 

o You can also use the utility Hopex Server Supervisor and R click > HOPEX > Restart HOPEX Processes 

Services and Web Application to restart installation. 

o The location of the installation folder can be found after a search is conducted in the machine 

registry. This location is not visible on the machine during installation or in the control panel. 
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o If the expected update level is not identified for the HOPEX programs registered on the machine, an 

error is displayed. 

2.2. Upgrading Windows Front-end 
 

Pre-install: 

1. Identify the target machine(s). 

The machine varies with the chosen deployment: see above table. 

2. Archive key configuration file of IIS application (file web.config) and HOPEX installation 

(Megasite.ini). 

3. Login in as administrator of the machine. 

4. Verify the Task Manager. 

No HOPEX process (mgwmapp.exe or HOPEX*.exe) must be running.  

5. Verify ‘Control Panel > Add or Remove programs’. 

The required update level must be installed. 

For example, HOPEX V2R1 U07.0 is a requirement before installing HOPEX V2R1 U08.0. 

 

Procedure: 

For each machine: 

1. Select the .EXE file of the update. 

Example: Select HOPEX_V2R1_U01.0.exe 

2. R click > Run as administrator 

The wizard can take more than 1 min to load. 

3. Click Update >. 

The installation process can take a minute to initialize. 

Wait until the processing is complete. 

4. Click Finish. 
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3. UPGRADING HOPEX DATA 

Most changes apply to HOPEX programs. However, some changes apply to the systemdb repository. It is 

therefore necessary to update all HOPEX environments to benefit from all the changes and fixes. The 

procedure varies with the storage. 

3.1. Upgrade HOPEX environments 
 

Pre-upgrade: 

• Verify that no workspace (ex-transaction) exists. 

 

3.1.1. Procedure (GBMS storage): 
 

For each HOPEX environment: 

1. Start the Administration Console (Administration.exe). 

2. Select the environment to be upgraded. 

3. R click > Open. 

4. Login with the System identifier. 

5. Select the environment. 

6. R click > Environment automatic update. 

A wizard 'Environment updating center - Welcome' is displayed. 
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7. Read the information, check the option 'I have taken note of the above text' then click Next. A list of 

actions is displayed. It is recommended to keep them checked. 

 

8. Click Run to start the update. Duration can vary according to various parameters (source and target 

versions, infrastructure performances, number of data repositories). It usually lasts about 15 min. A 

list of reports is displayed (one tab for each action). 

9. Review reports and click Close to exit the wizard. 

10. Close the environment. 

11. Exit the Administration Console. 

 

3.1.2. Procedure (RDBMS storage: Oracle, SQL Server): 
 

With RDBMS storage, the technical format of system database and data repositories may change when 

installing update. In this case, a warning is displayed: 

You cannot access repository XXX. Its internal structure is not up to date. … 

 

 
 

For each HOPEX environment: 

1. Start the Administration Console (Administration.exe). 

2. Select the environment to be upgraded. 

3. R click > Open. 

4. If a warning is displayed (You cannot access repository "SystemDb". Its internal structure is not up to 

date. …): 

o Select the environment in the administration tree. 

o R click > Perform SQL conversions on the repository 

A window 'MEGA RDBMS Technical Conversion' is displayed. 

o Click 'OK'. 

o Wait until the processing is complete (it takes few minutes) and click 'Close'. 

o Select the environment to be upgraded. 

o R click > Open.  

5. Login with the System identifier. 
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6. If warnings are displayed (You cannot access repository "XXX". Its internal structure is not up to 

date…). 

o For each data repository (ex: ProductionData) 

� Select the data repository in the administration tree. 

� R click > RDBMS Administration > Perform SQL conversions on the repository. 

A window 'MEGA RDBMS Technical Conversion' is displayed. 

� Click 'OK'. 

� Wait until the processing is complete (it usually takes a few minutes) and click 'Close'. 

7. Select the environment 

8. R click > Environment automatic update 

A wizard 'Environment updating center - Welcome' is displayed 

 

 
 

9. Read the information, check the option 'I have taken note of the above text' then click Next. A list of 

actions is displayed. It is recommended to keep them checked. 

 

10. Click Run to start the update. Duration can vary according to various parameters (source and target 

versions, infrastructure performances, number of data repositories). It usually lasts about 15 min. A 

list of reports is displayed (one tab for each action). 

11. Review reports and click Close to exit the wizard. 

12. Close the environment. 

13. Exit the Administration Console. 
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3.2. Check Upgraded Data 
Exhaustive check of upgraded data is not possible. 

 

The data conversion success is guaranteed by the correct environment upgrade processing. 

If errors are encountered at this step, the migration process must be stopped so that a diagnosis is made. 

 

After complete execution of the migration process, it is recommended to perform a manual check of 

migrated data. 

Example of scenario: 

1. Open a workspace. 

2. Browse through objects using query tool, navigation tree and diagram. 

3. Make small unimportant changes (e.g.: change a character in a comment value, slightly move an 

object in a diagram...) 

4. Exit the workspace with save or dispatch. 
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4. APPENDIX 

4.1. Advanced deployment 
For advanced deployments (deployment automations tools…), it can be useful to get the update in the 

.MSP format. It is possible to extract an .MSP file from the .EXE file available for download in MEGA 

Community. 

 

Note that with recent operating systems, it is required that the installation is performed not only by a user 

that belongs to the group of 'Administrators' but also that the installation program is executed with the 

privilege 'Run as administrator'. 

 

As no command 'Run as administrator' is available on the .MSP file, a specific procedure is proposed 

below to install the update. Otherwise, the installation may not be fully upgraded and various problems 

can occur especially with HOPEX Web Front-end. 

 

Procedure: 

For each .EXE file: 

1. Copy the .EXE file in a temporary folder 

Example: copy HOPEX_V2R1_U01.0.exe in C:\tmp 

2. In the Start-up menu of MS Windows, search 'Command prompt'. 

3. Select 'Command prompt', R click > Run as administrator. 

A command prompt is open with Run as administrator privilege. 

4. Browse the temporary folder 

5. Run a command /E to extract the .MSP file. Example: 

"HOPEX_V2R1_U01.0.exe" /E 

The .MSP file is uncompressed in the current folder. 

 

4.2. Documentation of Changes 
Several documents can be downloaded with the update. 

 

Document Comment 

Fix list document It contains the list of elementary changes (mainly error corrections). This 

document is cumulative for the version. 

Ex: Fix list for HOPEX V2R1uX.0.htm 

Update Changes document It contains the description of functional improvements of the update This 

document is not cumulative and applies to the update only. 

Ex: HOPEX V2R1 – UX Changes.pdf 

Known issues document It contains list of elementary issues (identified and not fixed). This document 

is cumulative for the version. 

Ex: HOPEX V2R1 – UX Known Issues.pdf 
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The fix list is a table with the following columns: 

 

Column Definition Example 

Patch Identifier of the update 7.85 u01.00 

Product HOPEX Product impacted 1 HOPEX BAV2 

Subsystem Subsystem impacted Web Property Page 

Support id Reference to a support Case or a 

Solution (KB) identifier 

 

Id Identifier of the fix 51248 

Synopsis of the defects Brief description of the error Various errors regarding property pages 

Front-End Front-End impacted Web Front-End 
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5. FAQS 

5.1.1. Why is the menu 'Environment automatic update' is disabled? 

 

The menu will be available after a first systemdb upgrade to HOPEX V2R2 Update 2 or higher. 

When this is done, the update wizard is available, and the menu is enabled. 

5.1.2. What is the meaning of the actions?  

 

System repository update: update of system database by import of .MOL files. 

RDBMS technical alignment: update of tables at SQL level (RDBMS only); 

Data conversion: additional conversion for system database and data repositories. 

Metamodel and technical data compilation: compilation. 
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5.1.3. After a specific update installation, I get the following warning: 

You cannot access repository "XX". Its internal structure is not up to date. 

Run the menu "Technical Conversion" to perform the upgrade? 

With specific updates, the technical version of the repository can change. Run the conversion from the 

Administration Console. 

 

For each environment: 

1. Select the environment folder. 

2. R click > Perform SQL conversions on the repository. 

3. Click OK when conversion of the systemdb repository is complete. 

 

For each data repository of the environment: 

1. Select the data repository. 

2. R click > RDBMS Administration > Perform SQL conversions on the repository. 

3. Click OK when conversion of the systemdb repository is complete. 

5.1.4. I get a message 'MetaModel and/or technical data of your 

environment are not compiled (XXX is missing) .... Please contact your 

administrator to perform the translation/compilation of your 

environment. 

 

This warning reports that certain elements are not compiled. The environment can be used but 
performances are downgraded. As requested, ask the administrator to translate and compile the 

environment. If possible, this should be done outside working hours since this processing can 
take time and will prevent all repository update while it is running. 

5.1.5. When running the menu 'Conversions > System Repository 

Update, a warning says that workspaces exist.  

It is not possible to run the update processing as long as private or collaborative workspaces persist. If 

workspaces should remain, cancel environment upgrade, delete remaining workspaces and resume 

environment upgrade. 

5.1.6. Why are updates provided as .EXE files? 

The .EXE format enables to install the update in the appropriate mode (Run as administrator). 
Otherwise, the installation may not be fully upgraded and various problems can occur especially 

with HOPEX Web Front-end. 
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5.1.7. The SSP Service (mgwspp.exe) keeps re-starting and therefore 

loads other processes (mgwspro.exe...).  

To prevent automatic load of HOPEX processes (mgw*.exe.) it is recommended to disable the 

Windows Service and stop the IIS web site. See sooner in this document, Upgrading Window 

Front-end, Pre-install. 

5.1.8. What is the purpose of the menu 'Conversions > System 

Repository Update > Simulate'? 

This menu enables to preview the impact of the update installation on project customizations. 

By project customizations we mean objects of the system database that are installed by HOPEX 
(creator = mega-user) and customized by the project (modifier <> mega-user). 

To know more about this feature, consult the KB 00005120 in MEGA Community. 
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Summary 

 

This document describes the procedures necessary for installing a CP for HOPEX V2R1. 

It applies to HOPEX V2R1 Update 3. 

 

1. FOREWORD ............................................................................................................................. 3 
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1. FOREWORD 

1.1. Corrective Pack 
 

With HOPEX V2R1 there are several levels of changes: 

• Update: to deliver improvement and fixes. GUI can change. 

Ex: Update 2, Update 3, Update 4 

• Corrective Pack (CP): to deliver fixes only within an update. GUI should not change. 

Ex: Corrective Pack 2 on HOPEX V2R1 Update 3 

• Hotfix: to delivery urgent fixes. GUI does not change. 

Ex: Hotfix 02 on HOPEX V2R1 Update 3 Corrective Pack 2 

 

In concrete terms, a Corrective Pack installation program is a .MSP file embedded as a .EXE file. 

Example: HOPEX_V2R1_U03.02.0.exe. 

 

Each Corrective Pack is related to an update level of a major version. 

Example: Corrective Pack 2 (HOPEX_V2R1_U03.02.0.exe) applies to HOPEX V2R1 Update 3 

 

Corrective Packs are not cumulative. 

Data upgrade can be done in the final CP. 

Example: to upgrade from HOPEX V2R1 Update 3 CP1 to HOPEX V2R1 Update 3 CP4, it is required to: 

1. Install CP2 to upgrade to HOPEX V2R1 Update 3 CP2. 

2. Install CP3 upgrade to HOPEX V2R1 Update 3 CP3. 

3. Install CP4 to upgrade to HOPEX V2R1 Update 3 CP4. 

4. Run the 'Environment Automatic Update' feature. 

 

As a consequence, verify the expected update level is installed before installing a Corrective Pack. 

 

Before proceeding, make sure that, for all the HOPEX environments to upgrade: 

• Data is backed up (physical backup). 

• The password of the login System is known. 

This is very important since it will be requested to login with the login System. 

 

Note that the term FixPack was renamed to Corrective Pack. 
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1.2. Identification of version 
 

Versions can be found through the About HOPEX menu. 

HOPEX <Major version code> U<Update number>.<Corrective Pack number> (Build number) 

 

Example: HOPEX V2R1 U03.02 (7.85.5174.0000) 

• Major version code: V2R1 

• Update number: 03 

• Corrective Pack number: 02 

• Build number: 7.85.5174.0000 

 

Note these build numbers 

• 7.85.4832.xxxx � Update 1 

• 7.85.4903.xxxx � Update 2 

• 7.85.4990.xxxx � Update 3 
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2. UPGRADING HOPEX PROGRAMS 

The Corrective Pack installation program is an .MSP file embedded as an .EXE file. 

Example: HOPEX_V2R1_U03.02.0.exe. 

 

It must be installed on each machine where the version HOPEX V2R1 has been previously installed. The 

components initially installed (HOPEX Kernel and/or IIS components) will be updated. 

 

Front-end Deployment Target machine 

Web Front-end Standalone deployment Unique Server where HOPEX programs 

are installed 

Web Front-end Cluster deployment Each application server of the cluster 

where HOPEX programs are installed 

• HOPEX Front-end 

• HOPEX Back-end 

• SSP 

Windows Front-end 

 

Standard deployment Each workstation where HOPEX 

programs are installed 

Windows Front-end 

 

Citrix/Terminal Server deployment Each Citrix/TSE application server where 

HOPEX programs are installed 
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Deployment Machine Windows 

Service 

IIS Web site 

(1) 

HOPEX 

processes 

Web standalone 

deployment 

Unique server Yes Yes Yes 

Web cluster 

deployment 

Server running SSP Yes  Yes 

Web cluster 

deployment 

Server running HOPEX Back-end 

Server running HOPEX Front-end 

Yes  Yes 

Windows 

Citrix/Terminal 

Server deployment  

Each workstation No  Yes 

Windows standard 

deployment 

Each Citrix/TSE application server No  Yes 

 

(1) By default, an application 'HOPEX' is configured for 'Default Web Site'. 
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2.1. Upgrading Web Front-end 
 

Pre-install: 

• Identify the target machine(s). 

The machine varies with the chosen deployment: see the above table. 

• Archive key configuration file of IIS application (web.config file) and HOPEX installation 

(Megasite.ini). 

• Login in as administrator of the machine. 

• Verify ‘Control Panel > Administrative tools > Services’. 

On the SSP server, the service HOPEX Site Service Provider must be set to 'Stopped'. 

On all the servers, the service HOPEX Service Watchdog must be set to 'Stopped'. 

• Verify ‘Internet Information Services (IIS) Manager’. 

The web site hosting the IIS applications (by default it is 'Default Web Site') must be stopped.  

• Verify the Task Manager. 

No HOPEX process (mgw*.exe, or HOPEX*) must be running.  

• Verify 'Control Panel > Add or Remove programs'. 

The required update level must be installed. 

For example, HOPEX V2R1 Update 3 is a requirement before installing Corrective Pack 2 

(HOPEX_V2R1_U03.02.0.exe). 

 

Note: you can also use the utility Hopex Server Supervisor and R click > HOPEX > Stop HOPEX Processes 

Services and Web Application. 

 

Procedure: 

For each machine: 

1. Select the .EXE file of the Corrective Pack. 

Example: Select HOPEX_V2R1_U03.02.0.exe. 

2. R click > Apply 

The wizard can take more than one min to load. 

3. Click Update >. 

The installation process can take one minute to initialize. 

Wait until the processing is complete. 

4. Click Finish. 

 

Notes: 

o The location of the installation folder can be found after a search is conducted in the machine 

registry. This location is not visible on the machine during installation or in the control panel. 

o If the expected update level is not identified for the HOPEX programs registered on the machine, an 

error is displayed. 
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2.2. Upgrading HOPEX Data 
Most changes apply to HOPEX programs. However, some changes apply to the systemdb repository. It is 

therefore necessary to update all HOPEX environments to benefit from all the changes and fixes. The 

procedure varies depending on the storage. 

 

Pre-upgrade: 

• Verify that no workspace exists in read/write mode. 

• Verify ‘Control Panel > Administrative tools > Services’. 

On the SSP server, the service HOPEX Site Service Provider must be set to 'Stopped'. 

On the all servers, the service HOPEX Service Watchdog must be set to 'Stopped'. 

• Verify the Task Manager. 

No HOPEX process (mgw*.exe, or HOPEX*) must be running. 

 

 

Procedure: 

 

With RDBMS storage, the technical format of the system repository and data repositories may change 

when installing update. In this case, a warning is displayed:  

You cannot access repository XXX. Its internal structure is not up to date. …  

  

  

  

For each HOPEX environment:  

1. Start the Administration Console (Administration.exe).  

2. Select the environment to be upgraded.  

3. R click > Open.  

4. If a warning is displayed (You cannot access repository "SystemDb". Its internal structure is not up to 

date. …), click 'Cancel', then : 

• Select the environment in the administration tree.  

• R click > Perform SQL conversions on the repository  

A window 'MEGA RDBMS Technical Conversion' is displayed.  

• Click 'OK'.  

• Wait until the processing is complete (it takes a few minutes) and click 'Close'.  

5. Select the environment to be upgraded.  

6. R click > Open.   

7. Login with the System identifier.  

8. If warnings are displayed (“You cannot access repository "XXX". Its internal structure is not up to 

date…”), for each data repository (ex: ProductionData): 

• Select the data repository in the administration tree.  
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• R click > RDBMS Administration > Perform SQL conversions on the repository.  

A window 'MEGA RDBMS Technical Conversion' is displayed.  

• Click 'OK'.  

• Wait until the processing is complete (it usually takes a few minutes) and click 'Close'.  

9. Select the environment  

10. R click > Environment automatic update  

A wizard 'Environment updating center - Welcome' is displayed: 

 

  

11. Read the information, check the option 'I have taken note of the above text' then click Next. A list 

of actions is displayed. It is recommended to keep them checked.  

12. Click Run to start the update. Duration can vary according to various parameters (source and target 

versions, infrastructure performances, number of data repositories). It usually lasts about 15 min. A 

list of reports is displayed (one tab for each action).  

13. Review reports and click Close to exit the wizard.  

14. Close the environment.  

15. Exit the Administration Console.  
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Post-installation and data upgrade: 

• Verify ‘Control Panel > Administrative tools > Services’. 

On the SSP server, the service HOPEX Site Service Provider must be set to 'Automatic (Delayed 

Start)' and be started. 

On the all servers, the service HOPEX Service Watchdog must be set to 'Automatic (Delayed Start)' 

and be started. 

• Verify ‘Internet Information Services (IIS) Manager’. 

The web site hosting the IIS applications (by default it is 'Default Web Site') must be started. 

 

Note: you can also use the utility Hopex Server Supervisor and R click > HOPEX > Restart HOPEX Processes 

Services and Web Application. 

  



 
How to install CP HOPEX V2R1 EN 

 

C0 - PUBLIC page 11/12 

 

 

3. FAQS 

 

3.1.1. What is the meaning of the actions below?  

 

System repository update: update of system repository by import of .MOL files. 

RDBMS technical alignment: update of tables at SQL level (RDBMS only). 

Data conversion: additional conversion for system repository and data repositories. 

Metamodel and technical data compilation: compilation. 

 

3.1.2. What is the procedure for GBMS storage?  

It is not recommended at all to use GBMS storage (deprecated) 

• It not supported for Web Front-end 

• It not supported for large repositories (size larger than 4 GB) 

 

It is possible to upgrade data using the same procedure. 

Note that some steps/actions are not applicable: 

• Menu Perform SQL conversions on the repository in Administration.exe 

• Action 'RDBMS technical alignment in environment upgrade wizard 
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•  

3.1.3. How can I get the MSP file of the Corrective Pack?  

 

Procedure: 

• Copy the .EXE of the Corrective Pack file in a temporary folder, ex: 

C:\tmp\HOPEX_V2R1_U03.02.0.exe 

• Open a command prompt window (CMD) 

• Run the following command <path of EXE)> /E, Ex: C:\tmp\HOPEX_V2R1_U03.02.0.exe /E 

• The installation wizard is loaded. Click 'Cancel' then 'Yes' and 'Finish' to exit the wizard. 

• In the temporary folder, a .MSP file has been created, ex: MEGA HOPEX V2R1 Patch 301.msp 
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Summary 

 

This document describes the procedures necessary for installing a hotfix for HOPEX V2R1. 

It applies to HOPEX V2R1 Update 3. 

 

1. FOREWORD ............................................................................................................................. 3 

1.1. Hotfix ............................................................................................................................................. 3 

2. UPGRADING HOPEX PROGRAMS.............................................................................................. 3 

2.1. Upgrading Web Front-end ............................................................................................................ 5 
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3. UPGRADING HOPEX CONFIGURATION ..................................................................................... 8 
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1. FOREWORD 

1.1. Hotfix 
 

A hotfix provides a consistent set of changes, mainly error fixes. 

 

In concrete terms, a hotfix installation program is a .MSP file. 

Example: HOPEX_V2R1_U01_HF00.01.msp 

 

The hotfixes provided for HOPEX Software are cumulative. 

Example: Hotfix 01.03 also includes fixes of Hotfix 01.01 and Hotfix 01.02. 

 

Each hotfix is related to an update (U) level and possibly to a Corrective Pack (CP) level. 

Example: 

Hotfix 01 for HOPEX V2R1 Update 1. 

Hotfix 01 for HOPEX V2R1 Update 3 Corrective Pack 2. 

As a consequence, verify the expected Update level or Corrective Pack level is installed before installing a 

hotfix. 

 

Before proceeding, make sure that, for all the HOPEX environments to upgrade: 

• Data is backed up (physical backup). 

• The password of the login System is known. 

This is very important since it will be requested to login with the login System. 

 

2. UPGRADING HOPEX PROGRAMS 

The hotfix installation program is a .MSP file. 

Example: HOPEX_V2R1_U01_HF01.01.msp. 

 

It must be installed on each machine where the version HOPEX V2R1 has been previously installed. The 

components initially installed (HOPEX Kernel and/or IIS components) will be updated. 

 

Front-end Deployment Target machine 

Web Front-end Standalone deployment Unique Server where HOPEX programs 

are installed 

Web Front-end Cluster deployment Each application server of the cluster 

where HOPEX programs are installed 

• HOPEX Front-end 

• HOPEX Back-end 

• SSP 

Windows Front-end 

 

Standard deployment Each workstation where HOPEX 

programs are installed 

Windows Front-end 

 

Citrix/Terminal Server deployment Each Citrix/TSE application server where 

HOPEX programs are installed 
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Deployment Machine Windows 

Service 

IIS Web site 

(1) 

HOPEX 

processes 

Web standalone 

deployment 

Unique server Yes Yes Yes 

Web cluster 

deployment 

Server running SSP Yes  Yes 

Web cluster 

deployment 

Server running HOPEX Back-end 

Server running HOPEX Front-end 

Yes  Yes 

Windows 

Citrix/Terminal 

Server deployment  

Each workstation No  Yes 

Windows standard 

deployment 

Each Citrix/TSE application server No  Yes 

 

(1) By default, an application 'HOPEX' is configured for 'Default Web Site'. 
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2.1. Upgrading Web Front-end 
 

Pre-install: 

• Identify the target machine(s). 

The machine varies with the chosen deployment: see above table. 

• Archive key configuration file of IIS application (web.config file) and HOPEX installation 

(Megasite.ini). 

• Login in as administrator of the machine. 

• Verify ‘Control Panel > Administrative tools > Services’. 

On the SSP server, the service HOPEX Site Service Provider must set to 'Stopped'. 

On all the servers, the service HOPEX Service Watchdog must set to 'Stopped'. 

• Verify ‘Internet Information Services (IIS) Manager’. 

The web site hosting the IIS applications (by default it is 'Default Web Site') must be stopped.  

• Verify the Task Manager. 

No HOPEX process (mgw*.exe, or HOPEX*) must be running.  

• Verify 'Control Panel > Add or Remove programs'. 

The required update level must be installed. 

For example, HOPEX V2R1 U1.0 is a requirement before installing HOPEX V2R1 U01.0 Hotfix 1.01. 

 

Note: you can also use the utility Hopex Server Supervisor and R click > HOPEX > Stop HOPEX Processes 

Services and Web Application. 

 

Procedure: 

For each machine: 

1. Select the .MSP file of the update. 

Example: Select HOPEX_V2R1_U01_HF01.01.msp 

2. R click > Apply 

The wizard can take more than 1 min to load. 

3. Click Update >. 

The installation process can take a minute to initialize. 

Wait until the processing is complete. 

4. Click Finish. 

 

Notes: 

o The location of the installation folder can be found after a search is conducted in the machine 

registry. This location is not visible on the machine during installation or in the control panel. 

o If the expected update level is not identified for the HOPEX programs registered on the machine, an 

error is displayed. 
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2.2. Upgrading HOPEX Data 
Most changes apply to HOPEX programs. However, some changes apply to the systemdb repository. It is 

therefore necessary to update all HOPEX environments to benefit from all the changes and fixes. The 

procedure varies with the storage. 

 

Pre-upgrade: 

• Verify that no workspace exists in read/write mode. 

• Verify ‘Control Panel > Administrative tools > Services’. 

On the SSP server, the service HOPEX Site Service Provider must set to 'Stopped'. 

On the all servers, the service HOPEX Service Watchdog must set to 'Stopped'. 

• Verify the Task Manager. 

No HOPEX process (mgw*.exe, or HOPEX*) must be running. 

 

 

Procedure: 

 

For each HOPEX environment: 

1. Start the Administration Console (Administration.exe). 

2. Select the environment to be upgraded. 

3. R click > Open. 

4. Login with the System identifier. 

5. In the folder 'Repositories', select Systemdb. 

6. R click > Object Management > Import. 

7. Select file 'UpgradeHF.mol' and click Import. 

It is located in the folder '\Install\Update' of the installation 

Ex: C:\Program Files (x86)\MEGA\HOPEX V2R1\Install\Update 

Before Update 3, this file was located in the folder '\Mega_Std' of the installation. 

8. In the tree, select the environment. 

9. R click > Metamodel > Translate and compile. 

10. Check at least 'Compile metamodel' and 'Compile technical data' and click 'Start'. 

Wait until compilation is complete. 

11. Exit the Administration Console. 
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Post-installation and data upgrade: 

• Verify ‘Control Panel > Administrative tools > Services’. 

On the SSP server, the service HOPEX Site Service Provider must set to 'Automatic (Delayed Start)' 

and be started. 

On the all servers, the service HOPEX Service Watchdog must set to 'Automatic (Delayed Start)' 

and be started. 

• Verify ‘Internet Information Services (IIS) Manager’. 

The web site hosting the IIS applications (by default it is 'Default Web Site') must be started. 

 

Note: you can also use the utility Hopex Server Supervisor and R click > HOPEX > Restart HOPEX Processes 

Services and Web Application. 
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3. UPGRADING HOPEX CONFIGURATION 

 

In specific versions, it can be required to manually update configuration (web.config) of specific IIS 

applications. 

 

See in MEGA Community (personal login required) 

https://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=5012p000000kmXqAAI 

https://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=5012p000000kmXqAAI
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1. UNIFIED AUTHENTICATION SERVICE OVERVIEW 

Authentication is a common basic requirement for modern web-based applications as more and more 

customized and access controlled services move it online.  

Cloud applications have become popular among organizations that share content on the Internet.  

Most of the organizations have started using a centralized authentication source for their web portal, web and 

mobile applications. 

Most of the web and mobile applications have their own authentication system to provide a better user 

experience. To support that need, one of our goals is to provide you with a clear framework that allows you to 

develop secure web based authentication system easily. 

 We want to provide the most secure and scalable platform on our market. 

With the Unified Authentication Service (UAS), you have a centralized service for your login logic and 

workflows in a single and well secured place. 

It allows managing single sign-on (SSO) (and out) over multiple application types like web or mobile, access 

control for APIs and federation (support for external identity providers like Google and enterprise identity 

management systems via SAML and WS-Federation) 
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2. UAS CONFIGURATION 

UAS is configurable by HOPEX Administration through option module. 

2.1. Configuring authentication options 

To configure authentication options, you must access to HOPEX Options in Extended view. 

To configure authentication options: 

1) Go to HOPEX Administration. 

2) Right-click HOPEX and select Options > Modify. 

3) Right-click Options and select Extended. 

4) Expand Installation > Authentication folders. 

 

5) Click: 

• Client, and configure the client options. 

� See Client Option Description. 

 

• Cross-origin resource sharing, and configure the cross origin resource sharing options. 

� See Cross-Origin Resource Sharing Option Description. 

• Identity provider, and configure the identity provider options. 

� See Identity Provider Option Description 

 

• Server, and configure the server global options and specific options. 

� See Server Option Description. 
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2.2. Server Option Description 

2.2.1. Server global options 

The server global options (HOPEX > Options (Extended view) > Installation > Authentication > Server) are the 

following: 

• Name of the authentication site (available in Standard view) 

Displays name of the site used in standard views. Default to HOPEX. 

• SSL Activation 

Indicates if SSL is required for UAS.  You need to activate this option if you want to secure your 

authentication service and work with some identity providers. Defaults to false.  

• Public origin of the site 

By default, UAS uses the host, protocol, and port from the HTTP request when creating links. This 

might not be accurate in reverse proxy or load-balancing situations. You can override the origin 

used for link generation using this property. 

• Type of information storage 

UAS allows to use the following data component types:  

• InMemory 

This storage type allows to store data in memory of your server. It’s the simplest storage type. 

You cannot use it with a cluster deployment and you lose your token when you reboot your 

server. 

• Redis (Cluster Compatible) 

This storage type allows to store data in Redis, a nosql database storage, used for caching. You 

can use it with a cluster deployment. No data loss.  

• NCache (Cluster Compatible) 

This storage type allows to store data in NCache Entreprise 4.6.2 minimum, used for caching. 

You can use it with a cluster deployment. No data loss. 

For legal reason (License redistribution), MEGA cannot provide the assemblies to work with. 

You need to put the following assemblies in the UAS binary folder (by default wwwroot/uas/bin):  

- Alachisoft.NCache.Web.dll 

- Alachisoft.NCache.Runtime.dll 

• SqlServer (Cluster Compatible) 

This storage type allows to store data in SQL Server 2008 R2 minimum, used for caching. You 

can use it with a cluster deployment. No data loss. 
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You must launch SQL scripts which can be found in: 

{HOPEX installation folder}\Utilities\Hopex Cluster Tools\UAS_Scripts.sql  

• Parameters of the UAS data component 

This parameters allows to complete the data component type. Several data components needs 

more informations like connectionstring or key. 

• InMemory 

No need to fill this parameter. 

• Redis (Cluster Compatible) 

Fill the Redis connection string into this parameter.  

• NCache (Cluster Compatible) 

Fill the NCache name into this parameter. 

• SqlServer (Cluster Compatible) 

Fill the SQLServer connection string into this parameter. 

Data Source={ServerName}\{Instance};Initial Catalog={DataBaseName};Integrated 

Security=False;User ID={UserId};Password={UserPassword} 

2.2.2. Authentication options 

The server authentication options (HOPEX > Options (Extended view) > Installation > Authentication >Server 

> Authentication) are the following: 

• Activation of user name backup 

Indicates whether UAS will remember the last username entered on the login page. Defaults to true 

• Activation of the local connection 

Indicates if UAS will allow users to authenticate with a local account. Disabling this setting will not 

display the username/password form on the login page. This also will disable the resource owner 

password flow. Defaults to true. 

• Activation of the login hint 

Indicates whether the login_hint parameter is used to prepopulate the username field. Defaults 

to true. 

• Limit to the number of consecutive messages 

Gets or sets the limit after which old sign in messages (cookies) are purged. Defaults to 3. 

• Activation of the capacity to redirect directly to an URL after disconnection 

Gets or sets a value indicating whether UAS automatically redirects back to a 

validated post_logout_redirect_uri passed to the sign out endpoint. Defaults to false. 

• Activation of confirmation during connection 

Indicates whether UAS will show a confirmation page for sign-in. When a client initiates a sign-in, 

by default UAS will not ask the user for confirmation but you can activate it. This is a mitigation 

technique against “logout spam”. Defaults to false. 

• The redirection timeout of the automatic post-disconnection 

Gets or sets the delay (in seconds) before redirecting to a post_logout_redirect_uri. Defaults to 0. 
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• Activation of display of the disconnection confirmation page 

Indicates whether UAS will show a confirmation page for sign-out. When a client initiates a sign-

out, by default UAS will not ask the user for confirmation. 

• The invalid sign in redirect URL 

Gets or sets the invalid sign in redirect URL. If the user arrives at the login page without a valid sign-

in request, then they will be redirected to this URL. The URL can be absolute or relative (starting 

with “~/”). 

2.2.3. Cookie options 

The server cookie options (HOPEX > Options > Installation > Authentication > Server > Cookie) are the 

following: 

• Display the “Remember me” checkbox in the login page or not 

Indicates whether the “remember me” option is presented to users on the login page. If selected 

this option will issue a persistent authentication cookie. Defaults to false. 

• Sliding cookie Expiration 

Indicates if the authentication cookie is sliding, which means it auto renews as the user is active. 

Defaults to false. 

2.2.4. Events options 

UAS raises many events at runtime. 

The server event options (HOPEX > Options (Extended view) > Installation > Authentication >Server > Events) 

are the following: 

• Successful/failed authentication (resource owner flow, pre, partial, local and external) 

• Token issued (identity, access, refresh tokens) 

• Token handle related events (authorization code, refresh token issued/redeemed/refreshed) 

• Permission revoked 

• Endpoint success/failures 

• Expired/invalid/no signing certificate 

• Unhandled exceptions and internal errors 

• CSP errors reported by the browser 

By default, these events are forwarded to the configured log provider - a custom event service can process or 

forward them in any way suitable for the environment. 

The Events options are the following (all default to false): 

• Generation of all events 

Activates all the events below 

• Generation of success events 

Activates refresh token refreshed or authentication success. 

• Generation of failure events 
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Activates authentication failure, authorization code redeems failure events. 

• Generation of error events 

Activates unhandled exceptions events. 

• Generation of information events 

Activates token issued or certificate valid events. 

2.2.5. Logging trace options 

The server logging trace options (HOPEX > Options (Extended view) > Installation > Authentication > Server > 

Logging trace) are the following: 

• Activation of all logging 

Activates all the logging traces (http flow, katana Flow, programming web interface, programming 

web interface in Verbose mode). 

• Activation of Http flow logging 

When enabled, HTTP requests and responses are logged. 

• Activation of Katana Flow Logging 

When enabled, the Katana log output is logged (this is often useful to troubleshoot problems with 

external identity providers). 

• Activation of logging of the programming web interface 

When enabled, Web API internal diagnostic logging is forwarded to the log provider. 

• Activation of logging of the programming web interface in Verbose mode 

When enabled, the Web API diagnostics logging is set to verbose. 

2.2.6. Token Signature options 

The server token signature options (HOPEX > Options (Extended view) > Installation > Authentication > Server 

> Token Signature) are the following: 

• Name of the certificate to be used by the authentication server 

X.509 certificate (and corresponding private key) name for signing security tokens. 

• Password for the signature certificate of the authentication server  

X.509 certificate (and corresponding private key) password for signing security tokens. 

2.3. Identity Provider Option Description 

The identity provider options (HOPEX > Options > Installation > Authentication > Identity provider) are the 

following: 

• HOPEX, see HOPEX provider. 

• IIS windows, see IIS Windows provider 

• SAML2, see SAML2 provider. 

• Google, see Google provider. 
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• Microsoft, see Microsoft provider. 

• Salesforce, see Salesforce provider. 

• Custom, see Custom provider. 

2.3.1. HOPEX provider 

The HOPEX provider is the HOPEX default provider, which displays a login page with username and password.  

To authenticate HOPEX users, use either: 

• HOPEX User Native Authentication  

See HOPEX Administration documentation: Authentication in HOPEX section. 

•  LDAP Authentication 

See HOPEX Administration documentation: Authentication in HOPEX section. 

2.3.2. IIS Windows provider 

With the IIS Windows provider HOPEX users are authenticated by Windows Authentication.  

To use IIS Windows provider, you must configure the following mandatory options:  

• Enabled (Default to false) 

• Name displayed for the Windows IIS access provider (Windows by Default) 

• URL of the Windows IIS authentication server. 

2.3.3. SAML2 provider 

SAML 2.0 is an XML based framework, used to describe and exchange security information. It can be used for 

Single Sign On (SSO), Identity Management and Federation. 

To use SAML2 provider, you must set UAS in SSL Mode. 

UAS manages only Service Provider (SP) initiated SSO and not Identity Provider(IDP) initiated SSO. 

We have implemented two SAML2 Identity Provider and you can find the server configuration example: 

• SAML2 ADFS Server Configuration section 

• OKTA Configuration section 

2.3.4. Google provider 

Use the Google provider to authenticate HOPEX users with a google account by OAUTH2.   

To use Google provider, you must: 

• set UAS in SSL Mode (Options > Installation > Authentication > server) 

• Have your website accessible by Google server 

• enter the following fields:  

• Enabled ( Activated or not) 

• Display name (Text the user can display in the user interface, by Default Google) 
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• Google Client ID (Identifier of the Google access provider client) 

• Google Secret code (Password of the Google access provider client) 

• Google Scope (Scope of the authenticated client) 

If you do not know this information, go to the Google console (https://console.developers.google.com) to 

create your API keys. 

Do not forget to activate Google + API at least, otherwise you will not be able to authenticate HOPEX users. 

2.3.5. Microsoft provider 

Use the Microsoft provider to authenticate HOPEX users with a Microsoft account by OAUTH2.  

To use Microsoft provider, you must set UAS in SSL Mode and ensure the address is accessible by Microsoft 

server and fill the following fields:  

• Enabled (Activated or not) 

• Display name (Text the user can display in the user interface) 

• Microsoft Client ID (Identifier of the Microsoft access provider client) 

• Microsoft Password (Password of the Microsoft access provider client) 

• Microsoft Scope (Scope of the authenticated client) 

If you do not know this information, go to the Microsoft website (https://apps.dev.microsoft.com ) to create 

your API keys. 

2.3.6. Salesforce provider 

Use the Salesforce provider to authenticate HOPEX users with a Salesforce account by OAUTH2. 

To use  Salesforce provider, you must set UAS in SSL Mode and ensure the address is accessible by Salesforce 

server and fill the following fields:  

• Enabled (Activated or not) 

• Display name (Text the user can display in the user interface) 

• Salesforce Client ID (Identifier of the Salesforce access provider client) 

• Salesforce Password (Password of the Salesforce access provider client) 

• Salesforce Scope (Scope of the authenticated client) 

If you do not know this information, go to the website: 

https://help.salesforce.com/articleView?id=connected_app_create.htm for information on how to create a 

connected app. 

To connect Salesforce with UAS through Salesforce Admin, fill: 

• Application Url field: http(s)://<servername>/HOPEX/DEFAULT.ASPX 

• CallBack Url field: http(s)://<servername>/UAS/signin-salesforce 

https://console.developers.google.com/
https://apps.dev.microsoft.com/
https://help.salesforce.com/articleView?id=connected_app_create.htm
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2.3.7. Custom provider 

Use the Custom provider to authenticate HOPEX users with your own implementation. You must fill the 

following fields:  

• Enabled (Boolean) 

Activate or not your Custom Provider 

• Parameters (string) 

Parameters used by your custom provider. 

To create your custom provider, see Install the Hopex Identity Provider template section. 

Do not forget to: 

• set Namespace properties to “Custom”  

• call your C# project: MEGA.UAS.IdentityProvider.Custom 

2.4. Cross-Origin Resource Sharing Option Description  

(available with options in Extended view only) 

Cross-origin Resource Sharing (CORS) is a mechanism that allows some web resources (e.g. fonts) on a web 

page to be requested from a different domain outside the domain from which the first resource was served. A 

web page may freely embed cross-origin images, stylesheets, scripts, iframes, and videos. Certain "cross-

domain" requests, notably Ajax requests, however are forbidden by default by the same-origin security policy. 

With UAS you can add resources from another domain. It can be used if you use several domains in your HOPEX 

installation. You can have up to 5 different CORS. 

2.5. Client Option Description 

2.5.1. HOPEX Custom (options in Extended view only) 

HOPEX allows you to authenticate an external client with UAS and enable UAS SSO Features.  

You must fill the following fields:  

• Enabled (Activated or not) 

• Client ID: HopexCustom (default) 

• Client Name: Hopex Custom Client (default) 

• Client secret: secret (default) 

• Client Scopes 

• Client Flow  

• Client Redirect uri 

• Client Allowed Redirect uri 

• Client Post Logout Redirect uri  

https://en.wikipedia.org/wiki/Web_page
https://en.wikipedia.org/wiki/Web_page
https://en.wikipedia.org/wiki/Domain_name
https://en.wikipedia.org/wiki/Style_sheet_(web_development)
https://en.wikipedia.org/wiki/HTML_element
https://en.wikipedia.org/wiki/Ajax_(programming)
https://en.wikipedia.org/wiki/Same-origin_policy
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3. ENDPOINTS 

3.1. Authorization/Authentication 

The authorization endpoint can be used to request either access tokens or authorization codes (implicit and 

authorization code flow). You either use a web browser or a web view to start the process. 

• client_id (required) 

Identifier of the client 

• scope (required) 

One or more registered scopes 

• redirect_uri (required) 

must match exactly one of the allowed redirect URIs for that client 

• response_type (required) 

• code requests an authorization code 

• token requests an access token (only resource scopes are allowed) 

• id_token token requests an identity token and an access token (both resource and identity 

scopes are allowed) 

• response_mode (optional) 

form_post sends the token response as a form post instead of a fragment encoded redirect 

• state (recommended) 

Unified Authentication Service will echo back the state value on the token response, this is for 

correlating request and response. 

• nonce (required for identity tokens using implicit flow) 

Unified Authentication Service will echo back the nonce value in the identity token, this is for 

correlating the token to the request). 

• prompt (optional) 

• none no UI will be shown during the request. If this is not possible (e.g. because the user has to 

sign in or consent) an error is returned 

• login the login UI will be shown, even if the user is already signed-in and has a valid session 

• code_challenge (required when using proof keys) 

Sends the code challenge for proof key flows. 

• code_challenge_method (optional - default to plain when using proof key ) 

• plain indicates that the challenge is using plain text (not recommended) 

• S256 indicates the challenge is hashed with SHA256 

• login_hint (optional) 

Can be used to pre-fill the username field on the login page. 

• ui_locales (optional) 

Gives a hint about the desired display language of the login UI 
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• max_age (optional) 

If the user’s logon session exceeds the max age (in seconds), the login UI will be shown 

• acr_values (optional) 

Allows to pass additional authentication related information to the user service - there are also 

values with special meaning: 

• idp:name_of_idp bypasses the login/home realm screen and forwards the user directly to the 

selected identity provider (if allowed per client configuration) 

• tenant:name_of_tenant can be used to pass a tenant name to the user service 

 

Example (URL encoding removed for readability) 

GET /connect/authorize?client_id=client1&scope=openid email 

api1&response_type=id_token token 

3.2. Token  

The token endpoint can be used to programmatically request or refresh tokens (resource owner password 

credential flow, authorization code flow, client credentials flow and custom grant types). 

• grant_type (required) 

• authorization_code 

•  client_credentials 

• Password 

• refresh_token  

•  custom 

• scope (required for all grant types besides refresh_token and code) 

• redirect_uri (required for code grant type) 

• code (required for code grant) 

• code_verifier (required when using proof keys - added in v2.5) 

• username (required for password grant type) 

• password (required for password grant_type) 

• acr_values (allowed for password grant type to pass additional information to user service) 

Values with special meaning: 

• idp:name_of_idp bypasses the login/home realm screen and forwards the user directly to the 

selected identity provider (if allowed per client configuration) 

• tenant:name_of_tenant can be used to pass extra information to the user service 

• refresh_token (required for refresh token grant) 

• client_id (either in the post body, or as a basic authentication header) 

• client_secret (either in the post body, or as a basic authentication header) 

Authentication 
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All requests to the token endpoint must be authenticated - either pass client id and secret via Basic 

Authentication or add client_id and client_secret fields to the POST body. 

Example: (Form-encoding removed and line breaks added for readability) 

POST /connect/token 

Authorization: Basic abcxyz 

grant_type=authorization_code&code=hdh922&redirect_uri=https://myapp.com/callback 

3.3. UserInfo 

The UserInfo endpoint can be used to retrieve identity information about a subject. It requires a valid access 

token with at least the “openid” scope. 

Example: 

GET /connect/userinfo 

Authorization: Bearer <access_token> 

HTTP/1.1 200 OK 

Content-Type: application/json 

{ 

   "sub": "248289761001", 

   "name": "Bob Smith", 

   "given_name": "Bob", 

   "family_name": "Smith", 

   "role": [ 

       "user", 

       "admin" 

   ] 

} 

3.4. Discovery Endpoint 

The discovery endpoint can be used to retrieve metadata about Unified Authentication Service - it returns 

information like the issuer name, key material, supported scopes etc. 

Example: 

GET /.well-known/openid-configuration 

3.5. Logout Endpoint 

Redirecting to the logout endpoint clears the authentication session and cookie. 

You can pass the following optional parameters to the endpoint: 

• id_token_hint 

The id_token that the client retrieved during authentication. This allows bypassing the logout 

confirmation screen as well as providing a post logout redirect URL 

• post_logout_redirect_uri 
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A URI that Unified Authentication Service can redirect to after logout (by default a link is displayed). 

The URI must be in the list of allowed post logout URIs for the client. 

/connect/endsession?id_token_hint=...&post_logout_redirect_uri=https://myapp.com 

See the Authentication section to configure the behavior of logout endpoint and logout page. 

3.6. Token Revocation 

This endpoint allows revoking access tokens (reference tokens only) and refresh token. It implements the token 

revocation specification. 

Supported parameters: 

• token (required) 

The token to revoke 

• token_type_hint  

Either access_token or refresh_token 

Requests must be authenticated using one of the supported client authentication methods. 

Example: 

POST /connect/revocation HTTP/1.1 

Host: server.example.com 

Content-Type : application/x-www-form-urlencoded 

Authorization: Basic czZCaGRSa3F0MzpnWDFmQmF0M2JW 

token=45ghiukldjahdnhzdauz&token_type_hint=refresh_token 

3.7. Introspection Endpoint 

The introspection endpoint is an implementation of RFC 7662. 

It can be used to validate reference tokens (or JWTs if the consumer does not have support for appropriate 

JWT or cryptographic libraries). 

The introspection endpoint requires authentication using a scope credential (only scopes that are contained 

in the access token are allowed to introspect the token). 

Example: 

POST /connect/introspect 

Authorization: Basic xxxyyy 

token=<token> 

A successful response returns a status code of 200 and either an active or inactive token: 

{ 

   "active": true, 

   "sub": "123" 

} 

Unknown or expired tokens are marked as inactive: 

{ 

   "active": false, 

https://tools.ietf.org/html/rfc7662
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} 

An invalid request returns a 400 or a 401 if the scope is not authorized. 

Note: 

The introspection endpoint replaces the old access token validation endpoint. Since the introspection endpoint 

requires authentication, it adds privacy features to reference tokens, which were not available previously. The 

access token validation endpoint still exists, but it is recommended to disable it and use the introspection 

endpoint instead. 

3.8. Access token validation endpoint 

The access token validation endpoint can be used to validate reference tokens. It can be also used to validate 

self-contained JWTs if the consumer does not have support for appropriate JWT or cryptographic libraries. 

You can either GET or POST to the validation endpoint. Due to query string size restrictions, POST is 

recommended. 

Example: 

POST /connect/accesstokenvalidation 

token=<token> 

or 

GET /connect/accesstokenvalidation?token=<token> 

A successful response returns a status code of 200 and the associated claims for the token.  

An unsuccessful response returns a 400 with an error message. 

It is also possible to pass a scope that is expected to be inside the token: 

POST /connect/accesstokenvalidation 

token=<token>&expectedScope=calendar 

Note: 

The access token validation endpoint does not enforce client authentication.  

Do not use reference tokens for confidentiality purposes. 

3.9. Identity Token Validation Endpoint 

The identity token validation endpoint can be used to validate identity tokens. This is useful for clients that do 

not have access to the appropriate JWT or crypto libraries (e.g. JavaScript). 

You can either GET or POST to the validation endpoint. Due to query string size restrictions, POST is 

recommended. 

Example: 

POST /connect/identitytokenvalidation 

token=<token>&client_id=<expected_client_id> 

GET /connect/identitytokenvalidation?token=<token>&client_id=<expected_client_id> 

 

A successful response returns a status code of 200 and the associated claims for the token.  
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{ 

  "nonce": "nonce", 

  "iat": "1413203421", 

  "sub": "88421113", 

  "amr": "password", 

  "auth_time": "1413203419", 

  "idp": "idsrv", 

  "iss": "https://idsrv3.com", 

  "aud": "implicitclient", 

  "exp": "1413203781", 

  "nbf": "1413203421" 

} 

 

An unsuccessful response will return a 400 with an error message. 

3.10. CSP Endpoint 

Unified Authentication Service provides an endpoint to record CSP errors that the browser reports. These CSP 

errors are raised as events in the  system event 

https://identityserver.github.io/Documentation/docsv2/configuration/events.html
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4. ESTABLISH AN SSL CONNECTION 

UAS must establish an SSL connection to communicate with SAML2 Provider like as ADFS. 

To establish an SSL connection: 

 Action See 

1 Create a certificate request Creating a certificate request from IIS 

2 Complete the certificate request Completing the certificate request 

3 Bind IIS with SSL certificate Binding IIS with SSL certificate 

4 Export the certificate to the local disk Exporting certificate to the local disk 

4.1. Creating a certificate request from IIS 

To create a certificate request from IIS: 

1. Open IIS. 

2. In IIS section, double-click Server certificates. 

3. In the Actions pane, click Create certificate request. 

4. In the Common name field, enter the server name (Fully Qualified domain name). 

 

5. Enter all the requested fields. 

6. Click Next. 

The Cryptographic Service Provider Properties window appears. 

7. In the Cryptographic Service Provider field, select “Microsoft RSA Channel Cryptographic Provider”. 
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8. In the Bit length field, select “2048”. 

 

9. Click Next. 

10. Enter the name and saving location for the output request file 

11. Click Finish. 

12. Send this request to your CA Authority. 

When you receive the certificate, complete the certificate request, see Completing the certificate 

request. 

4.2. Completing the certificate request 

To complete the certificate request: 

1. Access IIS > Server Certificates. 

2. In the Actions pane, click Complete certificate request. 

3. In the Friendly name field, enter any name. 

4. In the Select a certificate store for the new certificate, select “Personal”. 

5. Click OK. 

4.3. Binding IIS with SSL certificate 

To bind IIS with SSL certificate: 

1. In IIS, Connections pane, expand Sites folder and select Default Web Site. 

2. In the Actions pane, click Binding. 

3. Click Add. 

4. In the Type field, select “https”. 

5. In the SSL certificate field, select the certificate previously imported. 

6. Click OK. 

 



 
      

| Establish an SSL connection 

  HOPEX UNIFI AUTHENTICATION SERVICE Page: 21 / 44

 

4.4. Exporting certificate to the local disk 

To export the certificate to the local disk: 

1. Open Manage certificate computer. 

2. Expand Personal > Certificates folders. 

3. Right-click your previously imported certificate and click All Task > Export. 

4. Select “Yes, export the private key”. 

5. Check Export all extended properties. 

6. Select Password. 

7. Enter and confirm your password. 

8. Select your file location to export the certificate. 

9. Copy this exported certificate file to the SAML2/ADFS server. 
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5. INSTALL HOPEX SIGNING CERTIFICATE (MANUALLY) 

By default, the installer installs the UAS signing certificate, but the certificate could also be updated with the 

following procedure 

To install HOPEX signing certificate (manually): 

1. Double-click your certificate. 

2. Select Local Machine and click Next twice. 

3. Fill the password field. 

4. Click Next twice and click Finish. 

5. Go to your certificate through "Computer Certificate Manager". 

6. Go to Personal Folder > Certificates. 

7. Right-click your certificate and select All Tasks > Manage private keys. 

8. Add IIS_USRS as user and click OK. 

9. Right-click your certificate and select Properties. 

10. Enter a Friendly Name. 

The Friendly name and the password are important for UAS configuration: do not forget to change 

it if it changes. 
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6. INSTALL THE HOPEX IDENTITY PROVIDER TEMPLATE 

See HOPEX Visual Studio Templates documentation:  Installing the HOPEX Identity Provider template section. 
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7. CONFIGURE UAS HOPEX BY OPTIONS 

7.1. Local Configuration 

7.1.1. Defining authentication options 

To define authentication options: 

1) Go to HOPEX Administration. 

2) Right-click HOPEX and select Options > Modify. 

3) Check that you are in “Extended” mode (right-click Options and select Extended). 

4) Expand Installation, Authentication and Client folder. 

Note: Client folder is only available in “Extended” mode. 

5) Select Hopex Web, and define: 

• Redirection URL when the user is authenticated to http://<servername>/uas/uaslogin.ashx” 

• List of authorized  redirection URLs to http://<servername>/uas/uaslogin.ashx” 

• Redirection URL after disconnection to http://<servername>/Hopex/Default.aspx” 

7.2. Cluster Configuration 

In a cluster configuration, do not forget to specify the same MachineKey in the web.config of each UAS node.  

You also need to fix the urls on the loadbalancer urls, and not on several nodes.  

7.2.1. Configuring your data component type   

Hopex manages several data component for Cluster configuration (see Error! Reference source not found. 

section). 

To configure your data component type: 

1) Go to HOPEX Administration. 

2) Right-click HOPEX and select Options > Modify. 

3) Check that you are in “Extended” mode (right-click Options and select Extended). 

4) Expand Installation > Authentication folders. 

5) Select Server and in the right pane define (see Authentication section): 

• Type of information storage 

• Parameters of the UAS data component 

7.2.2. Configuring your SQL Server Data component type  

To configure your SQL Server Data component type: 

1) Create a SQL Database named “UAS”. 
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2) Create the table with the script “UAS_Scripts.sql” located in {Mega installation folder}\ Utilities\HOPEX 

Cluster Tools. 

3) Go to HOPEX Administration. 

4) Right-click HOPEX and select Options > Modify. 

5) Check that you are in “Extended” mode (right-click Options and select Extended). 

6) Expand Installation > Authentication folders. 

7) Select Server and in the right pane define (see Authentication section): 

• Type of information storage : SQL Server  

• Parameters of the UAS data component : Your connection string 

7.2.3. Configuring HOPEX Web options 

To configure HOPEX Web options: 

1) Go to HOPEX Administration. 

2) Right-click HOPEX and select Options > Modify. 

3) Check that you are in “Extended” mode (right-click Options and select Extended). 

4) Expand Installation, Authentication and Client folder. 

Note: Client folder is only available in “Extended” mode. 

5) Select Hopex Web and define: 

• Redirection URL when the user is authenticated to front load balancer server name: 

http(s)://<servername>/hopex/uaslogin.ashx 

• List of authorized redirection URLs to front load balancer server name: 

http(s)://<servername>/hopex/uaslogin.ashx 

• Redirection URL after disconnection  to front load balancer server name: 

http(s)://<servername>/hopex/Default.aspx 

7.2.4. Generating Machine Key 

To generate the machine key: 

1) Go to your IIS Manager 

2) Expand 

3) Click UAS application. 

4) Double-click Machine Key. 

5) Select your validation method (SHA1 by default). 

6) Select your Encryption method (AES by default). 

7) Clear “Automatically generate at runtime” validation key. 

8) Clear “Automatically generate at runtime” decryption key. 

9) In Actions pane, click Generate Keys. 

10) Do the same with Windows Authentication Service if you use UAS Windows Authentication mode. 
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8. CONFIGURE CLIENT USING UAS 

All the clients that want to communicate with UAS can use UAS SDK. 

To configure the client with UAS SDK: 

1. Go to <HOPEX installation folder>\DotNet\packages. 

2. Download MEGA.UAS.Client.Owin package to retrieve UAS SDK. 

MEGA.UAS.Client.Owin is an OWIN middleware. 

3. Use the ConfigureClient method to configure the client. 

 

The following options must be the same (case sensitive) in client configuration as in HOPEX Options 

configuration: 

• AuthenticationUrl (mandatory, only in Client configuration) 

Unified Authentication Service URL 

• ClientId (mandatory) 

Identifier of your client  

• ClientSecret (mandatory) 

Secret of your client 

• ClientRedirectUri (mandatory) 

Redirect Url of your client 

• ClientPostLogoutRedirectUri (not mandatory) 

Post logout redirect url of your client if you want to manage it. 

• ClientScope (mandatory) 

Scope of your client  

Usually, this information is stored in web.config website. 
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9. STANDALONE MODE 

In its nominal version, UAS is designed to work with SSP. But it is possible to operate it in an environment 

without SSP: it is the standalone mode. This allows it to be used by earlier version of Hopex, or even 

independently of Hopex. 

To do so, you must declare in the appsettings section of UAS web.config file: 

<add key="ConfigurationMode" value="Standalone" /> 

 

In this mode, the configuration necessary for the proper operation of UAS is retrieved from a config.json file 

which must be located in the UAS bin folder.  

In case the Hopex provider is activated in the standalone mode, you must also add two additional keys: 

• the URL to access the API for recovering old version environments: 

<add key="HopexApiUrl" value="http://my-server/hopexapi/restapi/v1" /> 

• the URL to call in case of a forgotten password, if the mega authentication provider is used 

<add key="ForgetPasswordUrl" value="http://my-server/hopex/account.aspx /> 

 

In addition, the options that are normally retrieved from the SSP are read from the configuration file. These 

are not used by UAS, but can be used by custom providers. 
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10. ANONYMOUS ENVIRONMENT MODE 

In its nominal version, UAS is designed to work with an environment list on the login page but you can replace 

it with a textbox. 

It can be used when you have multiple environments and you do not want that your user can see them. 

To do so, you must declare in the appsettings section of UAS web.config file: 

<add key="IsAnonymousEnvironment" value="1"/> 
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11. SAML2 ADFS SERVER CONFIGURATION 

To create the Relay Party: 

1. Start AD FS Management console. 

2. In the AD FS folder, select Relying Party Trust folder. 

 

3. In the Actions pane, in the Relying Party Trusts section, click Add Relying Party Trust. 

4. In the Welcome page, select Claims aware. 

 

 

5. In the Specify Display Name page, select Enter data about the relying party manually 

6. Enter the Web Front-End server name. 
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7. Click Next. 

 

8. Click Browse. 

9. In the Configure URL page, select Enable support for the SAML2 Web SSO protocol. 

10. Enter the Relying party SAML2 SSO service URL:  

http://{servername}/uas/AuthServices/Acs 
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11. In the Configure Identifiers page, enter the Relying party trust identifier: 

http://{servername}/uas  

12. Click Add. 

 

13. Click Next. 

To add Signature certificate imported from the front server: 

1. Import the certificate to the local storage. 

2. Export the certificate without the private key. 

To assign the certificate in ADFS: 

1. Right-click the Relay party. 

2. In the Signature tab, select the imported certificate file 



 
      

| SAML2 ADFS Server Configuration 

  HOPEX UNIFI AUTHENTICATION SERVICE Page: 33 / 44

 

3. Click OK. 

 

To configure claims to be returned to UAS  

1. Select the Relay and click Edit Claim Issuance Policy. 

2. Click Add Rule. 

3. Select “Send LDAP Attributes as Claims”. 

4. Enter the name “Get LDAP Attributes”. 

5. Select Active Directory as Attribute store. 

6. Add attributes and transformation rules. 

 

7. Click OK. 

8. Click Add rule. 
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9. Select Transform an incoming claim. 

10. In the Incoming claim type field, select “E-Mail Address”. 

11. In the Outgoing claim type field, select Name ID. 

12. In the Outgoing name ID format, select “Email”. 

 

13. Click Finish. 

14. Click Add Rule 

15. Select Transform an incoming claim. 

16. Enter E-Mail Address to sub as rule name. 

17. Select “E-Mail Address” as incoming. 

18. Enter “sub” as outgoing. 

19. Click Finish. 

To configure UAS to enable SAML2 Provider and to communicate with ADFS: 

1. Open HOPEX Administration. 

2. Right-click HOPEX and select Options > Modify. 

3. Expand Installation > Authentication > Identity Provider folders. 

4. Select Identity provider folder, and in the right pane, select Activation of the SAML2 identity 

provider. 

5. Select SAML2 folder and in the right pane, in: 

• the Location of the metadata file:  enter your federationmedata.xml URL. 
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• the Identifier of the SAML2 identity provider: enter the ADFS URL. 
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12. WINDOWS AUTHENTICATION IN CLUSTER MODE WITH UAS 

If you want to use windows authentication with UAS in an intranet network with a Network Load Balancer, you 

need some prerequisites:  

1. Create an account service as follows: 

a. This account must belong to IIS_WPG group. 

b. Define the delegation level on "Trust the user for delegation to any service (Kerberos Only)". 

c. Add this account service to IIS_USRS group on all the nodes of your cluster. 

2. In the appHost.config file (c:\windows\system32\inetsrv\config), deactivate  the kernel mode.  

3. Activate the account service use: useAppPoolCredentials="true". 

4. Add read rights with account service on: 

- c:\inetpub\wwwroot 

- c:\inetpub\wwwroot\uas 

- c:\inetpub\wwwroot\hopex 

- c:\inetpub\wwwroot\windowsAuthenticationService 

5. Add full control with account service on: 

- C:\Windows\Microsoft.NET\Framework64\v4.0.30319\Temporary ASP.NET Files 

- C:\Windows\Microsoft.NET\Framework32\v4.0.30319\Temporary ASP.NET Files 

6. At DNS level:  

a. Define a host name for the Network Load Balancer(NLB). 

b. Define an alias host name by machine in the same Network Load Balancer domain. 

c. In your port rules, put single affinity. 

7. Configure the Service Principal Name (SPN):  

a. Set SPN on the NLB by FQDN and Short Name with your account service 

b. Set SPN on each node of your cluster by FQDN and Short name with your account service 

Example:  

setspn -S HTTP/NLBName.domain.com domain\webapplicationaccount (NLB) 

setspn -S HTTP/NLBName domain\webapplicationaccount 

setspn -S HTTP/ServerName1.domain.com domain\webapplicationaccount 

setspn -S HTTP/ServerName1 domain\webapplicationaccount 

setspn -S HTTP/ServerName2.domain.com domain\webapplicationaccount 

setspn -S HTTP/ServerName2 domain\webapplicationaccount 
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13. OKTA CONFIGURATION 

13.1. Configuring OKTA 

To configure OKTA: 

1) Connect to your OKTA account. 

2) Go to Admin Portal > Applications. 

3) Click  Add application. 

4) Click Create New App. 

5) Select Web platform and SAML2 sign on method. 

6) Click Create. 

7) Enter the General Settings as you want. 

8) Click Next. 

9) Enter Single Sign on URL with the following URL syntax:  

http://<server name>/uas/authservices/acs 

10) Enter Audience URI and Default Relay state with the following URL syntax: 

https://<server name>/uas 

11) In Attribute statements, do not forget to add an attribute named “sub” and it value will be your UAS 

login so you can choose user login or email. 

12) Retrieve the SAML metadata and store it in UAS folder or secured folder in your network accessible by 

HTTP. 

13.2. Configure UAS with OKTA 

To configure UAS with OKTA: 

1) Go to HOPEX Administration. 

2) Right-click HOPEX and select Options > Modify. 

(Check that you are in Extended view) 

3) Expand Installation > Authentication folders. 

4) Select Identity Providers and in the right pane, select “Activation of the SAML2 identity provider”. 

5) Expand Identity Providers and select SAML2. 

• In the “Contact email” field: enter OKTA administrator email. 

• In the “Location of the metadata file” field: enter the UAS URL where you store the metadata 

retrieved before.  

• In the “Identifier of the SAML2 identity provider” field: enter the Url in the following format: 

http://www.okta.com/<youroktaid> 

• In the “Return URL” field : enter the Hopex URL in the following format: 

https://<server name>/hopex 

• In the “Sign on URL” field Enter your Sign on URL:  
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https://<name of your organization>.okta.com/app/<appname>/<oktaid>/sso/saml 

• Set the certificate friendly name and password if it is necessary. 
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14. TERMINOLOGY 

14.1. Client 

A client is a piece of software that requests tokens from UAS - either for authenticating a user or for accessing 

a resource (also often called a relying party or RP). A client must be registered with the OP. 

Examples: Web applications, native mobile or desktop applications, Single Page Applications (SPA), server 

processes etc. 

14.2. User 

A user is a person who is using a registered client to access his or her data. 

14.3. Scope 

Scopes are identifiers for resources that a client wants to access. This identifier is sent to the OP during an 

authentication or token request. 

By default, every client can request tokens for every scope, but you can restrict that. 

They come in two flavors. 

14.3.1. Identity scopes 

Requesting identity information (aka claims) about a user, e.g. his name or email address, is modeled as a 

scope in OpenID Connect. 

There is e.g. a scope called profile that includes first name, last name, preferred username, gender, profile 

picture and more. You can read about the standard scopes here and you can create your own scopes in UAS 

to model your own requirements. 

14.3.2. Resource scopes 

Resource scopes identify web APIs (also called resource servers) - you could have e.g. a scope 

named calendar that represents your calendar API. 

14.4. Authentication/Token Request 

Clients request tokens from the OP. Depending on the scopes requested, the OP will return an identity token, 

an access token, or both. 

14.4.1. Identity Token 

An identity token represents the outcome of an authentication process. It contains at a bare minimum an 

identifier for the user (called the sub aka subject claim). It can contain additional information about the user 

and details on how the user authenticated at the OP. 

http://openid.net/specs/openid-connect-core-1_0.html
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14.4.2. Access Token 

An access token allows access to a resource. Clients request access tokens and forward them to an API. Access 

tokens contain information about the client and the user (if present). APIs use that information to authorize 

access to their data. 
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15. PROTOCOL SPECIFICATIONS 

 

Open ID Specifications: http://openid.net/connect/ 

OAUTH2 Specifications: https://tools.ietf.org/html/rfc6749 

SAML2 Specifications: https://tools.ietf.org/html/rfc7522 

 

http://openid.net/connect/
https://tools.ietf.org/html/rfc6749
https://tools.ietf.org/html/rfc7522
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16. TROUBLESHOOTING 

16.1. General 

If you have problems with UAS, launch HOPEX Daily Logs, you need to activate “Hopex Web App Logs” to see 

UAS logs. 

You can also use Hopex Monitor Console.  

16.2. Get information about configuration  

UAS use an SSP webservices to retrieve HOPEX options.  

You can request it to know if your configuration is well defined. 

You need to type this URL below if you want to retrieve a specific authentication configuration :  

http://<servername>/megassp/sitecfg.mgsp?skey=<serialkey>&section=<sectionname>&key=<keyna

me> 

16.3. Redirect Server name to Full Qualified Domain name  

To redirect Server name to Full Qualified Domain name:  

1. Download IIS rewrite module 2 at: 

http://download.microsoft.com/download/D/D/E/DDE57C26-C62C-4C59-A1BB-31D58B36ADA2/rewrite_amd64_en-

US.msi 

2. Install it. 

3. Into system.webServer in the web.config file, add the following: 

<rewrite> 

  <rules> 

    <rule name="Redirect2FQDN" stopProcessing="true"> 

      <match url="(.*)" /> 

      <conditions> 

        <add input="{HTTP_HOST}" pattern="^([^\.]+)$" /> 

      </conditions> 

      <action type="Redirect" url="http<s>://{HTTP_HOST}.mega.com/hopex" /> 

    </rule> 

  </rules> 

</rewrite>  

4. Change the domain .mega.com by yours. 

16.4. Client configuration in Windows Authentication mode 

To avoid the basic login popup, you must configure this website like a Local intranet website. 

http://download.microsoft.com/download/D/D/E/DDE57C26-C62C-4C59-A1BB-31D58B36ADA2/rewrite_amd64_en-US.msi
http://download.microsoft.com/download/D/D/E/DDE57C26-C62C-4C59-A1BB-31D58B36ADA2/rewrite_amd64_en-US.msi
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To configure the website like a local intranet website: 

1) Open your "Internet browser". 

2) Go to Internet Options. 

3) Select Security tab. 

4) Click Local Intranet. 

5) Click Sites.  

6) Click Advanced. 

7) In the Add this website to the zone field, enter: "http://<domain name>" . 

8) Click Add. 

9) Click Close. 

16.5. Filtering Windows group  

In Windows authentication mode, when you have too many Windows groups, you can filter them. 

You can filter either by group number or by group name.  

16.5.1. Filtering Windows group by number 

MaxWindowsRoles enables to filter the Windows groups by number.  

By default, the filter is disabled (value=”0”).  

You can set this value to the number of Windows groups you want.  

To filter Windows group by number: 

1) In HOPEX installation folder, expand wwwwroot > WindowsAuthenticationService folders. 

2) Open the Web.config file. 

3) In the appSettings section, set the MaxWindowsRoles value to the number of Windows group you 

want: 

  <appSettings> 

    <add key="MaxWindowsRoles" value="<number of Windows groups>"/> 

   <!-- <add key="WindowsRoles" value=""/>--> 

  </appSettings> 

16.5.2. Filtering Windows group by name 

Windows Roles enables to filter the Windows groups by name.  

By default, the filter is disabled.  

Values are group names separated with a “;”.  

To filter Windows group: 

1) In HOPEX installation folder, expand wwwwroot > WindowsAuthenticationService folders. 

2) Open the Web.config file. 
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3) In the appSettings section, remove the comment characters (<!--    --> ) and add the group names 

separated with a “;”: 

  <appSettings> 

    <add key="MaxWindowsRoles" value="0"/> 

    <add key="WindowsRoles" value=”GroupName1;GroupName2;GroupName3"/> 

  </appSettings> 
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1. PURPOSE 

UAS Tools serves as an easy means to configure and diagnose UAS. It is made of two entities: the Configuration 

section and the Diagnostic section. Its purpose is thus twofold: prevent UAS configuration errors by validating 

options beforehand and provide insight on existing UAS errors by analyzing the log files. 

You may access it via you web browser, at the following address: 

http(s)://<hopex_server_or_cluster_url>/uastools 

2. CONFIGURATION 

The Configuration tab of UAS Tools displays a wizard that allows you to configure UAS options. It aims at 

showing and asking you the least information possible, as several options can be inferred from others. 

You will input information in the home page (the configuration page) and if everything is valid, you will then be 

presented with the result page that will give you information on how to include the generated configuration 

files in UAS. 

2.1. Configuration page 

The configuration tab is split in three categories presented as a wizard: 

• Getting Started 

• Identity Provider 

• CORS (Cross-Origin Resource Sharing) 

You can go from step to step as you wish if there are no client-side validation errors.  

If there are any errors at this point, they appear either below the corresponding field, or at the top of the 

related section. 

The CORS section includes a publish button (“Generate configuration”), which submits all the form data to the 

server where they will be subject to more advanced validation. As with the client-side errors, server-side errors 

will be shown at their correct location, and the wizard will switch back to the first section. 
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2.1.1. Getting Started 

 

In the General Information section, you can select the topology of the server, which defaults to Standalone. In 

case of Cluster mode, some additional options pertaining to cache management are displayed. 

The Front server section lets you input Hopex and SSP URLs, as well as the related Security Key.  

• Front Server URL should indicate only the root address, i.e., do not add /hopex or /uas 

• SSP URL is usually the same address as above, appended with /megassp  

• The Security Key is found in clear text during HOPEX install time, or encrypted in the UAS web.config 

file 

The certificate section lets you input information concerning the certificate. It must be installed on each server 

UAS is installed on. This is especially important in Cluster mode. 
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2.1.2. Identity Providers 
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In the providers sections, you can add the authentication providers UAS will use. You need to select at least 

one authentication provider. Unlike almost all other sections in UAS Configuration tool, the following providers 

information cannot be validated on the server-side, so make sure they are correct: 

• Microsoft 

• Google 

• SalesForce 

Note: for now, the client secret for these providers will be written in plain text in megasite.ini for Hopex V2R1. 

If you need help for a provider, click the “More information” link at the bottom of every section, which will 

open the UAS documentation directly on the correct section. 

2.1.3. CORS 
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In the CORS section, you can add or remove CORS as needed, up to a maximum of 5, by using the Add and 

Remove buttons. 

The order in which you add them is not important. 

If you need help concerning CORS, click the More information link pointing to UAS documentation that will 

give you more details. 

When you are done with everything, click Generate configuration to validate your changes and create a 

configuration file that will be used to configure UAS. 

2.2. Result page 

 

After successful validation of the configuration, the Result page is displayed. 

Depending on the Topology, you have specific actions to perform. You have to: 

• Edit the HOPEX web.config and perform the changes displayed in the first section of this page (Replace 

or add these settings) 

• For HOPEX V2R1 

o Download the megasite.ini file, populated with entries concerning UAS, that need to be 

injected in HOPEX megasite.ini 

• For HOPEX V2 

o Download and overwrite UAS config.json file 

• In cluster mode, install the same signing certificate on each node. 
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3. DIAGNOSTIC 

As well as helping you configure UAS, UAS Tools also allows you to diagnose existing issues.  

To diagnose existing issues: 

1. In the UAS Tools menus, click the Diagnostic tab. 

 

1. In the Upload your log file section, upload the log file you want to diagnose:  

a. Click Browse. 

b. In the dialog box: enter %ProgramData%\MEGA\Logs\UAS to reach the log file location. 

c. Select the log file. 

Your file is uploaded.  

2. Click Check to analyze the log file.  

UAS Diagnostic tool automatically loads the configuration from the log file (the last one present in the 

file), and it analyzes it too. 

When UAS Diagnostic is done, the Diagnostic result page is displayed. 
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It is split in three main sections: 

• General and Provider sections give you either the errors it encountered while analyzing the logs, or 

a message saying that the configuration is ok. You can edit the current configuration with the Edit 

Configuration link. 

• Logging section shows a dump of the actual errors from the log file, with a message giving you 

advice on how to solve these issues, if necessary.  
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Summary 

 

This document describes the procedures necessary for migrating data from Oracle storage to SQL Server 

storage.  

It applies to HOPEX V2R1 Update 3. 

This migration is an administration task performed by HOPEX Administrator in coordination with Oracle 

DBA and SQL Server DBA. 

 

Note that repository snapshot objects are tied to low level information and cannot be transferred when 

data repository is rebuilt logically. 

This means that they will NOT be available after migration from Oracle to SQL Server. 

 

1. PRE-REQUISITES ....................................................................................................................... 3 
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1. PRE-REQUISITES 

 

1) Stop user activity and backup data 

Follow standard procedures. 

The objective is to make sure that data are not accessed not updated. 

This means an interruption of service. Duration can vary according to volume of data. 

Dummy run will enable to evaluate real duration. 

 

2) Verify that a physical backup of data is available 

Follow standard procedures. 

 

3) Dispatch of delete all pending workspaces 

Follow standard procedures. 

The objective is that no pending update exist. 

They can be exported as MGR file, cancelled or dispatched. 

 

3) Verify you have enough working space 

 

The process used the reorganization feature of HOPEX. 

For each repository, data will be dumped to a large command file on disk using logical backup feature. 

 

The generation folder is a subfolder of HOPEX environment folder. There is one file per repository. Ex: 

<Myenvironment path>\SysDb\WORK 

 <Myenvironment path>\Db\MyDataRepository\WORK 

 

4) Create SQL Server database with appropriate permissions 

See SQL Server DBA. 

 

For each repository (data repository or system repository) a SQL Server is required. 

SQL Server database must be empty. 

A SQL server user with appropriate permission must be created. 

 

See HOPEX Administrator for details. 

For more details, see only documentation. 

Installation and Deployment : RDBMS Repository Installation Guide : SQL Server support, SQL Server 

Requirements. 

 

Basic metrics:  

For logical backup file: size of Oracle dump for the schema of the repository x 5 

For logical backup file: size of Oracle dump for the schema of the repository x 1 

 

Example Size of .DMP in 

Oracle 

Size expected for 

SQL Server database 

Disk expected for 

logical backup file 

Schema of MyRepository 5 Go 5 Go 25 Go 

Schema of SystemDb 3 Go 3 Go 15 Go 
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5) Performances tuning indications 

 

The article below contains optional indications to favor performances when performing mass import in SQL 

Server 

https://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=5012p0000015TWLAA2 

 

 

  

https://community.mega.com/t5/custom/page/page-id/mega-kb-solution?sid=5012p0000015TWLAA2
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2. RECOMMENDATIONS 

 

1) Decide if you can delete repository log 

Deciding to delete full/partially repository log has several benefits: 

• Process is faster 

• Process is more reliable 

• Process requires less working space 

• Final data will be less voluminous 

 

2) Upgrade to most recent version available. 

The version must be HOPEX V2R1 Update 3 or higher. 

The objective is to benefit from recent fixes and to be under maintenance if ever an error occurs 

• Make sur you are in a supported version 

• Apply last CP/hotfix. 

 

3) Use a server machine close to SQL Instances 

The machine should be located as close as possible from Oracle instance and SQL server instance. 

The objective is to have a performant and reliable access to data. 

 

4) Leave the process running quietly. 

In particular: 

• Do not stop the HOPEX Process of the machine where it is running 

• Do not stop Oracle instance (source data) 

• Do not stop SQL Server instance (target data) 

• Do not try to move the HOPEX environment folder used 

 

5) Check process (test) on a copy of production 

The more recent backup, the better vision you will have (duration, success). 

 

a) Restore data according to standard procedures 

 

b) Check that logical backup runs fully (dummy run) 

If errors occur (related to logical backup step), analyze the errors with MEGA Technical Support. 

 

c) Check complete process (dummy run) 

If errors occur (likely related to import step), analyze the errors with MEGA Technical Support. 

 

6) Loop until the processing runs without unexpected error. 

You will have a good idea of  

• Disk size required (logical backup file) 

• SQL Server size required 

• Global duration of operations 

 

If an error occurs and the process fails or stops, do NOT reuse the target SQL Server database 

For each repository involved: 

• Delete the SQL Server database. 

• Create a new SQL Server, possibility with same name. 
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3. PROCEDURE 

 

3.1. General process 
 

For each environment: 

• Reorganize data repository first 

• Reorganize system repository last 

 

For each repository, it will be required to set: 

• SQL Server Instance used 

• SQL Server user/password used 

 

3.2. Procedure 
 

Run Administration.exe 

 

Open environment 

 

Select the repository to reorganize 

 

R click > Reorganize 
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Configure window (Reorganize Repository (XX) 

a) Set Logs of objects (keep log, delete log, delete log order than date) according to decision 

b) Keep backup file checked 

c) Select target storage support SQL Server 

 

Example 

 

 
 

Click Apply  

 

Set Connection parameters 
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Click button 'Test Connection' 

 

 
 

Click OK 

 

Click button 'Test GRANTs' 

 

 
 

Click OK 

 

 
 

Click OK to confirm 

 

Note that reorganization in appropriate in this situation even if the following warning can create a doubt. 

If your purpose is to maintain access performances, reorganization is not appropriate for an RDBMS 

repository 

 



 
How to migrate data from Oracle storage to SQL Server storage HOPEX V2R1 EN 

 

C0 - PUBLIC page 9/11 

 

 

 
 

Click 'OK' to confirm 

 

Process starts. Note that it goes through 2 mains steps: 

• Logical backup 

• Import 

 

Wait until process ends. The following windows should be displayed. 

 

 
 

Check message, ex 'The repository has been successfully reorganized' 

 



 
How to migrate data from Oracle storage to SQL Server storage HOPEX V2R1 EN 

 

C0 - PUBLIC page 10/11 

 

 
 

Click button 'Close' 

 

For more details, see only documentation, reorganization feature 

HOPEX Administration: Administrator Guide : Managing Repositories : Managing Repositories : 

Reorganizing an RDBMS Repository 
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4. CHECK DATA 

 

The best proof it the fact that process could fun without error or that errors can be understood and 

accepted. 

 

As a precautionary measure, you run a quick tour and check that upgraded data looks correct. Of course, 

this kind of check cannot be exhaustive, but it usually enables to have a first feedback and confirm 

migration process went well. 

 

Example of scenario:  

• Open a private workspace (ex-transaction). 

• Browse through objects using query tools, navigation trees and diagrams. 

• Perform insignificant updates (ex: change a character in a comment value, slightly move an object 

in a diagram...).  

• Dispatch private workspace. 
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